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1 Overview
1.1 Benefits

[ | Easy Backup of
1. Microsoft Exchange Server 2000 / 2003
Microsoft SQL Server 7.0 / 2000
Lotus Domino/Notes 5.0 or above
Oracle 8i or above
MySQL 3.2.4 or above
Windows System State
Outlook and Outlook Express (i.e. *.pst, *.dbx and *.wab)
Important personal settings, e.g. Desktop, Favorite, My Documents and History etc
Other common files (e.g. *.doc, *.xls)
[ | Support backing up only changes within a file (using in-file delta technology)
Support backing up of open files on Windows XP/2003 (Volume Shadow Copy)
| Support backing up of Windows NTFS access privileges, Linux access privileges and modes, Mac OS
X metadata and resource forks
[ | Easy to use, deploy and maintain

©CNOGOr®WN:

1.2 Features

[ ] (New in 5.2) Full support of Microsoft Exchange individual email, contacts, calendars, tasks etc.

(New in 5.2) Choose whether to restore “file permissions” during restore.

(New in 5.2) For “Local Copy” backup, ability to choose whether to perform a local copy backup only

and skip the offsite backup.

[ | (New in 5.2) Lotus Notes/Domino agent for Linux.

(New in 5.2) Auto Upgrade Agent to automatically upgrade the client software.

User configurable incremental / differential in-file delta backup mode (i.e. backing up only changes

within a file since the last incremental or full backup according to each user’s preference).

[ | Allow in-file delta backup mode to be overridden by each user individually according to backup time
(e.g. enforcing full (or incremental or differential) backup of all files every Sunday or the 1% day of every
month).

[ | Volume Shadow Copy backup (i.e. backing up files even when they are exclusively open, e.g.
Outlook.pst).

[ | In-File Delta backup (i.e. backing up only changes within files).

[ ] Off-line backup mode and logout backup reminder.

[ ] Customizable backup schedule allows backups to be scheduled at any time.

[ | Compress and encrypt data automatically before sending them to the server (server stores only
encrypted data).

| Increment backup strategy ensures that only new or updated files are sent to the backup server.

[ | Support both full backup (database backup) and incremental backup (transaction log backup) for
Microsoft SQL Server 7.0/2000, Microsoft Exchange Server 2000/2003, Lotus Domino/Notes 5.0 and
Oracle 8i or above.

| Can integrate with external “Open File Manager” to provide open file backup support to all open files.

[ | Access backup data anytime, anywhere by using a web browser.

[ ] Comprehensive backup report lists all files backed up. Backup report delivered automatically via email.

u Backup data are CRC validated before they are stored on server.

| Fully user customizable data retention policy allows users to have access to deleted files using the

least possible storage space on the backup server.

[ | Can select source backup files easily by using a backup filter, e.g. selecting all *.doc and *.xIs in your
computer in a single operation.

] Run any custom OS commands before/after a backup job.

[ ] Run on Windows, Mac OS X, Linux, NetWare, Unix and all other platforms supporting a Java2 Runtime
Environment.

] Periodic backup files validation on backup server ensures backup files are 100% valid and fully
restorable when needed.

Fortikup is a trademark of Micso Srl Page 5 of 135 (April 24, 2008)



Fortil'“JPe “‘ Fortikup OBS v5.2

micso fortified backup User’'s Guide

1.3 Security

128-bit point-to-point SSL communication between server and client

Support HTTP/HTTPS Proxy and Socks v4/v5 firewall

Data are 128-bit encrypted when stored on the backup server

Choice of different encryption algorithms, e.g. Twofish, Triple DES, Advanced Encryption Standard

(AES)

Choice of different encryption modes, e.g. Electronic Cook Book (ECB) and Cipher Block Chaining

(CBC)

| An random initializing vector, salt and iteration count will be generated by the software automatically for
each file when encrypting your data

] Each backup user can restrict online access to his files to his pre-defined list of IP addresses

1.4 System Requirements

Server-side applications

OBS e Windows 2000/ XP / 2003 (server e Memory:
6 recommended) o 512MB (minimum)
e Linux kernel 2.4 or above 0 1GB (recommended)
e Solaris 2.x or above e Disk Space:
o AIX o 300MB
e HP-UX e Network Protocol:
e FreeBSD o TCP/IP (http/https)
e Mac OS X 10.2 or above
e All other operating systems that

supports Java2 Runtime Environment
1.4.2 or above

RPS e Windows 2000/ XP / 2003 (server e Memory:
o recommended) o 128MB (minimum)
e Linux kernel 2.4 or above 0 512MB (recommended)
e Solaris 2.x or above e Disk Space:
o AIX o 100MB
e HP-UX e Network Protocol:
e FreeBSD o TCP/IP (http/https)
e Mac OS X 10.2 or above
e All other operating systems that

supports Java2 Runtime Environment
1.4.2 or above

* The use of Windows 2000 WorkStation and XP Professional is only recommended for backup system with less
than 20 users. For 20 or more users, please use Windows 2000 or 2003 Server instead.

Client-side applications

Windows 95 /98 / e Microsoft Exchange e Memory:

ME / NT /2000 / XP Server 2000 / 2003 / o 128MB

/2003 / Vista 2007 (minimum)
Linux kernel 2.4 or Microsoft SQL o 256MB

above Server 7.0/ 2000 / (recommended)
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ACB

NetWare 5.1 or
above

Solaris 2.x or above
AlIX

HP-UX

FreeBSD

Mac OS X 10.2 or
above

All other operating
systems that
supports Java2
Runtime
Environment 1.3.1
or above

Windows 95 /98 /
ME / NT /2000 / XP
/2003 / Vista

Mac OS X 10.2 or
above

2005

Lotus Domino /
Lotus Notes 5.0 or
above

Oracle 8i or above
MySQL 3.2.4 or
above

Outlook / Outlook
Express i.e. *.pst,
*.dbx and *.wab
Other common files
e.g. *.doc, *.xls
Also supports
backing up of:

0 Windows System
State (all
platforms except
Vista)

o Windows NTFS
access privileges

0 Linux access
privileges and
modes

0o MacOSX
metadata and
resource forks

Outlook / Outlook
Express i.e. *.pst,
*.dbx and *.wab
Other common files
e.g. *.doc, *.xls

Also supports
backing up of:
0 Windows NTFS

access privileges

Disk Space:

o 110MB

Network Protocol:

o TCP/IP
(http/https)

Memory:

o 128MB
(minimum)

o 256MB
(recommended)

Disk Space:

o 110MB

Network Protocol:

o TCP/IP
(http/https)
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2

Installing OBM

Before you can start backing up data to the Offsite Backup Server, you need to install the Online Backup Manager
(OBM) client onto your computer.

2.1

Installing OBM for Windows

Double click the icon to run the installer.
Follow on screen instructions.

After installation, OBM will start automatically.

nline Backup Services Management Console - Microsoft Internet

y
gy solaris
Installation Guide - OBM - Windows Print =

System Requirement

# Operating System : Windows 95/ 98 / ME / NT / 2000 / XP / 2003
« Memory : 128 Mbytes
# Disk Space : 100 Mbytes
» Network Protocol : TCP/IP (Http/Https)
s Additional Requirement:
O Windows 95 - Please download and install Windows Socket 2 Update for Windows 95

(w9Sws2eetup.exe)
o Windows NT / 2000 / XP / 2003 - Please make sure you have logged onto Windows

using an account with administrative privileges

Online Backup Manager - cbm-win.exe

Get Started

1. Download the setup file {obm-win.exe) above and run it
2. Follow the instructions on the installation wizard to complete installation

3. When finished, a new icon (OBM) will be installed to the system tray (near the clock)
automatically and OBM will be launched automatically.

4. (optional) Enter the backup server host name in the [Address] field and press the [Next]
button.

=l

Download the Online Backup Manager installer (obm-win.exe) from the website.
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2.2

Installing OBM for Mac OS X

Download the Online Backup Manager installer (obm-mac.zip) from the website.

Expand the zip file.

Double click the pkg file icon to run the installer.

Follow on screen instructions.

After installation, the installer will need to restart your computer.

After restarting your computer, click the newly added OBM icon on your desktop. You can manually drag
the icon to your dock bar if you wish.

System Requirement

Get Started

1.

2.

1")‘ .‘\lll(’
Ay solaris
Installation Guide - OBM - Mac 0S X Print =4

Operating System : Mac 0S5 X v10.x
Memory : 128 Mbytes
Disk Space : 20 Mbytes
Network Protocol : TCP/IP (Http/Https)
Additional Requirement:
o Apple JavaZ? Standard Edition 1.3.x or above must be installed already

Online Backup Manager - cbm-mac.zip

Download the setup file (obm-mac.zip) above

Expand the archive and run the installation wizard [OBM] within the archive
Follow the instructions on the installation wizard to complete installation
Restart your Mac. Double click the desktop OBM icon to start.

(optional) Enter the backup server host name in the [Address] field and press the [Next]
button.

If you don't have a backup account, select [Trial Registration] and press the [Next] button
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2.3 Installing OBM for Linux

1. Download the Online Backup Manager tarball release (obm-linux.tar.gz) from the website.
2. Set the OBM_HOME environment variable
# export OBM_HOME=/usr/local/obm

3. Expand the client software to $OBM_HOME

# mkdir $OBM_HOME
# tar —x —C $OBM_HOME -zvf obm-linux.tar.gz

4. Install OBM

# cd $OBM_HOME
# ./bin/install.sh

5. Start Auto Upgrade Agent

# /etc/init.d/auaobm start

6. Start backup scheduler

# /etc/init.d/obm-scheduler start

7. Set the DISPLAY environment variable

# export DISPLAY=IP_ADDRESS_OF XTERMINAL[:0.0]

8. Run OBM

# sh $OBM_HOME/bin/BackupManager.sh &

a Online Backup Services Management Console - Microsoft Internet Ex;

1.'} My
ag) solLaris
Installation Guide - OBM - Linux Print =

System Requirement

Operating System : Linux Kernel 2.2 or above (e.g. Redhat 6.0 or above)

Memeory @ 128 Mbytes

Disk Space : 100 Mbytes

Network Protocol : TCP/IP (Http/Https)

Additional Requirement:

0 The Standard C++ libraries for backwards compatibility compiler (compat-libstdc++-

XX-Y.y.Y.Y.i386.rpm) are required to run Online Backup Manager correctly. If it is not
installed already, please download and install this library from your Linux vendor.

Online Backup M ger - obm-linux.tar.gz

1. Download the setup file (obm-linux.tar.gz) above

2. Setthe OBM_HOME environment variable (directory to where Online Backup Manager is to
be installed)

export OBM_HOME=/usr/local/obm

3. Unpack the install file to OBM_HOME

mkdir $0BM_HOME
tar v o~ EOBEM HAME cmuf nheolinoe tar o LI

Fortikup is a trademark of Micso Srl Page 10 of 135 (April 24, 2008)



forti

L]
MIC50 fortified backup I

Fortikup OBS v5.2
User’s Guide

2.4

Installing OBM for Netware

Download the Online Backup Manager zip release (obm-netware.zip) from the website.

Expand the zip file to SYS:\OBM

Install OBM

SYS:\> SYS:\OBM\aua\bin\install-aua.ncf

Start Auto Upgrade Agent

SYS:\> SYS:\OBM\aua\bin\startup.ncf

Start backup scheduler

SYS:\> SYS:\OBM\bin\Scheduler.ncf

Run OBM

SYS:\> SYS:\OBM\bin\RunBackupManager.ncf

a Online Backup Services Management Console - Microsoft Internet Ex)

Select your Operating System

P
5

=101 x|

b,
- e

solaris

Get Started

1.
2

3.

Installation Guide - OBM - NetWare

System Requirement

Print —|

Operating System : Novell NetWare 5.1 or above
Memory : 128 Mbytes
Disk Space : 100 Mbytes
Network Protocol : TCP/IP (Http/Https)
Additional Requirement:
o Mowvell 7vM 1.3.x or above for NetWare must be installed already

Online Backup M ger - cbm-netware.zip

Download the setup file (obm-netware.zip) above
Expand the zip file to SYS:\OBM

Install OBM

SYS:\OBM\aua\binlinstall-aua.ncf

Start Auto Upgrade Agent

SYS:\0BM\aua\bin\startup.ncf
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2.5 Installing OBM for Sun Solaris

1. Download the Online Backup Manager tarball release (obm-solaris.tar.gz) from the website.

2. Set the OBM_HOME environment variable

# export OBM_HOME=/usr/local/obm; export OBM_HOME

3. Set the JAVA_HOME environment variable to the directory where J2SE Java Runtime Environment (JRE)
1.4.x has been installed

# export JAVA_HOME=/usr/java/j2rel.4.x; export JAVA_HOME
4. Expand the client software to $OBM_HOME
# mkdir $OBM_HOME

# cd $OBM_HOME
# gunzip -c obm-solaris.tar.gz | tar —xf -

5. Install OBM

# ./bin/install.sh

6. Start Auto Upgrade Agent

# /etc/init.d/auaobm start

7. Start backup scheduler

# /etc/init.d/obm-scheduler start

8. Set the DISPLAY environment variable

# export DISPLAY=IP_ADDRESS_OF XTERMINAL[:0.0]

9. Run OBM

# sh $OBM_HOME/bin/BackupManager.sh &

/My R
gy solLaris
Installation Guide - OBM - Solaris Print =

System Requirement

Operating System : Sun Scolaris 2.5 or above
Memory : 128 Mbytes

Disk Space : 100 Mbytes

MNetwork Protocol @ TCP/IP (Http/Https)

Online Backup | ger - cbm-solaris.tar.gz

Get Started - X Window Mode

1. Download the setup file {obm-solaris.tar.gz) above

2. Set the OBM_HOME environment variable (directory to where Online Backup Manager is to
be installed)

export OBM_HOME=/usr/local/ocbm

3. Set the JAVA_HOME environment variable (directory where 125E Java Runtime Environment
(JRE) 1.4.x has been installed)

JAVA_HOME=/usr/java/jZrel.4.x; expart JAVA_HOME

4. Unpack the install file to OBM_HOME
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3 Uninstalling OBM

This section describes the steps required to uninstall OBM from your computer.

3.1 Uninstalling OBM for Windows

1. Open [Start] -> [Control Panel] -> [Add/Remove Programs]

2. Select [OBM] from the list and press the [Remove] button

3.2 Uninstalling OBM for Mac OS X

1. Remove all program files by running

# cd $OBM_HOME/bin
# sudo ./uninstall.sh

2. Remove all backup setting by removing ~/.obm

# rm —rf —/.obm

3. Restart your computer

3.3 Uninstalling OBM for Linux

1. Change user to “root” or equivalent

2. Remove all program files by running

# cd $OBM_HOME/bin
# ./uninstall.sh

3. Remove all backup setting by removing ~/.obm

# rm —rf —/.obm

3.4 Uninstalling OBM for Netware

1. Stop the running backup scheduler by running

SYS:\> touch SYS:\OBM\ipc\Scheduler\stop

2. Stop the running auto upgrade agent by running

SYS:\> SYS:\OBM\aua\bin\shutdown.ncf
3. Remove all program files by removing the directory SYS:\OBM

4. Remove all backup settings by removing the directory SYS:\.OBM
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3.5 Uninstalling OBM for Solaris

1. Change user to “root” or equivalent

2. Set the OBM_HOME environment variable

# export OBM_HOME=/usr/local/obm; export OBM_HOME

3. Set the JAVA_HOME environment variable to the directory where J2SE Java Runtime Environment (JRE)
1.4.x has been installed

# export JAVA_HOME=/usr/java/j2rel.4.x; export JAVA_HOME

4. Remove all program files by running

# cd $OBM_HOME/bin
# ./uninstall.sh

5. Remove all backup setting by removing ~/.obm

# rm —rf —/.obm
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4 Using OBM

This chapter will describe all the features available in OBM and outline how you can use OBM to meet various
backup needs.

4.1 System Tray Launcher (Windows Only)

After you have successfully installed OBM onto your computer, an OBM icon will be added to the system tray area
(next to your system clock) automatically.

Backup 4
Backup and Logoff 4
Backup and Festat 4
Backup and Shotdown P

Help

Exit

T 1446

This icon is the entry point to OBM. Right clicking the icon will show a menu that provides the following functions:

Menu Item What it does

Open Run OBM.

Backup Runs a specific backup set (or all backup sets) chosen from the sub-
menu in silent background mode.

Backup and Logoff Runs a specific backup set (or all backup sets) chosen from the sub-
menu in silent background mode and then logoff from Windows when
finished.

Backup and Restart Runs a specific backup set (or all backup sets) chosen from the sub-

menu in silent background mode and restart Windows when finished.

Backup and Shutdown | Runs a specific backup set (or all backup sets) chosen from the sub-
menu in silent background mode and shutdown the computer when

finished.

Help Shows a help dialog

Stop running backup Interrupts a running backup set (or all backup sets) chosen from the
sub-menu.

Exit Close this system tray launcher application.

4.2 Logon Dialog

Before you can use OBM, you have to be authenticated by the Offsite Backup Server first. The logon dialog shown
below will check if you have the right to access OBM by submitting the username and password you provided to
the backup server.
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.ﬁirj Online Backup Manager Lo

I [ 3

\ Login Mame: Idemn

" Password I""*

[V Save passward
Language

English

Backup Server

& hitp = hitps

Address: wwwbackup-provider.wm|

Proxy Setting

" Proxy  Socks & None

FronyAddress: |

Fart:

WserHame: |

Fassyard: I

Ok | Cancel Options ==

Flease lagaon to Online Backup Manager.

For secure communication, you can choose to communicate with Offsite Backup Server in SSL (Secure Socket

Layer) by selecting the [https] option.

The [Address] field shows the Offsite Backup Server to which OBM will connect to authenticate your username and
password. You can use either a resolvable host name (e.g. backup.your-domain.com) or an IP address (e.g.

192.168.1.1).

If the Offsite Backup Server is not accepting connection from the standard ports (Port 80 and 443 for http and
https respectively), you can append a semi-colon “:” and the custom port number to the host name of the
[Address] field (e.g. www.backup-provider.com:8080) to connect to the server using the custom port number

(port 8080 in this case).

If you need to connect to the server through proxy, just enter your proxy setting in the [Proxy Setting] section.

For [SOCKS] proxy, both v4 and v5 without user authentication are supported.

4.3 Language Selection

You can switch the language of the OBM user interface by choosing the desired language available from the
[Language] drop down list. The languages available includes English, Czech, Danish, Dutch, French, Spanish,

Portuguese, Icelandic, Norwegian,
Japanese, Lithuanian and Slovenian.

Finnish,

Italian, German,

Swedish, Chinese (Traditional and Simplified),
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il

\; Login Mame: Idemo

" Password I“"*

[¥ Save pasgward

rLanguage

|English =

Mesky

Dansk

Deutsch

Espafiol

Suomi

Frangais

islenska -

FronyAddress: |

Fart:

User Marme: I

Fassward: |

Ok | Cancel | Options =<

|Please logan to Online Backup Manager.

4.4 User Profile

After the backup server authenticates you successfully, the OBM main window appears. You can then use OBM to
update your user profile.

i x

Backup Set Backup Restore Tools Yiew Help
IH save Setting | P> Start Backup [l Siop Baskup |

g’} Backup Controller r_x [—:’. User Profile

f::’. U_serProﬂIe
=H @) FileBackupSet-1

~User Information

—0'[,_%,: Backup Saurce Login Mame:  demo
@ Backup S.chedule Fassword: A Change
Backup Filter —_
—ﬁﬂ Command Line Toal Display Mame: Demonstration Account Change
] setting
L Encryption ~Account Infarmatian
iy Retertion Palicy _
Extra Backup GQuota: a0
7 In-File Delta Time Zone: [GMT+08:00 (HKT) |
= Local Copy
~Contact
Idemo@vour—compan\;.com j

Contact Name: Demonstration Account
Email Address: demoi@your-company.com

Add Remave ||| Properies
&> Backup I &} Restore | [@/ Log |
|We|come to Online Backup Manager! |Qu0ta (Remaining § Total): 50 § 500 |Last Backup: -

You can perform the following update to your user profile.

To change your [Password], press the [Change] button next to the password field. A Change Password dialog will
appear. Enter your original password and new password into the text field of this dialog and press [OK].
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21 Paswond:

Mew Paspword: I
Confirm New Password : I

0]:4 | Cancel |

To change your [Display Name], press the [Change] button next to the display name field. A Change Display
Name dialog will appear. Enter the new display name and press [OK].

Display Mame: IDemo Account

0K | Caneel |

To change your [Time Zone], just select your time zone from the drop down list next to the time zone entry.

To add a new contact email to this account, press the [Add] button in the [Contact] section. A [Add New Contact]
dialog will appear. Enter a name and an email address in the text field provided and then press the [OK] button.

Contact Mame: I

Email Address: I
QK | Cancel |

To remove a contact email, select the email that is to be removed from the email list and press the [Remove]
button. Press [OK] to confirm the removal.

To update a contact email, select the email that is to be updated from the email list and press the [Properties]
button. A [Update Contact Property] dialog will appear. After you have made the changes that you want, press the
[OK] button.

Contact Marne: IDemuAccnunﬂ

Email Address: Idemu@ynur—cnmpany.cnm

oK | e |

4.5 Backup Logs

All backup activities are logged to backup activity log files. They are available for reviewing from OBM.

How to review backup activities?

You can review all your backup Jobs by
1. Select the [Log] tab available at the bottom of OBM

2. Select the Backup Job you want to review on the [Log Controller] panel
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.tn online Backup Manager
Backup Set Backup Restore Tools

view Help

|| save setting |

| Log Controller

(2] | Log Table (2007-01-15-21-00-01 log)

Page: [141 =]

-] FileBackupSet

Type | Log

Time

2007-01-15-18-28-34 1
2007-01-15-17-30-40 log
2007-01-15-17-20-43 Ing

4 |+ =h

Start [ Windows XP (soloman), OBM 5.2.1.0]

Start running pre-cormmands

Finished running pre-commands

Starting to create Shadow Copy Set

Shacow Copy Set created successfully

Downloading serverfile list...

Reading backup source frorm hard disk

Reading backup source fram hard disk... Completed
[Local Copy] Start running local backup

[Local Copy] Reading local backup files fram hard disk...
Downloading serverfile list.. Cormpleted

[Local Copy] Reading local backup files from hard disk.. Com

[Local Copy] Getting all files which have been updated.. Comp

[Local Copy] Total Mew Files=10
[Local Gopy] Total Updated Files = 0
[Local Copy] Total Update File Permission=10
[Local Copy] Total Deleted Files =1
[Local Copy] Total Moved Files = 0
[Local Copy] [Deleted File] Deleting "C:

ocalBackupli 168848
el P d Ciim e v e [y

oW IAII ~| Logs perpage: |500 I

[Local Copy] Getting all files which have been added... Comple..

[Local Copy] Getting all files which have been deleted... Compl...
[Local Copy] Gelting all files which have been moved... Comple...

[20070115 21
[2007M0118 21
[2007M01nE 21
[2007/01/15 21
[20070115 2
[2007M01nE 21
[2007/01/15 21
[20070115 21
[2007M0118 21
[2007M01nE 21
[2007/01/15 21
[20070115 2
[2007M01nE 21
[2007/01/15 21
[20070115 21
[2007M0118 21
[2007M01nE 21
[2007/01/15 21
[Zo07mia
[2007/M01nE 21
[2007/01/15 21
[20070115 21

fAnTIA M E A4

00:01]
00:02
00:02
00:03
00:05
00:08
0007
00:08
00:08
00:08
00:08
00:08
00:08
00:08
00:08
00:08
00:09
00:0g
00:09
00:08
00:0g
00:09

an.nm

]

=

o Backup | &) Restore [ Log |

|Elackup Completed Successfully

|Quuta {Remaining f Total); 8.86G 110G |LastBackup. 2007-01-15 21:.00
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5 Setting Up Backup Sets

A backup set contains all backup settings of a backup operation. This section will describe all features available
within a backup set and explain how you can use each of them to achieve various tasks.

Each backup account can have multiple backup sets. Each backup set is an individual and independent entity. For
example, if you want one directory to be backed up during the day and another directory to be backed up during
the night, you can create two backup sets, each with a different backup schedule and backup source, to serve this
need.

To create a new backup set, simply click [Backup Set] -> [New] and choose a backup set type. For example, let’'s
create a “File Backup Set” for the rest of this chapter.

i8]
Backup Set Backup Restore Tools View Help
B new | File Backup Set
,'_X Remove b g System State Backup Set
|Z] save Setting |4 Lotus Backup Sat
" [Heit [ mSExhange Backup Set
5 Backup 50 || M3 Exchange Mail Level Backup Set
S Backun 3¢ [{7) M8 SQL Server Backup Set
o Backup It eoh e 0l Backup Set

=] Command onAccount  Chanoe
} Setting |&@ Oracle Database Backup Set —

Change

i Encryption Account Information
Retention Policy

Exira Backup GCluata: 106G

In-File Delta Time Zane: W

Local Copy

Contact

|demo@yuur—company.com LI

Contact Mame: Demonstration Account
Email Address: demo@your-company.com

Add Rermave Propetties |

& Backup | &} Restare| (@ Log
|Elackup Completed Successfully |Qu0ta (Rermaining f Total): 9.86G /106G |LastElackup: 2007-01-14 21:00

5.1 Backup Set Type

A backup set can be of one of the following types:

Backup Type Description

File Backup set type to backup common files/directories

Microsoft SQL Server Backup set type to backup Microsoft SQL Server 7.0/2000

Oracle Database Server Backup set type to backup Oracle 8i/9i database

Lotus Domino/Notes Backup set type to backup Lotus Domino/Notes

Microsoft Exchange Server Backup set type to backup Microsoft Exchange Server 2000 / 2003
MySQL Backup set type to backup MySQL Server

System State Backup set type to backup Microsoft Window’s System State

Microsoft Exchange Mail Backup set type to backup individual emails, contacts, calendars,
(MAPI) tasks etceteras from Microsoft Exchange Server 2000 / 2003

Backup set type is defined at backup set creation and cannot be modified. If you want to change the backup set
type, you have to create another backup set in the new backup set type.

Fortikup is a trademark of Micso Srl Page 20 of 135 (April 24, 2008)



MIC50 fortified backup

Fortikup OBS v5.2
User’s Guide

forti up

5.2 Backup Source

A “Backup Source” defines the files/directories that are to be included in a backup set. There are two types of
backup source: Selected and Deselected. Selected backup source defines files/directories that are to be included in
a backup set while deselected backup source defines files/directories that are to be excluded from a backup set.
Online Backup Manager will generate appropriate backup source setting for you automatically when you make
your backup source selection on OBM.

Please note that for Windows operating systems, if the “Hide protected operating files (Recommended)” setting is
enabled for the file explorer, system folders/files will not be shown in the backup source. By selecting the parent
folders however, all subfolders (including system folders/files) will be included in the backup set. Thus if you want
to exclude system folders (e.g. recycle bin) from the backup, please select the desired folders/files directly rather
than selecting the parent folder. Alternatively, you can enter the corresponding system path to the [Exclude List]
of the backup set using the web interface.

From the [Standard] node available at the top of the [Backup Source] tree, you can easily select the following
common folders to be backed up:

1. “My Documents” folder

2. “Outlook” and “Outlook Express” mail store folder
3. “Favorites” folder

4. “Desktop” folder

From the [Options] node available below the [Standard] node, you can easily select other common folders to be
backed up as well. They include the “Application Data” folder, the “Start Menu” folder, the “Templates” folder, the
“All Users’ Documents” folder, the “Temporary Internet Files” folder, the “Cookies” folder, the “Font” folder, the
“History” folder, the “Applications Data” folder, the “Nethood” folder, the “Printhood” folder, the “Recent” folder
and the “Send to” folder.

.ﬁh Online Backup Manager Mi=] B3
Backup et Backup Restare Tools View Help
|5, Save Setting |> Start Backun [ Stop Backup |
t.'} Backup Controller ,_X qj Backup Source (FileBackupSet1) EI
2 User Profile =1 5 Standard
(£ My Dncurnents (CADREUMENts and Setingsyohin s mithiy Docurmes)
i L‘ﬁl Outlook Express
ackup Schedule ¢ Favorites
Backup Filter [ (B Desktop
Command Line T g:D@ Options
1 setting = ' My Computer
(&) Encryption 1.5 3% Floppy (A
i Retention Palicy [ Lacal Disk (C)
5] Extra Backup [J<e Local Disk (D7)
i In-File Delta [ e Ml =
=4 Local Copy [ = Local Disk (F3)
1.4 DWD-Rw Drive (G2)
[1ligg My Sharing Folders
-3 My Network Places
= f@ Entire Matwork
(3 Microsoft Terminal Services
Y Microsoft windaws Metwork
€Y 'Weh Client Metwork
E Log Table (FileBackupSet-1)
Type | Log Time
T

"2 Backup | @) Restore] @ Log]

|Waiting for other Backup Job finish

|uota (Remaining f Total): 106 /106 |Last Backup: -
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The checkbox next to the files/directories shown above can be in one of the following mode:

Mode

Description

[

All files/directories (recursively) under this directory will be backed up

[

All files/directories (recursively), except those explicitly excluded, under this directory will

be backed up. If you add files/directories to this directory in the future, they will be

backed up as well.

Only the checked files/directories under this directory will be backed up. If you add
files/directories to this directory in the future, they will NOT be backed up.

Nothing under this directory will be backed up.

5.3

Mapped Network Drive

If you need to backup a mapped network drive on Windows (it will only work in Windows NT/2000/XP/2003), you
must enter your Window’s domain, username and password into the [Network Resources Authentication for
Windows] section as shown below. It is required because scheduled backups will always run under the context of
Window’s “Local System” account (which does not have the privileges required to access network resources) by
default. OBM needs to collect your Windows username, password and domain name to authenticate itself to the
windows domain controller to acquire the required access privileges to the network files to be backed up. If you
don’t supply a username and password, OBM will have problems accessing network resources in its scheduled
backup Jobs.

If you need to backup network mapped drive in scheduled backup, please do this:

i. Select the backup set from the left panel and press the [Properties] button

.+ online Backup Manager

Backup Set Backup Restore Tools View Help

=101 x|

5] save Setting |’~ start Backup [l Giop Backun |

fif Retentian Policy Password:
=i Extra Backup
s In-File Delta

=9 Local Copy

&> Backup Cantroller ,_X |&2] Backup Set- FileBackupsiet-1
-
%ﬁ?ger Pm'z'!éei;i.iﬁ o Backup Set
b Mame: FileBackupSet-1
1D 1168848399906
Type:  File Backup
Metwork Resources Authentication for Windows
Damain
User Narne:

Properies

¥ Run scheduled backup on this computer

|1E Log Table (FileBackupSet-1)

Type |

Log Time

| & Backup | ) Restore | (@ Log |

|Backup Cormpleted Successiully

[Quota (Remaining / Tatal) 10G /106 [Last Backup: 2007-01-15 17:20

ii. Enter your Windows domain, username and password into the dialog shown below and press [OK]
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Marme: |Fi\eEackupSet—1
Type: File Backup

Network Resources Authentication for Windows——————————

Domain |wind0ws-d0ma\n

User Mame: Idemo-user

Password: Im

0K | Cancel |

iii. Press the [Save Setting] button on the toolbar

The steps above apply only to computers running in a Windows domain. If you don’t have a windows domain with
your network and you are using a workgroup or using a NetWare server, please use the “net use” command to

authenticate the running backup process against the computer hosting the mapped drive. Otherwise, you will get
“Access Denied” error from the backup report.

For example, if you want to backup \\SERVER\SHARE that is located on a NetWare server (or another computer in

a windows workgroup) and you are getting "Network drive is not accessible" error message, please try adding the
following command as a [Pre-backup command]

net use \\SERVER\SHARE [PASSWORD] /USER:[DOMAIN | MACHINE_NAMEJ\[USERNAME]
E.g.

Add new Pre-backup Command Line Tool x|

Mame: IPre-bacKup Command-1

Command: Inel use WNetwareiData oassword JUSER peter

WurkingDirectuw.l Erowse |
QK | Cancel |

Enter one of the following commands directly into the Pre-Backup Command:

net use \\Netware\Data password /USER:peter
net use \\WorkgroupComputerl\Data password /USER:WorkgroupComputerl\peter

This will authenticate the current process with the NetWare server (or another computer in a windows workgroup)
and backup will then run correctly.

Fortikup is a trademark of Micso Srl Page 23 of 135 (April 24, 2008)



forti up

MIC50 fortified backup

Fortikup OBS v5.2
User’s Guide

5.4 Backup Schedule

A “Backup Schedule” defines the frequency and the time that backups should run automatically.

Backup Set Backup Restore Tools Wiew Help

=181 x|

5] save getting |h start Backup [l Stop Backup |

‘o> Backup Controller [# |[© Backup Schedule (FileBackupSet1)

ﬁ—;‘. User Profile

EH {3 FileBackupSet-1
i) Backup Snurce
B

BackupSchedule-1 Properties il

B

P

Mame |Backup8chedu|e-1

Cornmand Line Too "Bam‘”

] Setting Files
& Encryptian .
: T
fiy Retention Paliey e
5] Extra Backup " Daily " Manthly  Custom
#u In-File Delta
Local Copy rDa
Backup on the following day(s) every week:
[~ Sunday ™ Monday ™ Tuesday [~ Wednesday
[~ Thursday [ Friday ¥ Saturday

d Rermove | Propetties |

tart

Start Tirme (hh:mm): |21 vI:IDD hd

~Stop
" Stop on completion (Full Backup)

) Stop after|a houris)

Ok Cancel

| Time I

1 & Backup | &) Restore | g Log|

[Backup completed with warning(s)

Backup schedule can be in one of the following types:

[Quota (Remaining (Total): 8 A6G / 10 [Last Backup: 2007-01-15 21:00

Type Description

Daily Backup Jobs will run everyday

Weekly | Backup Jobs will run on the specified day(s) of every week

Monthly| Backup Jobs will run on the specified day or on a day with a given criteria (e.g. first
weekend, last weekday) of every month

Custom | Backup job will run once on any particular date

For each schedule type above, backup will run at the scheduled time for a maximum of the duration specified (or
until all data are backed up if [Stop on backup completion] option is chosen). If a backup job does not finish within
the maximum duration specified, it will be interrupted.

Please note that you can have more than one schedule within a backup set. For example, you can have a daily
backup schedule that runs at 13:00 at noon and another daily backup schedule that runs at 00:00 at midnight.
The combination of these schedules effectively creates a backup schedule that runs daily at 00:00 and 13:00

everyday.

5.5 Backup Filter

A “Backup Filter” defines the file selection rules that allow user to easily include/exclude files into/from the backup
set by applying user defined criteria(s) to the file names or directory names.

There are some basic rules regarding backup filters:

Filters are checked in creation order. Once inclusion/exclusion has been identified, the remaining
filters won't be checked.

Inclusion/Exclusion made by filter always takes precedence over backup source selections

If all filters do not apply to a particular file, this file is then checked for inclusion/exclusion backup
source selections
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_ Online Backup Manager == x|
Backup Set Backup Restore Tools View Help
15| save Setting " Start Backup [l Stop Backup |

ler Backup Cantroller 1 Backup Filter (FilsBackupSet-1)

[+ ) FileBackupSet-1
{5 Backup Source MName: |FiHer—1

Top Directony: |

Browse

¥ File: I™ Directory

Apply To

Pattern Matching

= Local Copy Type: + Text " Regular Expression
 starts with & contains " ends with
Pattern Add
Refmove
Froperiies
Time I
Filter Mode
& Include matched  Excluge matched
I~ exclude all others
6]34 Cancel
" (& Backup | @ Restora] [ Lo
|Backup completed with warningds) |Qu0ta {Remainingf Total): 9.86G 110G |Last Backup: 2007-01-145 21:00
Key Description
Name The name of a filter
Top Directory The top directory to which this filter is applied. Filtering rules will be applied to

all files and/or directories under this directory.

Apply To Define whether to apply the filtering rule to files and/or directories

Pattern Matching |[It defines the filtering rules of a filter. A filtering rule can be of one of the
following types:

[Starts With] Include/Exclude all files/directories with name starting
with a certain pattern.
For example: You can use B* to match all files with
name starting with a ‘B’ character

[Contains] Include/Exclude all files/directories with name
containing a certain pattern.
For example: You can use *B* to match all files with
name containing with a ‘B’ character

[Ends With] Include/Exclude all files/directories with name ending
with a certain pattern.
For example: You can use *.doc to match all files with
name ending with ‘.doc’ (all Word documents)

[Regular Expression] Include/Exclude all files/directories with name matching
a regular expression.

Filter Mode Defines whether you want to include or exclude matched files into/from the
backup set. Also, for those unmatched files, you can choose to exclude (if
include filter type) or include (if exclude filter type) them into/from the backup
set.

Example 1:
If you want to backup only Word, Excel and PowerPoint documents in your document directory (e.g. C:\My

Documents), you should setup your backup filter as follows.

Top Directory = C:\My Documents
Apply To = File (true)
Matching Type End With
Matching Patterns = *.doc, *.xls, *.ppt
Filter Mode = Include
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Exclude all others = True

Example 2:
If you want to backup all files, excluding all *.exe, *.dll and *.tmp, in C:\Applications, you should setup your

backup filter as follows.

Top Directory = C:\Applications
Apply To = File (true)
Matching Type = End With
Matching Patterns = *.exe,*.dll, *.tmp
Filter Mode = Exclude

Include all others = True

Example 3:

If you have made your selection of files (all under C:\) from the backup source setting but you want exclude all
images (e.g. *.jpg and *.gif) from your selection, you should setup your backup filter as follows.

Top Directory =C:\

Apply To = File (true)
Matching Type = End With
Matching Patterns = *.jpg, *.gif
Filter Mode = Exclude
Include all others = false

Please note that the [Include all others] setting is not enabled because you don’t want to include all other files
(NOT *.jpg, *.gif) under C:\ into the backup set.

Example 4: (advanced)

If you want to include everything, except the “log” directory, under C:\Applications into a backup set, you should
setup your backup filter as follows.

Top Directory = C:\Applications
Apply To = Directory (true)
Matching Type = Regular Expression
Matching Patterns = "™og$

Filter Mode = Exclude

Include all others = True

Example 5: (advanced)

If you want to include all directories named “log” from the backup set files with file name starting with “B” and
ending with “*.doc” under C:\My Documents into the backup set, you can use a regular expression of
“~B.*\.doc$” to do your selection. The filter backup can then be setup as follows.

Top Directory = C:\My Documents
Apply To = File (true)
Matching Type = Regular Expression
Matching Patterns = ~B.*\.doc$

Filter Mode = Include

Exclude all others = True

5.6 Pre/Post-Backup Command

The “Command Line Tool” feature has two major components, the [Pre-Backup] command and the [Post-Backup]
command. You can use the [Pre-Backup] or [Post-Backup] commands to run any native OS (operating system)
commands before or after running a backup job.
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Both [Pre-Backup] and [Post-Backup] commands comprise of the following parameters:

Key Description
Name Name of this Command
Command The command to be run

(e.g. C:\My Documents\Application.exe or C:\My Documents\BatchJob.bat)

Working Directory

The directory at which this command will run

The backup set type affects the time at which [Pre-Backup] and [Post-Backup] commands run. The following table
outlines when [Pre-Backup] and [Post-Backup] commands will run in different types of backup set.

Backup Set Type

When Pre-Backup Commands run?

When Post-Commands run?

File

Before uploading backup files

After uploading all backup files

Non-File Backup Sets
(e.g. Microsoft SQL
Server)

Before spooling backup files to
temporary directory

After spooling backup files to
temporary directory (i.e. before
the first backup file is uploaded)

Note: You should never backup an application while it is running as this can result in inconsistent and unusable
files getting backed up. Please use the “Volume Shadow Copy” feature if you’re running Windows XP/2003 or
make use of the Pre-Backup Command feature to shutdown your application before running a backup job and use
the Post-Backup Command feature to restart your application after the backup job has completed.

For Example

You want to stop Microsoft Outlook using the Pre-Backup Command and restart it after backup using the Post-
Backup Command, create the two following text files and assigned the files to Pre-Backup and Post-Backup

Command.

1. Create a text file named “OutlookClose.vbs” using notepad with the following two lines:

Set obj OLK = creat eObj ect (" Qutl ook. Appl i cation")

obj OLK. qui t

2. Create a text file named “OutlookStart.bat” using notepad with the following line:

"C:\Program Fil es\M crosoft O fice\ OFFI CE11\ OQUTLOOK. EXE"
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5.7 Temporary directory

If you are running a file backup job with in-file delta enabled or a database type backup job, OBM will generate
temporary files and the directory that will be used to store all these files are defined by [Setting] -> [Temporary
directory for storing backup files]. Please set this to a non-system disk partition that has enough free space to
avoid problems.

You can set the [Temporary directory for storing backup files] to a mapped network drive. If you choose to do this,
please use a UNC path (e.g. \\SERVER\SHARE) and don’'t forget to configure the [Backup Set] -> [Network
Resources Authentication for Windows] setting.

To conserve the use of disk space, you can set the [Remove temporary files after backup] option to delete the
temporary files automatically after a backup job has finished.

5.8 Transfer Block Size

Transfer block size defines the block size OBM will use to transfer your backup blocks. Generally, backup jobs
using a larger block size will have better performance, because of the smaller number of connections involved.

However, some firewalls or proxy servers may block out-going network traffic (HTTP/HTTPS POST method) with
large block size for security reasons. If you are in a network with this type of restriction, please lower the transfer
size value and try again.

To change the transfer block size of any backup set, please select the [Setting] node on the left panel to invoke
the [Setting] panel on the right. You can then make changes to the [Transfer Block Size]. After you have made
your changes, just press the [Save Setting] button on the toolbar.

L8l

Backup Set Backup Restors Tools View  Help
15| save Setting |> Start Backup [ Stop Backup |

t.'} Backup Controller ,'?‘ r'_! Setting (FileBackupSet-1)
=
['-‘ U_sler.ProﬁIe Temporary directory for staring backup files
EH FileBackupSet-1
—.uj Backup Source |C:\Documents and Settings\john.emith.obmipciBackupSet Browse |
S Backup Schedule
— Backup Filter Transfer Block Size
—ECnmand Line Toal 12007 Eytes

& S

—,__,_ Encryption -

i Retention Palicy Symbalic Link {Linux
=] Extra Backup Follaw symbalic iRk
¢ In-File Delta Cves (0o
—r='—’|LUEaI Copy

“olume Shadow Copy (Vindows 2003 & XP)
Enable Volume Shadow Copy
" Yes (* Mo

|@ Log Table (FileBackupSet-1)
Type | Log Time

& Backup | &) Restore | g Log |
|Elackup Completed Successfully |Guota (Remaining f Total): 9.86G 110G |LastElackup: 2007-01-15 21:00

5.9 Follow Symbolic Link (Linux/Unix/Mac only)

Under Unix/Linux/Mac, users can create a symbolic link to link a file/directory from another directory. This setting
defines whether you want OBM to traverse any symbolic links encountered on your backup path.

To change the follow symbolic link of any backup set, please select the [Setting] node on the left panel to invoke
the [Setting] panel on the right. You can then make changes to the [Follow Symbolic Link]. After you have made
your changes, just press the [Save Setting] button on the toolbar.
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5.10 Microsoft’s Volume Shadow Copy Service (VSS)

Microsoft Volume Shadow Copy Service (VSS) allows you to backup files that are exclusively opened. Without VSS,
you will get the error message “The process cannot access the file because another process has locked a portion of
the file” if you are trying to backup a file that is exclusively opened (e.g. Outlook PST file).

Please note that VSS is only available on Windows XP / 2003 and you must have administrative privileges to start
the VSS service on a computer. Also VSS will only work if at least one of your partitions is formatted using NTFS.

If you are running Windows 2003, please install the Windows 2003 VSS hot fix available in
http://support.microsoft.com/default.aspx?scid=kb:en-us;887827 before running VSS.

If you are running into problems with VSS running on Windows XP / 2003, Microsoft's recommendation is to try
re-registering the Volume Shadow Copy Service again. Simply run the script [OBM Home]\bin\RegisterVSS.bat to
do so.

For more information, please take a look at the following page for a technical introduction to Volume Shadow Copy
Services (VSS):

http://technet2.microsoft.com/windowsserver/en/library/2b0d2457-b7d8-42¢3-b6c9-59¢145b7765f1033.mspx

5.11 Encryption

Before your files are sent to the Offsite Backup Server, all your files are compressed and encrypted using your
choice of encryption algorithm, mode and key. The following table explains all encryption parameters available
within a backup set.

Note:
Encryption settings are set at backup set creation time and cannot be modified. You need to create a new backup
set if you want to change your encryption settings for a backup set.

-(0] x|

Backup Set Backup Restore Tools View Help
JEJ Sawe Setting |P Start Backup . Stop Backup |

&> Backup Controller [} \'x, Encrytion (FileBackupSet1)
[:_‘. U_sler Profile Encryption
E!—;g. FileBackupSet1

LD Backup Saurce Algarithm: AES
9 Backup Schedule Mode: ECB
i Backup Filter

=] Command Line Tool

{1 setting [ Mask Encrypting Key

Encrypting Key, [*

o) yption
\ﬁ[ Retention Policy
=] Extra Backup

iz In-File Delta

=3 Local Copy

‘ Log Tahle (FileBackupSet-1)

Type | Log Time
| & Backup |\='l Restnre| I=} Lng|
|Backup Completed Successfully |Quuta {Remaining / Total); 10G /110G |Last Backup: 2007-01-1817:20
Parameter Description

Encryption Algorithm |It defines the encrypting algorithm used to encrypt your backup files. There are
three encryption algorithms available:

[AES] Advanced Encryption Standard algorithm

Fortikup is a trademark of Micso Srl Page 29 of 135 (April 24, 2008)


http://support.microsoft.com/default.aspx?scid=kb;en-us;887827
http://technet2.microsoft.com/windowsserver/en/library/2b0d2457-b7d8-42c3-b6c9-59c145b7765f1033.mspx

MIC50 fortified backup

User’'s Guide

Forti Up Fortikup OBS V5.2

[DESede] Triple DES algorithm
[Twofish] Twofish algorithm

We recommend the use of AES as it has been chosen as the encryption standard for
commercial use. Please refer to references on Cryptography for more information
about encryption algorithms.

Encryption Mode It defines the encrypting mode used to encrypt your backup files. There are two
encryption modes available:

[ECB] Electronic Cook Book Mode
[CBC] Cipher Block Chaining Mode

We recommend the use of CBC mode as it offers better security. Please refer to
references on Cryptography for more information about encryption modes.

Encrypting Key The key used to encrypt all files within a backup set. Please write it down on
paper and keep it in a safe place. If the key is lost, you will not be able to
recover your files from the encrypted backup files.

5.12 Retention Policy

During backup, if OBM finds that you have deleted a file (or updated a file) on your computer, it will put the
corresponding deleted (or updated) file already backed up on the backup server into a retention area. The
retention policy setting defines how long files inside the retention area will be kept on the backup server before
they are deleted automatically from the server.

Retention policy will only affect “retained” file (i.e. files that have already been deleted or updated on your
computer and thus are moved to the retention area of the backup server). For those files that have not been
updated on your computer, the backup of these files is kept in the data area on the backup server and won’t be
affected by the setting of retention policy. These backup files of unchanged files will stay on the backup server
forever until the original files are removed (or updated) from your computer.

Standard Retention Policy

The [Standard] retention policy allows you to delete retained files automatically after a user defined number of
days or after a user defined number of backup Jobs. To change the retention policy setting of any backup set,
please select the [Retention Policy] node on the left panel. You can then make changes to your retention policy
under the [Retention Policy] section. After you have made your changes, just press the [Save Setting] button on
the toolbar.

1o

Backup Set Backup Restore Tools View Help
JEJ Save Setting |’ Start Backup . Stop Backup |

g‘: Backup Controller E?‘- '.JTL! Retention Policy (FileBackupSet-1)
=2 U Profil
[E—ﬁg'e;i\er;e:cekupsm—1 + Keep deleted file(s) far IT ;I |Days;|

Lﬁ Backup Source " Advanced
5 Backup Schedule
Backup Filter
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™ Remove retention files for overlap policy

s In-File Delta
Local Copy
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{7 Log Table (FileBackupSet1)
Type | Log [ Tirne |

& Backup | &) Restare | @ Log|
[Backup Completed Successtully [auota (Remaining f Total): 10G /106G [Last Backup: 2007-01-1517:20
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The [Advanced] retention policy allows you to configure a more flexible retention policy. It allows you to keep a
set of snapshots of all backup files based on the time of the backup Jobs. For example, you can configure the
advanced retention policy to keep the following sets of backup files to mimic the retention policy of the old days

when you were still doing tape rotations:

4 All files available within the last 7

* & o o

days

All files available on the last 4 Saturdays within the last 28 days
All files available on the 1% day of each month within the last 3 months
All files available on the 1% day of each quarter within the last 12 months

All files available on the 1% day of each year within the last 7 years

To do so, you need to setup your advanced retention policy as follows:

€ Type = Daily; Number of copy to keep = 7

* & o o

Type = Weekly; Frequency = Saturday; Number of copy to keep = 4

Type = Monthly; Frequency = Day 1; Number of copy to keep = 3

Type = Yearly; Frequency = Date 01-01; Number of copy to keep = 7

Type = Quarterly; Frequency = Day 1 of Jan, Apr, Jul, Oct; Number of copy to keep = 4

Assuming today is 17-Jan-2006, if [Remove retention files for overlap policy] is NOT enabled, a total of 22
snapshots (provided you have run backups daily for more than 7 years) will be kept on the server accordingly, i.e.:

Daily Weekly Monthly Quarterly Yearly
16-Jan-2006 14-Jan-2006 01-Jan-2006 01-Jan-2006 01-Jan-2006
15-Jan-2006 07-Jan-2006 01-Dec-2005 01-Oct-2005 01-Jan-2005
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14-Jan-2006 31-Dec-2005 01-Nov-2005 01-Jul-2005 01-Jan-2004
13-Jan-2006 24-Dec-2005 01-Apr-2005 01-Jan-2003
12-Jan-2006 01-Jan-2002
11-Jan-2006 01-Jan-2001
10-Jan-2006 01-Jan-2000

If [Remove retention files for overlap policy] is enabled, only the following snapshots are kept:

Daily Weekly Monthly Quarterly Yearly

16-Jan-2006 14-Jan-2006 01-3Jdan-2066 01-3Jdan-2066 01-Jan-2006
15-Jan-2006 07-Jan-2006 61-Bee-2065 61-0et-2065 01-Jan-2005
14-Jan-2606 31-Bee-2665 B61-Nev-2605 64-3ul-2065 01-Jan-2004
13-Jarn-2006 24-Dee-20065 B1-Apr-20065 01-Jan-2003
I2-Jan-2606 01-Jan-2002
+H1-Jan-2606 01-Jan-2001
10-Jan-2006 01-Jan-2000

The weekly policy overrides the daily policy so the snapshots of 10-Jan-2006, 11-Jan-2006, 12-Jan-2006, 13-Jan-
2006 and 14-Jan-2006 are removed. The monthly policy overrides the weekly policy so the snapshots of 24-Dec-
2005 and 31-Dec-2005 are removed. The same applies to the monthly, quarterly and yearly policy giving a total
of 11 snapshots.

5.13 Extra Backup (Off-line backup, Logout Reminder)

Off-line backup is basically designed for notebook users who are off-line most of the time and cannot rely on the
backup schedule to backup regularly. The "Backup Interval" allows notebook users to specify the interval that they
would like their data to backup. When the machine is online and this interval has elapsed, backup will run
automatically. If “Backup Alert” is enabled, a popup message box will ask the user to confirm starting the backup.

The "Email Notification" setting is the number of days since the last backup that triggers the backup server to send
email notification to the client to remind him to run an off-line backup.

When the “Logout Reminder” setting is enabled, a popup message box will ask the user to start a backup before
logging out / shutting down Windows.
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5.14 In-File Delta

Please refer to the in-file delta section for more information on this topic.

5.15 Local Copy

If you want to save an extra copy of backup data on your local hard disk (in addition to a copy of backup data
stored on the backup server) to minimize file-restoring time and/or to provide an extra safety precaution, you can

do the following:

i Open OBM from the System Tray (see previous sections for details)

ii. Setup your backup set (see previous sections for details)

iii.  Select [Local Copy] under your backup set from the left panel
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iv.

Check the [Copy to Local Hard Disk] checkbox

V. Enter a directory to where you want an extra copy of your backup files to be stored in the [Copy to]
field provided (preferably a directory under another hard disk)

Vi.

conserve free space usage

Vii.

ISETE
Backup Set Backup Restore Toaols View Help
15 save Setting |’ Start Backup [l Stop Eackup |
e s Backup Cantraller [ |[5) Backup Set- FileBackupSet-1
T -
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— 4 Backup Schedule Log Table (FileBackupSet-1}) 9

Backup Filter
Command Line Taoal

Type | Log | Time |

Setfting

—iaJ Encryption
—\f—uj Retention Policy
=] Extra Backup
% In-File Delta

L= Local copy

Finished running pre-cammands

Reading backup source from hard disk...

Reading backup source from hard disk .. Completed

[Local Copy] Start running local backup

[Local Copy] Reading lacal backup files fram hard disk...

[Local Copy] Reading local backup files from hard disk... Compl..
[Local Copy] Getting all files which have been added... Completed
[Local Copy] Getting all files which have been updated... Campl...
[Local Copy] Getting all files which have been deleted... Comple..
[Local Copy] Getting all files which have heen moved... Complet..
[Local Copy] Total Mew Files =0

[Local Copy] Total Updated Files =0

[Local Copy] Total Update File Permission=10

[Local Copy] Total Deleted Files =1

[Local Copy] Total Moved Files =0

[Local Copy] [Deleted File] Deleting "CihlLocalBackupl1 1688483,
[Local Copy] Finish running local backup

Start running postcommands

Finished running postcommands

Backup Completed Successfully
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[2007/01/16 11:37:44]
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G0000000008008880089

-

1 2 Backup IQ“ Restorel [I=4 Logl

|Backup Completed Successfully

|Quota (Remaining ! Total): 9.86G 110G |Last Backup: 2007-01-15 21:00

(Optional) Select the [Yes] radio button if you want to store your backup files in compressed form to

An extra copy of backup will be saved in the [Copy to] directory when you run your backup job
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If you want to make local copy to a directory located on a NetWare server (or another computer is a windows
workgroup) and you are getting "Network drive is not accessible" error message, please try adding the following
command as a [Pre-backup command]

net use \\SERVER\SHARE [PASSWORD] /USER:[DOMAIN | MACHINE_NAMEJ\[USERNAME]
E.Q.

C:\> net use \\Netware\Data password /USER:peter
C:\> net use \\WorkgroupComputer1l\Data password /USER:WorkgroupComputerl\peter

This will authenticate the current process with the NetWare server (or another computer is a windows workgroup).
Backup will then be allowed to run correctly.

How to restore “Local Copy” files

“Local Copy” files are stored in the [Copy to] directory (under [Local Copy] setting). To restore backup files,
please do the followings:

i. Choose [Tools] -> [Unzip Local Copy]
-l8[x

Backup Set Backup Restore | Tools Wiew Help

|5 save setting P> start Backu L TVIRR LR Ko |
I
\er Backup Contraller _ = Decrypt Files Wizard haat
[-_‘_prs‘erPrnﬂle Eackup Set ﬁl
1!L|jBackup Source ’V Mame: FileBackupSet-1 | j
—®Backup Schedule LngTahIe(Fl\eEackupSet—U
Backup Filter
] Gommand Line Taol Tyne I — - Log I Time I
ESetling @ Flnlahed running pre-commands . [2007/011611:37:48] ﬂ
& Encryption @ Reading backup source fram hard disk... [2007501M 6 11:37:48]
_(,—,'_I' Fetention Palicy @ Reading backup saurce from hard disk... Completed [2007501M6 11:37:49]
| = Extra Backup 2 [Local Copy] Start running local backup [2007/01116 11:37:49)
"~ In-File Delta (D [Local Copy] Reading local backup files from hard disk... [2007/0116 11:37:44]
—,%Lgca\ Copy @ [Local Copy] Reading local backup files from hard disk... Compl... [2007/01016 11:37:49]
@ [Local Copy] Getting all files which have been added... Completed [2007/01M 6 11:37:49]
@ [Local Copy] Getting all files which have heen updated... Compl... [20070011611:37:49]
D [Local Copy] Getting all files which have heen deleted... Cample... [2007/01/16 11:37:49]
@ [Local Copy] Getting all files which have been moved... Complet.. [200750116 11:37:49]
D [Local Copy] Total Mew Files = 0 [2007401/16 11:37:44]
@ [Local Copy] Tatal Updated Files =0 [20075011 6 11:37:49]
@ [Local Copy] Total Update File Permission=10 [2007/011611:37:49]
@ [Local Copy] Taotal Deleted Files =1 [2007/01M 6 11:37:49]
@ [Local Copy] Total Moved Files =10 [2007501M6 11:37:49]
D [Local Copy] [Deleted File] Deleting "CLocalBackupt! 16RE483 [2007/01/16 11:37:49]
@ [Local Copy] Finish running lacal backup [200750116 11:37:49]
@ Start running postcommands [2007/011611:37:80]
@ Finished running postcommands [2007/01M 6 11:37:60]
@ Backup Completed Successiully [20070011611:37:81] z
& Backup | &) Restore | (@ Log |
|Eackup Completed Successiully |Quota (Remaining f Total): 9.86G /110G |LastBackup: 2007-01-15 21:00

ii. Select the required [Backup Set] from the drop down list
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X

Backup Set: IFiJeBackupSet—l

~Source Directary

IC MoocalBackup

~Destination Directony

|D Restore

hange

=l
Chmlgel
_ G|

[2005-06-28 22:25:22] Start
[2005-06-28 22:25:22] Copying CAMlocalBackopyC MCONFIG ST zip' to TRestoredC _NCONFIG STE'
[2005-06-28 22:25:23] Copyving =ALocalBackophC_Mrvnetimg zip' to D \RestoredC_drmet img’
[2005-06-28 22:25:22] Completed Successfully

Btart | Bop

iii.  Fill in the [Source Directory] (directory where “Local Copy” files are stored) and [Destination
Directory] (directory to where you want “Local Copy” files to be restored)

iv. Click [Start]

5.16 Using One Backup Account for Multiple Computers

OBM allows you to backup multiple computers using a single backup account. To backup multiple computers, you
need to create a different backup set to backup each individual computer and to configure the [Run scheduled
backup on this computer] checkbox.

Lt Online Backup Manager

Backup Set Backup Restore Tools Wiew Help

==l

15| save setting [P Start Backup [l Siop Backup |

e Backup Cantraller [La)

|3 Backup Set - FileBackupSet-1

[—_‘.UserF’roﬂIe

5] Comrmand Line Tool
] setting

(&) Encryption

—\TT_'[ Retention Paolicy
—1§Extra Backup

% In-File Delta

—%Lucal Copy

Backup Set

Mame: FileBackupSet-1
IC: 1168848359906
Type: File Backup

Metwork Resources Authentication for Windows

Damain
User Mame:
Password:

Froperies |

¥ Run scheduled hackup on this computer

Log Tahle (FileBackupSet-1)

Type | Log

Time

" Backup [ @ Restore] [ Log]

|Elac|-(up Completed Successfully

For version 5.2

|Quma (Remaining f Total): 8.86G /110G |LastElackup: 2007-01-15 21:00

Since the computer that created the backup set will have its computer name associated with the backup set. The
backup scheduler running on each computer will only run backup sets with the same computer name as itself.
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Thus, you just need to make sure that all your computer names using a single backup account are unique.

For version 5.1 or Earlier

You must configure OBM on each computer that it only runs scheduled backup for the intended backup sets only.
If this is not setup properly, scheduled backup job of the same backup set from different computers will both be
started. This will result in lots of checksum errors and files being deleted on the backup server.

To allow multiple computers to be backed up under a single backup account, you are required to do the following
for each computer that has installed OBM under the same backup account:

i. Logon to one of the computers that has OBM installed under the same backup account.
ii. Open OBM and select a backup set that is not intended to run on this computer from the left panel.

iii. Make sure that the [Run scheduled backup on this computer] checkbox on the right panel is not
checked.

iv. Repeat the previous step for the rest of the backup sets that are not intended to run on this
computer.

V. Repeat steps ii to iv for each computer that has OBM installed under the same backup account.

IMPORTANT If you create a new backup set or want to backup another computer using the same backup account
at a later date (this implies that you need to create an additional backup set under this backup account for the
new computer), please make sure to repeat the procedure above (i.e. uncheck the [Run scheduled backup on this
computer] checkbox for the added backup set) for each computer.
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6

Backing Up Files

This chapter describes how files are backed up by OBM to the backup server

6.1 How files are backed up

The diagram below describes how OBM backup your files.

Authentication
parmeters &
Zipped & encrypted fles Zipped & Mary
Raw Encrypted aresentin3SSL  Encrypted
File File File i |
K= aQ [ =
’ Data e 0 e
L0 7 John
i |

Backup 8perations:

1. Collect all files which are new or ha
been updated since last backup

Run backup at scheduled time automatically 2. EaCh Of these files iS Zipped,

Once you set your backup scheduled, a backup job will be stargﬂmﬂgﬁﬁomgrr§gaﬁ(”pr%ua\tplaf&ked up
you at your absence. You can have backup running at your sch eOnﬁaﬁé‘thkjth@rWr 1mough

or hourly during office hour) without requiring doing any extra w
Secure Socket Layer (SSL)

Incremental Backup
User’s Computer

Unchanged files are already backed up to server and need not to be backed up again. OBM will pick the new or
updated files from your backup set files and upload only these files to the server. It significantly reduces the time
required to perform the backup operation since most users update less than 5% of their total data each day.

User Directory

Compress and encrypt data automatically

Data are compressed and encrypted before they are uploaded to the server. Not only does it reduce the storage
space to keep you backup files, it also ensures the privacy of your data.

Eile Retention Policy

The built-in file retention policy allows you to access multiple versions of the same file or even deleted files from
your backup set. Backup files are put into a retention area before they are removed from the server. If you want
to get back a deleted file (or you want to get back the previous versions of an updated files) within the retention
period, these files will always be available in the retention area. This feature is particularly useful when you have
accidentally deleted a file or incorrectly updated a file within the file retention period (file retention period is user
customizable).
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6.2 Backup files directly to the backup server

You can backup your data to an Offsite Backup Server by following instructions below.
vi. Open OBM
vii. Right click OBM icon available in the system tray and choose [Open]
a. Create a backup set

b.  From the Menu, Choose [Backup Set] -> [New] -> [File Backup Set]

SETES
Backup Set Backup Restore Tools View Help

|@) File Backup Set

(A Remove » |2 Svstem State Backup Sat

m {4 Lotus Backup Set
BT |#) M8 Exchange Backup Set
T fH MS Exchanae Mail Level Backup Set
|7 MS AL Server Backup Set e —

|42 MySGL Backup Set
ﬁéf Oracle Database Backup Set

an Account Change

(&) Encryption FAccount Inform ation
ﬁ' Retention Palicy

=] Extra Backun GQuota: 100G
i In-File Delta Time Zone: IGMT+DS:DD(HK‘I’) 'I
Local Copy
rCaontact
Idemu@yuur—cumpany.cum LI

Contact Mame: Demonstration Account
Email Address: demo@your-company.com

Add Remove Froperties |
& Backup | € Restore | @ Log|
|Backup Completed Successiully |Quota (Remaining f Total): 9.86G 100G \Last Backup: 2007-01-15 21:00

C. Enter a name for your backup set

Add new File Backup Set x

~Backup Set
Please type a name far this Backup Set.

Mame: IFiIeElackupSet—‘l

1D: 1168819585156
Type:  File Backup

Cancel | = Frevious Mext =

d. Select the files/directories you want to backup
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Add new File Backup Set x|

~Backup Source

Please selectfiles orfand directories to be hacked up.

- Standard -
B My Documents (CiDocuments and Settingsisolo
|£| Outlook (CADocuments and Settingsisolaman.yu
5] Outlook Express

[ [E} Desktop

ﬁ:l:l@omions

= i My Computer

[ Local Disk ()

[ Lacal Disk (D)

[J%e Lacal Digk (E)

[J=ee Local Disk (F3

]2 DVD-RW Drive (33

O wrosePublic (P f
D@MySharing Folders -
Kl | o

Cancel | = Previous | Mext =

e. Set the backup schedule (Note: You can have more than one schedule in a backup set)

Add new File Backup Set x

Backup Schedule

Please schedule the backup time.

Add Remove | :
Cancel | = Previous | Mext = |
f. Set the encryption algorithm, encryption mode and encrypting key for this backup set

(Hint: For the sake of simplicity, just select the [Default] radio button (your encrypting key is
set to be the same as your backup account password)
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x

~Encryption Setting
Please setup the encryption setting ofthe Backup Set.

" Default (Use Login Password as Encrypting Key)
(ol

[~ Do MNOT use encryption.

Algorithm: IAES vl

hode;
' CBC (Cipher Block Chaining)

 ECE (Electronic CookBook)

Enerypting Key: |

Confirm Encrypting key: I

Cancel | = Previous Mext =

viii. Run Backup

a. Select the backup set you want to run on the left panel and press the [Start Backup] button
(») on the toolbar

b.  Select [Off-site Backup Server] to start backing up your files to an Offsite Backup Server.

Confirm Backup Start x|

Backup to
' Offsite Backup Server
 Local Hard Disk (Seed Load Utilitd

Start the backup for [FileBackupSet-1] 7

]34 Cancel Optiong ==

Note:
1. You can have more than one backup set in a backup account.
2. Please write the encrypting key down on paper and keep it in a safe place. If you lose your encrypting key,

you will not be able to restore your backup files.

6.3 Backup files to removable hard disk (seed loading)

If you have a lot of data (e.g. 300GB) to backup to the backup server, it would take a considerable amount of
time to perform the first full backup through the Internet. If you run into this problem, you can use the Seed
Loading Utility to backup your backup set to local hard disk (instead of directly to the backup server) and then
transport the backup data, using removable hard disk, to the offsite backup server. The administrator can then
load all your backup files from your removable hard disk into your backup account. This could then save you days
(even weeks) of performing your first full backup. Since subsequent backup will be incremental backup (only new
or updated files will be uploaded to the server) you should have no problems uploading your backup data

afterwards.
To perform seeding loading, please do the following:
i. Open OBM from the System Tray (see previous sections for details)

ii. Setup your backup set (see previous sections for details)

iii. Select the backup set you want to run on the left panel and press the [Start Backup] button (»)
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on the toolbar

iv. Select [Local Hard Disk (Seed Load Utility)] to start backing up your files to local hard disk and
press the [OK] button

Confirm Backup Start x|

Backup to
" Offsite Backup Server
% |Local Hard Disk (Seed Load Ltility

Startthe backup for [FileBackupSet-1] 7

Ok Cancel Options ==

V. Enter a directory where you want all backup files to be stored in the [Destination Directory] field
and press the [Start] button.

Please make sure you have enough free space in the directory specified. If you are going to
transport a removable hard disk to the offsite backup server, please enter a directory under your
removable hard disk here.

Load Utility) x|

Backup Set.  FileBackupSet1

Backup Type: File

~Destination Directory

E:1Seed-Loading-Directary] Browse

Start Stop

vi.  You should get the message “Backup Completed Successfully” as shown below after all backup
files are spooled to the directory you specified.

En Backup to and, D 2 . Uity x|

Backup Set.  FileBackupSet-1

Backup Type: File

~Destination Directory
El\Seed-Loading-Directory Browse

Collecting all files in this backup set.. Completed :l
Total Files=9

[1/5] Processed 'CIAUTOEXEC BAT'

[2/5] Processed 'Ciibootini*

[3/5] Pracessed 'Chdellimg’

[4/5] Processed 'Cidrnetimg’

[5/5] Processed ‘Cildrinet2.img'

Start running postcommands

Finished running post-commands

Backup Completed Successfully -

L1}
Processed: 3.1M { 3206764 byte ) Start Stop:

vii. Transport the data specified in the [Destination Directory] field to the offsite backup server
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7 Restoring Files

This chapter describes different ways files can be restored from to the backup server

It is very important to write down your encrypting key on paper and keep it in a safe

place because there will be no way to restore your backup files if you lose your
encrypting key.

7.1 Restore backup files directly from backup server

You can use either OBM or the web restorer to restore backup files from the backup server.

Using OBM
You can restore your data from the backup server by following instructions below.
i. Open OBM from the System Tray (see previous sections for details)

ii. Select the [Restore] tab at the bottom part of OBM

18]

EBackup Set Backup Restore Tools View Help

|5 save Setting | P> Restore Files |

g'l Restore Contraller :I I Restore Source (FileBackupSet-1) :I
: : = Show files afterJob [2007-01-16 (12:03:40) 7| Showall files

= Backup Server [l
EHAS]
E-A S images |2007-01-16 (12:01:21)
ﬂ aix.png (Date Madified: Tue 31 472006 12:46 PM Size: 21k)
B2 (5] A _logo.JPG (Date Modified: Tue 3/14/2006 12:08 PM Size: 6K)
ﬂ apple.png (Date Madified: Tue 31 472006 12:45 PM Size: 29k)
ﬂ apple_logo jpg (Date Modified: Tue 311 4/2006 12:00 P Size: 5k)
ﬂ B_linux.png (Date Modified: Tue 31 452006 12:42 PM Size: 22k)
ﬂ BSD.0if (Date Modified: Tue 31 4/2006 12:26 PM Size: 21K
ﬂ BSD.png iDate Modified: Tue 314/2006 12:22 P Size: 3K)
ﬂ hsd_logo.png (Date Modified: Tue 301 42006 12:37 PM Size: 44K)
] %] hp-ue gif (Date Modified: Tue 201 42008 1208 PW Size: 2K
ﬂ hpuwxpng (Date Modified: Tue 31472006 12:44 PM Size: 15k
'_\; linux.hmp {Date Modified: Thu 2092008 5:19 PM Size: 53k
ﬂ linuz.png {Date Modified: Sat 31172006 11:52 A Size: 8k
'_\; linuxzZ.bmp {Date Modified: Sat 311/2006 11:51 A6 Size: 13k
ﬂ loga.gif {Date Modified: Sat 31 82006 11:39 AM Size: 3K
'_\; mac.bmp {Date Modified: Thu 2972006 5:19 PM Size: 148k
ﬂ mac.png {Date Modified: Sat 31 172006 11:52 AM Size: 8K
'_\; mac2hbmp (Date Modified: Sat 31172006 11:51 AM Size: 12k
ﬂ map.gif iDate Modified: Wed 3222006 9:34 AM Size: 10k
ﬂ open.png (Date Modified: Mon 41 0520068 9:44 AM Size: 67K
ﬂ openz.png (Date Modified: Fri 110572004 1:01 PM Size: 75k)
ﬂ solaris_logo.oif (Date Modified: Tue 31 452006 12:01 P Size: 2K)
B4 (%] solaris_ngo.png (Date Modified: Tue 314/2006 12:28 PM Size: 8k) =

|»

s Backup ) Restore | 16 Log |
|Elackup Completed Successfully |Guota (Remaining [ Total): 9.86G /110G |LastEackup: 2007-01-15 21:00

iii. Select the backup set from which you would like files to be restored from the left panel

iv.  Select the snapshot of your backup files that you would like to restore from the backup server by
using [Show files after Job] drop down list

v.  Select the files that you would like to restore and press the [Restore Files] button on the toolbar
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It Restore Files |

Backup Set FileBackupSet1 (FILE)
~Restore files to

- Browse |

[ Restore file permissions

Tirme Log |

Estimated Total Restore Time:
Estimated Restore Time:
Saving File To;

Restaring Speead:

Close | Start | Stop |

vi. Use the [Browse] button to select the directory to where you want files to be restored (or simply
select [Original location] to restore files to their original path)

vii. Files will be restored automatically as shown below (a file won’t be downloaded from the backup
server again if an identical file exists on local path already)

.In Restore Files x|

Backup Set: FileBackupSet-1 (FILE)
~Restore files to

 Original location

* |citemp Browse |

¥ Restare file permissiong

Tirme Log |
2007-01-1612:06:27 Start il
2007-01-16 12:06:27 Downloading restore file list ..

2007-01-1612:06:27 Ciownloading ... eMempimages' (Total O ytes)

2007-01-1612:06:27 "citemplimages” containg the same file permission. Skip restare file p...
2007-01-1612:06:27 Ciowenloading ... eMemplimagestwindows bmp' (Total 9k bytes)
2007-01-1612:06:27 chtempimagesiwindows. bmp {9k ytes) downloaded

2007-01-16 12:06:27 "citermplimageswindows bmp" containg the same file permission. Sk,
2007-01-16 12:06:27 Downloading .. clempimagesiUnicpng' (Total 4k bytes)
2007-01-16 12:06:27 citempimages\Uniz png (4k bytes) downloaded LI

reeeerg e e e L
Estimated Total Restore Tirme: 0 sec (Total 479 33k bytes - 479 36k bytes restored)

Estimated Restore Time: 0 zec (Total 43.66k bytes - 4366k hytes restored)
Saving File To: citermpimanesibsd_logo.png
Restaring Speed: 479 4k bytesisecond
Cloge | Start | Stap |
\End
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Using the web interface

You can restore your data from an Offsite Backup Server by following instructions below.
i. Logon to the Offsite Backup Server web interface

ii. From the top menu, click [File Explorer]

43 Online Backup Services Management Console - Microsoft Internet Explorer

=l&1x|
Restore | Install Software EAQs | Help | Select Language
Erofile | Backup Set | File Explorer | Report | Statistics Logout
3 Home
Delete |
= Backup Set Size Last Modified Zipped [Ratio]
[T I3 FileBackupSet-1
Delete |

Note: 1. This shows all backup sets available within this backup account.
2. To restore backup files, please click the backup =et link shown above to continue.
3. To delete a backup set, check the checkbox next to the backup set and press the [ Delete ] button.

[&] pone [ [ [ s Loclintranet

iii.  Click the [Backup Set] link that contains the files that you want to restore

iv. Select the snapshot of your backup files that you would like to restore from the backup server by
using [Show files after Job] drop down list
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43 Online Backup Services Management Console - Microsoft Internet Explorer &=l
Restore | Install Software EAQs | Help | Select Language
Profile | Backup Set | File Explorer | Report | Statistics Logout

Rows/Page: |50 'l
' Home = FileBackupSet-1 > F:\ > images
& Show files after Job |2007-01-16 (12:22) | ¢ Show all files " Show Jobs View
Delete Restore |
[ File / Directory Size Last Modified Zipped [Ratio]
= ..
| E] apple_logo.jpg 4k 2006/03/14 12:00 dlc [3%]
I [ mac.bmp 149k 2006/02/09 17:19 39k [73%]
| I:] solaris_logo.gif 2k 2006/03/14 12:01 2k [0%]
| E] windows_|ogo.jpg 10k 2006/03/14 12:00 10k [7%]
Delete Restore
Mote: 1. This shows all files / directories within a backup job of a backup set.
2. Files shown in light gray color refers to files retained in the retention area.
3. To restore files/directories, check the checkbox next to the files/directories and press the [ Restore ] button.
4. To delete files/directories, check the checkbox next to the files/directories and press the [ Delete ] button.
5. [D] = Differential delta file
6. [I1] = Incremental delta file
[&] [ [ 3 Localintranet

If you want to see all the different versions of all files (shown as gray below), just choose the

[Show all files] radio button on the [File Explorer] page.

Files, which are shown in gray below (e.g. AIX_logo.JPG) are being stored in the retention area on

the backup server but you can still restore these files from the backup server.

/3 online Backup Services Management Console - Microsoft Internet Explorer

=& x|
Restore | Install Software FAQs | Help | Select Language
Profile | Backup Set | File Explorer | Report | Statistics Logout
Rows/Page: ISU 'I
\_J) Home = FileBackupSet-1 > F:% = images
" Show files after Job [2007-01-16 (12:22) *| & Show all files " Show Jobs View
Delete | Restore |
= File [ Directory Size Last Modified Zipped [Ratio]
& ..
M B A _logodrc 5k 2006/03/14 12:08 ak [17%]
|| E] apple_logo.jpg 4k 2006/03/14 12:00 4k [3%]
I [* mac.bmp 149k 2006/02/09 17:19 39k [73%]
O I:] solaris_logo.gif 2k 2006/03/14 12:01 2k [0%]
O E] windows_logo.jpg 10k 2006,/03/14 12:00 10k [79%]
Delete | Restore |
Mote: 1. This shows all files / directories within a backup job of a backup set.
2. File= shown in light gray color refers to files retained in the retention area.
3. To restore files/directories, check the checkbox next to the files/directories and press the [ Restore ] button.
4. To delete files/directories, check the checkbox next to the files/directories and press the [ Delete ] button.
5. [D] = Differential delta file
6. [I] = Incremental delta file
[&] Done [ [ [ Lloclintranet

vi. Select the files that you would like to restore and press the [Restore] button on the toolbar

vii. A dialog shown below would appear
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43 Online Backup Services Management Console - Microsoft Internet Explorer =S
Restore | Install Software FAQs | Help | Select Langquage
Erofile | Backup Set | File Explorer | Report | Statistics Logout

Please wait ... while applet is downloading

Please select the Java Virtual Machine you would like to use to restore your backup files and press the [ Restore ] button

below.
Restore < You should see a "Restore” button here

Troubleshooting:

i.  Malke =sure you have clicked the "Yes' button on the security warning dialog box. If you have clicked the 'No’ button already,
please restart your browser and try again.

= Back

[i&] Applet Restorer started ’_ ’_ ’_ ’_ ’_ %.J Local intranet

a. Press the [Restore] button

b.  Enter the directory to which backup files should be restored to in the [Restore files to]
textbox

£ pnline Backup File Restoring Manager o m] |

Restore files to: |D:‘.temp\.|mages Elrnwsel

Decrypting Key: I*"*

[2007-01-16 12:26:03] Start

[2007-01-16 12:26:03] Downloading restore file list ...

[2007-01-16 12:26:03] Downloading ... "Dtemplimages\alX_logo JPG™ (Total 4k bytes)
[2007-01-16 12:26:03] "D:Mempiimages\AlX_|logo. JPG™ (4k bytes) downloaded
[2007-01-16 12:26:03] Downloading ... "D:templimagesiapple_logo.jpg” (Total 4k bytes)
[2007-01-16 12:26:03] "D:Mempiimagesiapple_logo.jpa” (4k bytes) downloaded
[2007-01-16 12:26:03] Downloading ... "D:Memplimagesimac.bmp” (Total 39k bytes)
[2007-01-16 12:26:03] "D:Mempiimagesimac.bmp” (39k bytes) downloaded

[2007-01-16 12:26:03] Downloading ... "DMemplimagesisolaris_logo.gif (Total 2k bytes)
[2007-01-16 12:26:03] "D:Memplimages\solaris_logo.gif’ (2k bytes) downloaded
[2007-01-16 12:26:03] Downloading ... "DMemplimageswindows_logo.jpg” (Total 10k bytes)
[2007-01-16 12:26:03] "D:Memplimageswindows_logo.jpa” (10k bytes) downloaded

[2007-01-16 12

Saving windows_logo jpg from localhost

| 100%

Estimated Total Restore Time: 0 sec (Total 61.06k bytes - 61.07k bytes restored)
Estimated Restore Time: 0 sec (Total 10.08k hytes - 10.08k bytes restored)
Saving File To: Ditemplimageswindows_logo.jpg

Restoring Speed: 1221k bytesizecond

Close | Startl Stop |
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C. Enter the encrypting key which will be used to decrypt your backup files upon restoring your
backup files

d. Press the [Start] button

7.2 Restore backup files from removable hard disk

If you want to restore lots of backup files from the backup server and you find it too slow to restore all your
backup files from the backup server through the internet. You can ask your backup services provider to send you
all your backup files in removable hard disk (or CD/DVD). However, all backup files stored on backup server are in
encrypted format. You need to decrypt them back to their original format before you can use them. To decrypt
your backup files from removable media, please do the followings:

i. Open OBM from the System Tray

ii. Select the [Tools] -> [Decrypt Files Wizard] from the menu

EIE

Backup Set Backup Restore Tools View Help
JEJ Save Setting |’ Start Backu| B nzip Laocal Capy

\e» Backup Contrallar
=2 User Profile

 Backup Set

MName: FileBackupSet-1
IC: 1168919864093
Type: File Backup

S Backup Scheduls

: Backup Filter
Command Line Tool Metwork Resources Authentication for Windows

—] Setting Darmain:
—,j: Encryption User Mame:
—fiiy Retention Palicy Password:
= Extra Backup

% In-File Dielta Fropetties |

—éLocal Cao
i ¥ Run scheduled hackup on this computar

E| Log Table {FileBackupSet-1)
Type | Log Tirna

& Backup | & Restore | [ Log
|Eackup Completed Successiully |Quuta (Remaining ! Total): 8.86G M10G |LastBackup. 2007-01-15 21:00

iii. Use the [Browse] button to locate the “files” directory (provided by your backup provider in
removable hard disk or DVD) which contains the backup files that you want to decrypt
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~Full path 1o the [files] folder
Flease enter the path to the [files] folder which contains the backup files that you want to decrypt.

i Browse |

Cancel = Previous | [HErt =

iv. If you have more than one backup set under the “files” directory, select the [Backup Set] which
contains the backup files that you want to decrypt

.En Decrypt Files Wizard x|

~Backup Set

Flease select the backup set.

¥ FileBackupSet-1

Cancel | = Previous |

v.  Select the snapshot of your backup files that you would like to restore from the removable media
by using [Show files after Job] drop down list
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~Please select the files that you want to decrypt
+ Show files after Job |Current |  Showallfiles

EI—B Backup Server
E=ra 2007-01-1612:22:22
E—Dﬁimages 2007-01-16 {12:22:07)
E‘] apple_logojpa (Date Modified: Tue 31 4r2006 12:00 PM Size: 5k)
.j mac.hmp (Date Modified: Thu 21972006 5:19 P Size: 149k)
.:':] solaris_logo.gif (Date Modified: Tue 311472006 12:01 PM Size: 2K
E‘] windows_logo.jpd (Date Modified: Tue 201 4/2006 12:00 FM Size: 11k)

Cancel | = Previous et =

If you want to see all the different versions of all files (shown as gray below), just choose the
[Show all files] radio button on the [Decrypt Files Wizard] dialog.

Vi.

Files, which are shown in gray below (e.g. AIX_logo.JPG) are being stored in the retention area on
the removable media (but you can still restore these files).

Ln Decrypt Files Wizard EI

~Please select the files that you want to decrypt
" Show files after Job |Current | & showallfiles
EI—E Backup Server

== T3
-3 images
\1‘.] Al_logo JPG (Date Modified: Tue 31 472006 12:02 P Size: 6k)
\5‘:] apple_logo jpag (Date Modified: Tue 31452006 12:00 PM Size: ak)
.j. mac.hmp (Date Modified: Thu 2r972006 519 Ph Size: 149K)
\:':] solaris_logo.gif (Date Modified: Tue 3/ 472006 12:01 PM Size: 2K)
\5‘] windomis_logo.jpa (Date Modified: Tue 31452006 12:00 Pw Size: 11k)

= Previous Mext =

Enter the directory to which you want the backup files to be restored to in the [Decrypt files to]

Vii.
section and enter the [Decrypting Key] (the same as the encrypting key of this backup set)
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L1 Decrypt Files x|

Backup Set: FileBackupSet-1 {FILE)
Decrypt files to

. | Brawse |

[~ Restore file permissions

Decrypting Kev:l

Time Log

Elapsed Time:
Current File Timea:
Saving File To:
Decrypting Speed:

Close | Start | Stap |

viii. Press the [Start] button

.In Decrypt Files x|

Backup Set: FileBackupSet-1 (FILE)
Decrypt files ta

 Original location

i+ Ie:ltemp Browse |

[~ Restore file permissions

Cecrypting Kev:l“*

Time Log
2007-01-1612:48:58 Start -
2007-01-1612:48:53 Initializing decrypt action ...
2007-01-1612:48:53 Cecrypting ... 'edtemplalx_logo PG
2007-01-1612:48:53 Cecrypted 'eMempial<_logo JPG' {4k ytes)
2007-01-1612:48:53 Cecrypting ... 'edtemplwindows_loga.jpg’
2007-01-1612:48:53 Cecrypted 'eMempiwindows_logojoa ¢ 0k bwtes)

2007-01-16 12:48:58 Decr\,rpting ‘eitemplsolatis_logol DECrpting ... ‘eempiwindows_logo.jp

AAAT A4 AT AT AN SR P e U PR PP R P P PR BT L

Iﬂ_

Kl

Elapsed Time: 61k ytes decrypted. 0 sec elapsed.
Current File Time: 0 sec {Total 4k ytes - 4k iytes decrypted)
Sawing File To: elMempiapple_logojpa

Cecrypting Speed: 122k ntesisecond

Close | Start | Stap |

\End
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7.3

IP addresses Restriction for Online Restore

Online file restore operation can be restricted by IP addresses. You can ask your backup service provider to
restrict online file restoration for your backup sets by IP addresses to only allow people from authorized IP
addresses to restore files from the backup server. To check if online file restore of any backup set is restricted this
way, please take a look at the web interface of OBS, [Online Backup Services Management Console] -> [Backup
Set] -> [Online Restore IP restriction] (shown below).

Users are not allowed to update the [Online Restore IP restriction] directly. Please ask your backup services
provider to do the changes for you.

a Online Backup Services Management Console - Microsoft Internet Explorer — |EI|1|
Restore | Install Software FAQs | Help | Select Language
Profile | Backup Set | File Explorer | Report | Statistics Logout

Command I ;I
Working Directory I
[Help] Post-backup command
1. Name | [ Add ]
Command |
—_—
orking Directory |
[Hzlp] Online Restore IP restriction
1. 0Only frem 192.168.1.10 to 192.168.1.200
\
opaale Reset |
Key :
Name Mame of the backup set
Backup Source Files/Directories that are to be included inte or excluded from
the backup set
Backup Schedule Schedules when backup should be performed automatically
Enable In-File Delta Enable In-File Delta backup feature
Block Size Block size used to detect changes within backup files. LI
[&] Dore l_ l_ ’_|\_-_a! Local intranet 4
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8

In-File Delta Technology

The chapter describes what in-file delta technology is and how in-file delta can be used to backup large database
files (e.g. a 10GB Outlook.pst file) without uploading the whole database file everyday.

8.1 Overview

In-file delta technology is an advanced data block matching algorithm which has the intelligence to pick up
changes (delta) of file content between two files. Using this algorithm, daily backing up of large files (e.g. a 10GB
Outlook.pst file) over low-speed internet connection is made possible because it requires only the changes of
information (should be marginal) since the last backup to be sent over a low-speed internet connection to
complete the backup of a large file (here we assume that the full backup of the file has been saved on the backup
server already).

This is what will happen in the backup of a 10GB Outlook.pst file when it is backed up by OBM with in-file delta
technology.

i. The whole files (10GB), along with its checksum file, are backed up to the backup server. This can
be done directly through the internet or indirectly using the seed loading utility on a removable
hard disk.

ii. When backup runs again later (normally the next day), OBM will download a checksum listing of all
data blocks of the full backup file (or last incremental backup file) from the backup server and use
it to pick up all changes that have been made to the current Outlook.pst file.

iii. Changes detected are then saved in a delta file which is uploaded to the backup server. A new
checksum file is generated and is also uploaded. (This delta file is assumed to be small because
the content of PST files doesn’t change a lot during daily usage)

iv. Subsequent backups of this 10GB Outlook.pst file will go through step ii and step iii again. As
explained, only a small delta file and checksum file will be uploaded to the backup server.

v.  With in-file delta technology, daily backing up of large file over low-speed internet connection is
now possible

Incremental in-file delta type

Incremental Delta will facilitate ease of backup. The delta is generated by comparing with the latest uploaded full
or delta file. The delta file generated is the smallest possible and uses the least bandwidth during backup. For
restoration, the full file and all delta files up to the required point-in-time is required to restore the file to a specific
point-in-time.

Example: If you are adding around 100MB changes to a 10G Outlook.pst everyday.

After the first full backup job, OBM will continue to generate and upload delta files instead of uploading the full file
until either one of the following two rules are true:

a) Number of deltas generated since the last full backup is greater than the [Number of Delta] setting.

b) The delta ratio (the ratio of the delta file size against the full file size) is greater than the [Delta Ratio]
setting

Using incremental delta, the delta generated by comparing the current file with the latest uploaded full or delta file
is around 100MB.

Since the delta file size is around 100MB daily, the delta ratio (around 1%) will not trigger a full file upload.
Instead OBM will continue to generate and upload delta files until day 102 (assuming the full file was uploaded on
day 1) when the number of deltas generated exceeds the [Number of Delta] setting and triggers the upload of the
full Outlook.pst file. You can disable the [Number of Delta] and [Delta Ratio] if you don’t want to upload the full
file.

All delta files are generated with respect to changes made since the last incremental or full backup. This means
that the last full backup file and ALL incremental delta backup files are required to restore the latest snapshot of a
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backup file.

Differential in-file delta type

Differential Delta will facilitate ease of restore. The delta is generated by comparing with the latest uploaded full
file. The delta file generated grows daily and uses more bandwidth during backup. For restoration, the full file and
a single delta file is required to restore the file to a specific point-in-time.

Example: If you are adding around 100MB changes to a 10G Outlook.pst everyday.

After the first full backup job, OBM will continue to generate and upload delta files instead of uploading the full file
until either one of the following two rules are true:

c) Number of deltas generated since the last full backup is greater than the [Number of Delta] setting.

d) The delta ratio (the ratio of the delta file size against the full file size) is greater than the [Delta Ratio]
setting

Using differential delta, the delta generated by comparing the current file with the latest uploaded full file is
around 100MB for the 1% delta, 200MB for the 2" delta, 300MB for the 3™ delta and so on.

Since the delta file grows by 100MB daily, the delta ratio for day 52 (delta file size is approximately 51x100=
5.1GB, assuming the full file was uploaded on day 1) being over 50% exceeds the [Delta Ratio] setting and
triggers the upload of the full Outlook.pst file. You can disable the [Number of Delta] and [Delta Ratio] if you don’t
want to upload the full file.

All delta files are generated with respect to changes made since the last full backup file (i.e. differential backup).
This means that only last full backup file and the last delta file are required to restore the latest snapshot of a
backup file. This means that other intermediate delta files are only required if you want to restore other snapshots
of a backup file.

Differential in-file delta backup has the benefits that a corrupted delta file would only make one particular version
of a backup file non-recoverable and all other backups created by other delta files of the same file would still be
intact.

151

Backup Set Backup Restore Tools “iew Help
15l 5ave Setting | P> Start Backup B Siop Backup |

o) Backup Controller [# [ In-File Delta (FileBackupSet-1)

=2 User Prafile
=) FileBackupSet-1

¥ Enable In-File Delta

5 Backup Source Block Size: IAuto - | Bytes

_®Backup Schedule

Apply tafiles

—U Command Line Toal Minimum Size: |25 Mhytes
4 Setting
(&) Encryption -
iy Retention Policy Ii=AlE DEa RE
—E Extra Backup Default: |Incrementa\ ;I
R 1-File: Delta Advansed
—r='—’|LucaI Copy WElEE

Upload full file when

¥ Mo of Delta = |1nn

r
IV DeltaRatio*= |50 ~| %
* Delta Ratio = Delta Size / File Bize

‘ﬂ Log Tahle (FileBackupSet-1)
Type I Log Time

& Backup | &) Restore | g Log
|Elac|-(up Completed Successfully |Quma (Remaining f Total): 8.86G /110G |LastElackup: 2007-01-15 21:00
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8.2 Block Size

The block size defines the size of data block being used to detect the changes between the last full or delta backup
file and the file sitting on the local computer right now. In general, the smaller the block size, the more likely a
matched data block can be found between the last backup file and the file on local computer. It, therefore,
produces a smaller delta file but it would require more processing power to detect these changes. On the other
hand, in-file delta backup running with larger block size will run faster but this will generally produce a larger delta
file.

In most case, the default setting [Auto] will choose the optimal block size for each file (depending on the size of
the file) for you.

8.3 Minimum File Size

The [Minimum File Size] setting defines the smallest file size a file must have before the use and application of in-
file delta backup technology.

If the size of a file that is being backed up is smaller than the [Minimum File Size] setting, in-file delta backup
technology won’t be applied to this file and the whole file, instead of just the delta file, will be uploaded to the
backup server. It is not necessary to perform in-file delta backup on small files because backing up the whole file
doesn’t take too long anyway. Backing up the whole file instead reduces the time required to restore a backup file.

8.4 Uploading full file again

No. of Delta

The [No. of delta] setting defines the maximum number of delta files from the same full backup file to be
generated and backed up to the backup server before a full backup (the whole file) of this file is uploaded to the
backup server instead.

For example, if you have created 100 delta files from the full backup file already and the [No. of delta] setting is
set to 100, the next backup will upload a full backup file (the whole file) instead of just the delta file. However, if
the [No. of delta] rule is disabled, it will keep generating delta files and uploading these delta files to the backup
server until the other delta rule forces a full backup (i.e. delta ratio exceeded). This setting is here to make sure
that there will always be a full backup file after a certain number of delta files have been generated.

Delta Ratio

The [Delta Ratio] setting is defined to be the size of a delta file divided by the size of its full backup file (i.e. the
percentage of changes detected between the last full backup file and the current file).

If the delta ratio calculated from the size of the generated delta file and the size of the full backup file is greater
than the [Delta Ratio] setting, the whole file, instead of just the delta file, will be backed up to the backup server.
It is done this way because the difference between backing up the whole file and the delta file is not significant
and it is better to upload the whole file instead to reduce the time required to restore the file.

The default setting of [Delta Ratio] is 50%. This means that if a file changes by more than 50%, the whole file,
instead of just the delta file, will be backed up and uploaded to the backup server.

8.5 Advanced In-file delta type

The [In-file delta] -> [Advanced] setting allows users to override default in-file delta type when on a certain
number of days (e.g. all Sundays or the 1°* day of each month). This is useful if you want all in-file delta backups
to be incremental but you want to do a differential in-file delta backup on Saturdays as well as the full file backups
on the 1° day of every month. If you want to do this, simply configure [In-file delta] -> [Advanced] -> [Advanced
In-file Delta Type Setting] to what is shown below.
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Advanced In-File Delta Type Setting x|

HWeekly Variation (Owverride Default Setting)

I Suridzay IFuII vl I Thursday IFuII vl
[ larcla IFuII "I [~ Friday IFuII -I
[ Tuesday IFuII vl ¥ Saturday IDiﬁerential 'I

[ Wiednesday IFu|| vl

I January Ih W July Im
¥ Februany Ih ¥ August Im
¥ March Ih ¥ September Im
¥ April Im ¥ October Im
v tlay Ih ¥ hNovember Im
¥ June Ih ¥ December Im
Date

& Day: |1 v|

C rirst x| |sunday <]

Yeatly Variation (Override Weekly Variation or Default Setting)—————

0]14 Cancel

With this setting, all backup Jobs on Saturdays will be differential in-file delta backups, backups for the 1% day of
each month will run a full backup. This ensures that all backup files will be backed up in full at a regular interval.
One benefit of this is that restore time will run faster because of less delta merging. Another benefit is that the risk
of a corrupted incremental delta file resulting in data loss is much lower because a full backup is always available

periodically.

Fortikup is a trademark of Micso Srl Page 56 of 135

(April 24, 2008)



Forti Up Fortikup OBS V5.2

micso fortified backup User’'s Guide

9 Backup/Restore Oracle 8i/9i/10g

This chapter will describe in details how OBM backup your Oracle 10g and how you can restore an Oracle 10g
database using the backup files.

9.1 Requirements

i OBM must be installed onto the computer that can connect to your Oracle 10g server using TCP/IP
protocol.

ii. Data from Oracle 10g database will be backed up to a temporary directory before they are sent to
Offsite Backup Server. Please make sure you have sufficient space on your computer to store these
data when you run the backup job.

iii. Database must be in archived log mode

To switch database to archived log mode, please do the following:

a. Set the parameters below in the PFILE to enable automatic archiving
LOG_ARCHIVE_DEST = [directory where archive redo logs will be stored]

LOG_ARCHIVE_FORMAT = 'log%t_%s_%r.arc'
LOG_ARCHIVE_START = TRUE

b.  Set ORACLE_SID to your database’s System ldentifier (SID)
export ORACLE_SID=GDBL (@assuming your database’s SID is GDB1)
C. Run SQL Plus and connect to database as SYSDBA

For Oracle 9i/10
sql plus "/ as sysdba"
For Oracle 8i

connect internal;

d. Shutdown database

shut down i medi at e

e. Start and mount database

startup nount

f. Switch database to archived log mode

al ter database archivel og;

g. Open database

al ter dat abase open;

Oracle 10g Example:

$ export ORACLE_SI D=GDB1

$ sqlplus "/ as sysdba"

SQ*Plus: Release 10.2.0.1.0 - Production on Thu Nov 8 15:08:57 2007
Copyright (c) 1982, 2005, Oracle. Al rights reserved.

Connected to:

Oracl e Database 10g Enterprise Edition Rel ease 10.2.0.1.0 - Production
Wth the Partitioning, OLAP and Data M ning options

SQL> shut down i nmedi ate

Dat abase cl osed.

Dat abase di smount ed.
ORACLE i nst ance shut down.
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9.2

OBM wiill backup your Oracle database by taking the following steps.

SQL> startup nount
ORACLE instance started.

Total System G obal Area 285212672 bytes

Fi xed Size 1218992 bytes
Variabl e Size 96470608 byt es
Dat abase Buffers 184549376 bytes
Redo Buffers 2973696 bytes

Dat abase nount ed.

SQ.> al ter database archivel og;
Dat abase al tered.

SQ.> al ter database open;

Dat abase al tered.

JAVASYSPRIV role is granted to system account

You can grant this role to system account by executing:

h.

Grant permission to system account

For Oracle 9i/10
SQL> grant javasyspriv to system
For Oracle 8i

SVRMGRL> connect i nternal

SVRMGRL> @/ javavmiinstall/initjvmsql;
SVRMGRL> @/ r dbns/ adni n/ cat al og. sql ;
SVRMGRL> @/ r dbns/ adni n/ cat proc. sql ;
SVRMGRL> @/ javavniinstall/initdbj.sql;

SQ.> grant javasyspriv to system

Oracle 9i/10g Example:

SQL> grant javasyspriv to system

Grant succeeded.

Overview

Connect to the Oracle database using SQL*NET over TCP/IP

Run all Pre-Commands of this backup set

a.

If the backup type to run is [Database Backup type],

all data files in each of the tablespace(s) selected are copied to the temporary directory

specified by this backup set

if there are temporary files in the database, the script to re-create the temporary files are
generated to a file located in the temporary directory specified by this backup set

all non-default initialization parameters will be spooled to an initializing file located in the

temporary directory specified by this backup set

all control files will be copied to the temporary directory specified by this backup set

all archived log files will be copied to the temporary directory specified by this backup set
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iv. If the backup type to run is [Archived Log Backup type],

a. all archived log files will be copied to the temporary directory specified by this backup set
V. Run all Post-Commands of this backup set
vi. Upload all files copied to the temporary directory to the Offsite Backup Server

vii. Remove temporary files from the temporary directory if [Setting] -> [Temporary Directory for
storing backup files] is enabled

Note:

If your Oracle database is running on Windows, please install OBM onto the company running the Oracle database
if OBM is to backup this Oracle database. This would shorten the time required to backup the Oracle database.

9.3 How to backup an Oracle Database (Physical Backup)

Please follow the instructions below to backup your Oracle database to the Offsite Backup Server.
i. Install OBM onto your computer
ii. Open OBM
Right click OBM icon available in the system tray and choose [Open]

Backup

Backup and Logoff
Backup and Eestart
Backup and Shutdown

* vy v v

Help
Stop Bunndng Backup P

Exit

T 1446

iii. Create a backup set

a. From the Menu, Choose [Backup Set] -> [New] -> [Oracle Database Backup Set]

-0l x|
Backup  Wiew
File Backup Set
Remave » Lotus Backup Set bt - M3SOLBackupSet1
Save M3 Exchange Backup Set
MS SQL Server Backup Set
SoLBackupSet1
7 SIEIL (AT i rosoft SOL Server Backup
Oracle Database Backup Set
SaLsemer————————————— |
H Login ID:  sa
[=)-(a] MySQLBackupSet-1
- Backup Source Password: =
+[igh Backup Schedule
+[=] Command Line Tool Properties
U Setting
) Encryption
Log Tahle (MSS@LBackupSet-1) &
Type | Log Time
Backup | Leg
|We\cumeto online Backup Manager! ‘Quma (Remaining / Total): 43.9G [ 50G |Last Backup: 2004-07-22 14:32
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b.  Enter a name for your backup set

Backup Set

Please type a name for this Backup Set

Mame IOracIeEackupSeH
Type: Oracle Database Server Backup

Qracle Database Server

Login 1D Isy’stem

Password: I

Host:

part: [1521
sio: |

= Frevious MNest = Cancel |

C. Enter the system password, the Oracle Database Server Host Name, TNS Port and SID

d. Select the tablespace(s) you want to backup

Backup Source

Flease selecttablespaces to be backed up.

[ Qracle Database Server
- [#y 5YSTEM

- !—‘SQOENLHEPOSITORY
..... 5 ReS

e TEMP

¥ UsERS

..... ’—@a‘"\]D}(

Temporary disk space used for staring spool files

[c1packumoraciene Change
= Previous | Mlext = cancel |

e. Enter a temporary location to store the database file(s) before they are sent to an Offsite
Backup Server

f. Set the backup schedule for database backup and archived log backup
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Backup Schedule
Please schedule the backup time.

\Archived Logs BackupSchedule (Type: Archived Logs, Weekly - Mc

K1 | I

Add | Remaove | Propetties |

< Previous | Mext = Cancel

Mame: IDatabase - complete BackupSchedule

~Backup
f+ Database - complete
" Database - differential

" Transaction log

~Type
= Daily i+ \Weekly " Monthly " Custom

rDay
Backup on the following dawis) every week:
[~ Sunday I~ Monday [~ Tuesday [~ Wednesday

[~ Thursday ¥ Friday [~ Saturday
—Start

Start Time (hh:mm): |21 vI:IDD vI
~Stop

Stop on completion (Full Backup

OK | Caneel |

Note: You can have more than one schedule in a backup set, i.e. you can perform intra-day
transaction log backup by adding more than one daily transaction log backup schedule to
your backup set.

g. Set the encryption algorithm, encryption mode and encrypting key for this backup set

Encryption Sedting
Please setup the encryption setting of the Backup Set,

[~ Do MNOT use encryption

Algarithm
Mode:
= CBC (Cipher Block Chaining)

" ECB (Electronic CookBook)

Encrypting Key |

Confirm Encrypting Key: |

< Previous | Mext = Cancel

Hint: For maximum security, please select AES (Advanced Encryption Standard) Algorithm,
CBC (Cipher Block Chaining) mode and use an encrypting key with more than 8 characters.
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iv.  Run Backup

a. Select the backup set you want to run on the left panel and press the [Start Backup] button
)

b.  Select the backup type (e.g. Database Backup, Archived Log Backup) you would like to
perform

Backup

(+ Database (Tahlespaces, Contral & Init File, Archived Logsy

 Archived Logs

0K Cancel

C. Select [Off-site Backup Server] to start backing up your files to an Offsite Backup Server.

Backup to

& DfFsite Backup Server
¢ Local Hard Disk (Seed Load Utility)

Start the backup for [OracleBackupSet-1] 2

0K Cancel

d.  When the backup finished, you should see Backup Completed Successfully in the log table.

.Iin Ahsay Online Backup Manager’ i [u] 3]

Backup Set Backup Restore Tools Yiew Help

}_EJ Save Setting |’ Start Backup ! Siop Backup: ‘

\e> Backup Controller (A | |a) Backup Set - OracleBackupSet1
I’;;‘.uaerFmﬂle
J) FileBackupSet-1

Backup Set

Mame: OracleBackupSet-1
Type:  Oracle Datahase Server Backup

'8 Backup Source
Backup Schedule Metwork Resource L 1 for Windor
Command Line Tool Domain

“1 getting User Marme:

Encryption Passward:
iy Retention Policy
,EI Exira Backup rOran\e Database Ser\rer—‘ LI
[ In-File Delta
E Lag Table (OracleBackupSet-1)
Type | Log | Time |

@ [33/34] [New File] Uploading 63% of"Oracle Database Serverl. [2007/07I09 17:33:34] ﬁl

@ [33/34] [Mew File] Uplnading 66% of "Oracle Datahase Servert. [2007/07i09 17:33:34]

@ [33/34] [New File] Uploading 72% of "Oracle Database Serverl. [2007/07I09 17:33:39]

@ [33/34] [Mew File] Uploading 74% of "Oracle Database Serverl. [2007/07/08 17:33:35]

@ [33/34] [New File] Uploading 77% of "Oracle Database Serverl. [2007/07I09 17:33:39]

@ [33/34] [New File] Uploading 100% of"Oracle Database Server. [2007/07I09 17:33:35]

@ [33/34] [Checksum File] Uploading 35% of "Oracle Database 5 [2007/07i09 17:33:35]

@ [33/34] [Checksum File] Uploading 100% of"Oracle Database ... [2007/07I09 17:33:36]

@ Deleting tempaorary file "C\BackuplOracleDBU 183973303187, [2007/07/08 17:33:36]

@ [34/34] [New File] Uploading 100% of "Oracle Database Server... (20070709 17:33:36]

() Df W e flfup\Orac\eDBH1839733031 an [2007¢07/09 17:33:36]
@ Backup Completed Successiully [2007/07i09 17:33:37] j

& Backup | &) Restore| @ Log

|Backup Completed Successiully \Quuta (Remaining / Total: 1G 116G |La51 Backup: -

9.4 How to restore an Oracle Database

Please follow the instructions below to restore your Oracle 9i/10g databases from an Offsite Backup Server.

i. Download the backup files from Offsite Backup Server

Please refer to the [Quick Start - Backup File] section for information on how to download backup
files from Offsite Backup Server.

ii. For restore an existing database

Shutdown the database
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To shutdown the database, please do the following:
a. Set ORACLE_SID to your database’s System Identifier (SID)
$ export ORACLE SID=cDB1 (@assuming your database’s SID is GDB1)

b.  Run SQL Plus and connect to database as SYSDBA

$ sqlplus "/ as sysdba"

C. Shutdown database

SQL> shutdown i medi ate

Oracle 9i/10g Example:

$ export ORACLE_SI D=GDB1

$ sqlplus "/ as sysdba"

SQ*Plus: Release 10.2.0.1.0 - Production on Thu Nov 8 17:04:57 2007
Copyright (c) 1982, 2005, Oracle. Al rights reserved.

Connected to:

Oracl e Dat abase 10g Enterprise Edition Release 10.2.0.1.0 - Production
Wth the Partitioning, OLAP and Data M ning options

SQ.> shutdown i mmedi ate

Dat abase cl osed.

Dat abase di snount ed.
ORACLE i nstance shut down.

For recover a database that currently does not exist

Create a password file

$ orapwd fil e=$ORACLE_HOME/ dbs/ or apwGDB1 passwor d=pwd123
(assuming your database’s SID is GDB1, and password is pwd123)

Oracle 9i/10g Example:

©®

orapwd file=/oracle/ OraHonel/ dbs/ or apwGDB1 passwor d=pwd123

Put all downloaded backup files in place

Control files, data files and archived logs are stored on Offsite Backup Server along with their full
path information. You just need to put all these files back to their original locations when

performing a database restore.

For example:

/obm restore/ Oracl e Dat abase Server/oracl e/ product/10. 2. 0/ db_1/ adm n/ GDB1/

/obmrestore/ Oracl e Database Server/oracl e/ product/10.2. 0/ db_1/dbs/i ni t GDBL1. ora

/ obm restore/ Oracl e Database Server/oracl e/ product/10.2. 0/ db_1/dbs/ spfil eGDB1. ora
/obmrestore/ Oracl e Dat abase Server/oracl e/ product/10.2.0/db_1/fl ash_recovery_area/ GDB1/

/obm restore/ Oracl e Dat abase Server/oracl e/ product/10. 2. 0/ db_1/ or adat a/ GDB1/

Move to

/ oracl e/ product/ 10. 2. 0/ db_1/ admi n/ GDB1/

/ oracl e/ product/ 10. 2. 0/ db_1/ dbs/ i ni t GDB1. ora

/ oracl e/ product/10. 2. 0/ db_1/ dbs/ spfi | eGDB1. ora

/ oracl e/ product/10. 2.0/ db_1/fl ash_recovery_ar ea/ GDB1/

/ oracl e/ product/ 10. 2. 0/ db_1/ or adat a/ GDB1/
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iv. Rename database files (Only for restoring database to a new location)

Rename your database files by doing the following:

a. Modify the PFILE to update file path

Open the PFILE ($ORACLE_HOME/dbs/initGDB1.ora), change every file path to the new
location, and then save it

For example:

background_dunp_dest = /oracl e/ OraHonel/ adni n/ GDB2/ bdunp

control _files = (/oracl e/ OraHonel/ or adat a/ GDB2/ control O1. ctl,
/ oracl e/ OraHonel/ or adat a/ GDB2/ control 02. ctl,
/ oracl e/ OraHonmel/ or adat a/ GDB2/ control 03. ctl)

core_dunp_dest = /oracl e/ OraHonel/ admi n/ GDB2/ cdunp

user _dunp_dest = /oracl e/ OraHomel/ adni n/ GDB2/ udunp
Change to

background_dunp_dest = /new_db_| ocati on/ Or aHonmel/ adni n/ GDB2/ bdunp

control _files = (/new_db_| ocation/ OraHonel/ or adat a/ GDB2/ control 01.ct |,
/' new_db_| ocati on/ Or aHonel/ or adat a/ GDB2/ control 02. ctl,
/ new_db_| ocat i on/ Or aHonme1/ or adat a/ GDB2/ control 03. ctl)

core_dunp_dest = /new_db_| ocati on/ Or aHomel/ adni n/ GDB2/ cdunp

user _dunp_dest = /new_db_| ocati on/ OraHonel/ admi n/ GDB2/ udunp

b.  You may need to quote the values of dispatchers as a single argument.
Add double quotation marks
di spat chers = " ( PROTOCOL=TCP) ( SERVI CE=GDBLXDB) "

[ Delete the SPFILE

Delete the SPFILE ($ORACLE_HOME/dbs/spfileGDB1.ora)
d. Set ORACLE_SID to your database’s System Identifier (SID)
$ export ORACLE SID=GDBL (@ssuming your database’s SID is GDB1)

e. Run SQL Plus and connect to database as SYSDBA

$ sglplus "/ as sysdba"

f. Start and mount database

SQL> startup nount

g. Create a backup of the control file to trace file

SQL> alter database backup controlfile to trace as '/New_DB_ Location/control.trc' reuse; (assuming you
create a trace file to /New_DB_Location/)

h. Rename each of data file, log file and tempfile

Open the trace file that just created, and then check for the filename of each datafile, log file
and tempfile.

Please do the following to rename each of the files:

SQL> ALTER DATABASE RENAME FILE 'xxx' TO 'yyy';
where xxx is the old filenane found in the trace file, and yyy is the new filenanme with updated path

For example:

SQ.> ALTER DATABASE RENAME FI LE '/oracl e/ product/10. 2.0/ db_1/ or adat a/ GDB1/ syst en01. dbf' TO
'/ new_db_| ocati on/ or adat a/ GDB1/ syst enD1. dbf " ;

SQL> ALTER DATABASE RENAME FI LE '/oracl e/ product/10.2. 0/ db_1/ or adat a/ GDB1/ undot bs01. dbf* TO
"/ new_db_| ocat i on/ or adat a/ GDB1/ undot bs01. dbf " ;
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SQL> ALTER DATABASE RENAME FI LE '/oracl e/ product/ 10.
"/ new_db_| ocati on/ or adat a/ GDB1/ sysaux01. dbf " ;

SQL> ALTER DATABASE RENAME FI LE '/ oracl e/ product/10.
'/ new_db_| ocati on/ or adat a/ GDB1/ user s01. dbf " ;

SQL> ALTER DATABASE RENAME FI LE '/oracl e/ product/ 10.
"/ new_db_l ocati on/ or adat a/ GDB1/ TS1' ;

SQL> ALTER DATABASE RENAME FI LE '/ oracl e/ product/10.
'/ new_db_| ocati on/ or adat a/ GDB1/ r edo01. | og' ;

SQL> ALTER DATABASE RENAME FI LE '/oracl e/ product/ 10.
'/ new_db_l ocati on/ or adat a/ GDB1/ r edo02. | og" ;

SQL> ALTER DATABASE RENAME FI LE '/ oracl e/ product/ 10.
'/ new_db_| ocati on/ or adat a/ GDB1/ r edo03. | og' ;

SQL> ALTER DATABASE RENAME FI LE '/oracl e/ product/ 10.
'/ new_db_l ocati on/ or adat a/ GDB1/ t enp01. dbf ' ;

2.

2.

2.

2.

2.

2.

2.

0/ db_1/ or adat a/ GDB1/ sysaux01. dbf' TO

0/ db_1/ or adat a/ GDB1/ user s01. dbf' TO
0/ db_1/ oradat a/ GDB1/ TS1' TO

0/ db_1/ or adat a/ GDB1/ r edo01. | og' TO
0/ db_1/ or adat a/ GDB1/ r edo02. | og" TO
0/ db_1/ or adat a/ GDB1/ r edo03. | og' TO

0/ db_1/ or adat a/ GDB1/ t enp01. dbf' TO

Oracle 9i/10g Example:

$ export ORACLE_SI D=GDB1
$ sqlplus "/ as sysdba"

SQ*Plus: Release 10.2.0.1.0 - Production on Fri

Copyright (c) 1982, 2005, Oracle. Al rights reserved.

Connected to an idle instance.
SQ.> startup nount
ORACLE instance started.

Total System d obal
Fi xed Size
Variable Size

Dat abase Buffers
Redo Buffers

Dat abase nount ed.

Area 285212672 bytes

1218992 bytes

92276304 bytes

188743680 bytes

2973696 bytes
SQ.> al ter database backup controlfile to trace as
Dat abase al tered.

SQL> ALTER DATABASE RENAME FI LE '/oracl e/ product/10. 2
'/ new_db_| ocati on/ or adat a/ GDB1/ syst enD1. dbf "' ;

Dat abase al tered.

SQ.> ALTER DATABASE RENAME FI LE '/oracl e/ product/10. 2.
'/ new_db_| ocati on/ or adat a/ GDB1/ undot bs01. dbf " ;

Dat abase al tered.

SQL> ALTER DATABASE RENAME FI LE '/oracl e/ product/ 10. 2.
‘I new_db_| ocati on/ or adat a/ GDB1/ sysaux01. dbf" ;

Dat abase al tered.

SQL> ALTER DATABASE RENAME FI LE '/oracl e/ product/10. 2.
'/ new_db_| ocati on/ or adat a/ GDB1/ user s01. dbf ' ;

Dat abase al tered.

SQL> ALTER DATABASE RENAME FI LE '/oracl e/ product/10.2
'/ new_db_l ocati on/ or adat a/ GDB1/ TS1' ;

Dat abase al tered.

SQ.> ALTER DATABASE RENAME FI LE '/oracl e/ product/10. 2.
'/ new_db_| ocati on/ or adat a/ GDB1/ r edo0O1. | og' ;

Dat abase al tered.

SQL> ALTER DATABASE RENAME FI LE '/oracl e/ product/ 10. 2.
'/ new_db_| ocati on/ or adat a/ GDB1/ r edo02. | og' ;

Dat abase al tered.

SQ.> ALTER DATABASE RENAME FI LE '/oracl e/ product/10. 2.
'/ new_db_| ocati on/ or adat a/ GDB1/ r edo03. | og' ;

Dat abase al tered.

SQL> ALTER DATABASE RENAME FI LE '/oracl e/ product/10. 2
'/ new_db_l ocati on/ or adat a/ GDB1/ t enp01. dbf ' ;

Dat abase al tered.

Nov 9 17:50:30 2007

'/ new_db_| ocation/control.trc'

.0/ db_1/ or adat a/ GDB1/ syst enD1. dbf "'

0/ db_1/ or adat a/ GDB1/ undot bs01. dbf"'

0/ db_1/ or adat a/ GDB1/ sysaux01. dbf"

0/ db_1/ or adat a/ GDB1/ user s01. dbf"*

.0/ db_1/ or adat a/ GDB1/ TS1' TO

0/ db_1/ or adat a/ GDB1/ r edo01. | og'

0/ db_1/ or adat a/ GDB1/ r edo02. | og'

0/ db_1/ or adat a/ GDB1/ r edo03. | 0og'

.0/ db_1/ or adat a/ GDB1/ t enp01. dbf"’

reuse;

TO

TO

TO

TO

TO

TO

TO

TO

V. Restore Database
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Use Recovery Manager to restore your database by doing the following:
For Oracle 9i/109g
a. Set ORACLE_SID to your database’s System Identifier (SID)

$ export ORACLE SID=cDB1 (@ssuming your database’s SID is GDB1)

b.  Run Oracle Recovery Manager (rman) and connect to the target database

$ rman target /

(o Start and mount database
RVAN> startup nmount
d. Reapply all transactions from the archived log files to the last sequence

RVAN> recover database until sequence=4 thread=1; (assuming the sequence number of your last
archived redo log is 3)

Sequence number are named on the filename of archived redo log

e.g. / oracl e/ OraHonel/ dbs/ol_nf _1_2_3nbhlsvs_.arc
/ oracl e/ OraHomel/ dbs/ ol_nf _1_3_3nbhlyby_.arc

in this case, the sequence number of archived redo log is 4.

e. Open database

RVAN> al ter database open resetl ogs;

Oracle 9i/10g Example:

$ export ORACLE_SI D=GDB1

$ rman target /

Recovery Manager: Release 10.2.0.1.0 - Production on Thu Nov 8 17:46:27 2007
Copyright (c) 1982, 2005, Oacle. Al rights reserved.

connected to target database (not started)

RVAN> st artup nount

Oracle instance started
dat abase nount ed

Total System G obal Area 285212672 bytes

Fi xed Size 1218992 bytes
Vari abl e Size 113247824 bytes
Dat abase Buffers 167772160 bytes
Redo Buffers 2973696 bytes

RVAN> recover database until sequence=4 thread=1;

Starting recover at 08- NOV-07

Starting inplicit crosscheck backup at 08- NOV-07

using target database control file instead of recovery catal og
al | ocated channel: ORA DISK 1

channel ORA DI SK_1: sid=157 devtype=DI SK

Finished inplicit crosscheck backup at 08- NOv-07

Starting inplicit crosscheck copy at 08-NOv-07
using channel ORA DISK_ 1
Finished inplicit crosscheck copy at 08- NOV-07

searching for all files in the recovery area
cataloging files...
cat al ogi ng done

Li st of Catal oged Files

Fi l e Name:
/oracl e/ product/10.2.0/db_1/fl ash_recovery_ar ea/ GDB1/ ar chi vel og/ 2007_11_08/ o1_nf_1_3_3nbhly
by_.arc

usi ng channel ORA DI SK 1

starting nedia recovery

archive log thread 1 sequence 2 is already on disk as file

/ oracl e/ product/10.2.0/db_1/fl ash_recovery_ar ea/ GDB1/ ar chi vel og/ 2007_11_08/ o1_nf_1_2_3nbhls

vs_.arc
archive log thread 1 sequence 3 is already on disk as file

Fortikup is a trademark of Micso Srl Page 66 of 135 (April 24, 2008)



MICE0 fortified backup User’'s Guide

Forti Up Fortikup OBS V5.2

/oracl e/ product/10.2.0/db_1/fl ash_recovery_area/ GDB1/ ar chi vel og/ 2007_11_08/ o1_nf _1_3_3nbhly
by_.arc

archive | og

fil ename=/oracl e/ product/10.2. 0/ db_1/fl ash_recovery_area/ GDB1/ ar chi vel og/ 2007_11_08/ 01_nf _1
_2_3nbhlsvs_.arc thread=1 sequence=2

archive | og

fil ename=/ oracl e/ product/10. 2.0/ db_1/fl ash_recovery_ar ea/ GDB1/ ar chi vel og/ 2007_11_08/01_nf _1
_3_3nbhlyby_.arc thread=1 sequence=3

nmedi a recovery conplete, elapsed tine: 00:00:01

Fi ni shed recover at 08- NOV-07

RVAN> al ter database open resetl ogs;

dat abase opened

For Oracle 8i
a. Set ORACLE_SID to your database’s System Identifier (SID)
$ export ORACLE sSID=GDB1 (@ssuming your database’s SID is GDB1)

b.  Run Oracle Server Manager (svrmgrl)

$ svrngrl

C. Connect to the target database

SVRMGRL> connect i nternal

d. Start and mount database

SVRMGRL> start nmount;

e. Reapply all transactions from the archived log files

RVAN> recover database using backup controlfile

f. Open database

RVAN> ALTER DATABASE OPEN RESETLCGS;

Oracle 8i Example:

$ svrngrl
SVRMGRL> connect i nternal

SVRMGR> startup nount;
ORACLE instance started.

Total System G obal Area 95874448 bytes
Fi xed Size 64912 bytes
Vari abl e Size 52744192 bytes
Dat abase Buffers 40960000 bytes
Redo Buffers 2105344 bytes

Dat abase nount ed.

SVRMGRL> recover database using backup controlfile

ORA- 00279: change 419671 generated at 06/14/03 02:51:49 needed for thread 1

ORA- 00289: suggestion : /data/ora815/vin/archi ve/ ARCHO000000225. LOG

ORA-00280: change 419671 for thread 1 is in sequence #225

ORA-00278: log file '/datal/ora815/vin/archi ve/ ARCHO000000224. LOG no | onger needed for this
recovery

Specify log: {<RET>=suggested | filenane | AUTO | CANCEL}

AUTO

Log appli ed.

ORA-00279: change 547222 generated at 06/18/03 19:58: 26 needed for thread 1

ORA-00289: suggestion : /data/ora815/vin/archi ve/ ARCHO000000384. LOG

ORA- 00280: change 547222 for thread 1 is in sequence #384

ORA-00278: log file '/datalora815/vin/archive/ ARCHO000000383. LOG no | onger needed for this
recovery

ORA-00308: cannot open archived |og '/data/ora815/vin/archi ve/ ARCHO000000384. LOG

ORA-27037: unable to obtain file status

Linux Error: 2: No such file or directory

Addi tional information: 3

SVRMGR> recover database using backup controlfile until cancel

ORA-00279: change 547222 generated at 06/18/03 19:58: 26 needed for thread 1
ORA-00289: suggestion : /data/ora815/vin/archi ve/ ARCHO000000384. LOG

ORA- 00280: change 547222 for thread 1 is in sequence #384

Specify log: {<RET>=suggested | filenane | AUTO | CANCEL}

CANCEL

Medi a recovery cancel | ed.

SVRMGR> al ter database open resetl ogs;

Statement processed.
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Vi. (Optional) Create Net Service Name and Database Service Listener

To create Net Service Name

Start Net Manager by running the command netmgr
$ netngr

- expand [Oracle Net Configuration]

- expand [Local]

- select [Service Naming]

- click “+” icon on the toolbar
9
9

Net Service Name Wizard will be launched to guide you through creating a net service name
click [File] on the menu bar
-> [Save Network Configuration] on the menu bar

To create Database Service Listener

Start Net Manager by running the command netmgr
$ netngr

expand [Oracle Net Configuration]

expand [Local]

expand [Listeners]

select [LISTENER]

select [Database Services] from combo box
click [Add Database]

input Global Database Name and SID

click [File] on the menu bar

[Save Network Configuration] on the menu bar

A A A2 2 2 227

9.5 How to restore a single tablespace

Restoring a tablespace required a backup of datafiles consistent with the existing archived logs and control files, as
redo will be applied during the restore operation.

Please follow the instructions below to restore a tablespace from an Offsite Backup Server.

i. Download the backup files from the Offsite Backup Server

Please refer to the [Quick Start - Backup File] section for information on how to download backup
files from Offsite Backup Server.

ii. Set ORACLE_SID to your database’s System ldentifier (SID)
$ export ORACLE S| D=GDBL (assuming your database’s SID is GDB1)

ili. Run SQL Plus and connect to database as SYSDBA

$ sqlplus “/ as sysdba”

iv. Shutdown database

SQ.> shutdown i mmedi ate

V. Put the downloaded tablespace datafiles in place
Datafile names and paths can be found by using the REPORT SCHEMA command.
a. Set ORACLE_SID to your database’s System Identifier (SID)

$ export ORACLE SID=GDBL (@ssuming your database’s SID is GDB1)

b.  Run Oracle Recovery Manager (rman) and connect to the target database

$ rman target /
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[ Start and mount database
RVAN> startup mount

d. List the names of all datafiles and tablespaces
RMAN=> report schema,;
For example:

Report of database schema
File K-bytes Tablespace RB segs Datafile Name

1 419840 SYSTEM Fekk /oracle/OraHomel/oradata/GDB1/systemO1.dbf
2 204800 UNDOTBS1 fadaied /oracle/OraHomel/oradata/GDB1/undotbs01.dbf
3 20480 CWMLITE falaiad /oracle/OraHomel/oradata/GDB1/cwmlite01.dbf
4 20480 DRSYS FAx /oracle/OraHomel/oradata/GDB1/drsys01.dbf

5 141440 EXAMPLE aiaied /oracle/OraHomel/oradata/GDB1/exampleO1.dbf
6 25600 INDX folaiad /oracle/OraHomel/oradata/GDB1/indx01.dbf

7 20480 ODM Fhx /oracle/OraHomel/oradata/GDB1/0odmO01.dbf

8 10240 TOOLS folaied /oracle/OraHomel/oradata/GDB1/toolsO1.dbf

9 25600 USERS folalied /oracle/OraHomel/oradata/GDB1/usersO1.dbf

10 39040 XDB Fekk /oracle/OraHomel/oradata/GDB1/xdb01.dbf

11 0TS1 foiaiad /oracle/OraHomel/oradata/GDB1/TS1_datafilel.dbf
12 0TSl adaiad /oracle/OraHomel/oradata/GDB1/TS1_datafile2.dbf
13 0TS1 aiaied /oracle/OraHomel/oradata/GDB1/TS1_datafile3.dbf

e. Put all the downloaded backup of datafile/s that constitute the tablespace to the listed
location

For example:

/obm_restore/Oracle Database Server/oracle/OraHomel/oradata/GDB1/TS1_datafilel.dbf
/obm_restore/Oracle Database Server/oracle/OraHomel/oradata/GDB1/TS1_datafile2.dbf
/obm_restore/Oracle Database Server/oracle/OraHomel/oradata/GDB1/TS1_datafile3.dbf
Move to

/oracle/OraHome1/oradata/GDB1/TS1_datafilel.dbf
/oracle/OraHomel/oradata/GDB1/TS1_datafile2.dbf

/oracle/OraHome1/oradata/GDB1/TS1_datafile3.dbf
vi. Restore tablespace
RVAN> recover tablespace TS1; (@ssuming your tablespace is TS1)

If your datafiles consistent with the database, you should see:

Oracle 9i/10g Example:

RVAN> recover tabl espace TS1;

Starting recover at 19-JUL-07
al | ocated channel : ORA DI SK_1
channel ORA DI SK_1: sid=156 devtype=DI SK

starting nmedia recovery

archive log thread 1 sequence 1 is already on disk as file D:\ ORACLE\ PRODUCT\ 10.
2. 0\ FLASH_RECOVERY_AREA\ GDB1\ ARCHI VELOG\ 2007_07_19\ Ol_M-_1_1_39Y98FOH . ARC
archive log thread 1 sequence 2 is already on disk as file D:\ ORACLE\ PRODUCT\ 10.
2. 0\ FLASH_RECOVERY_AREA\ GDB1\ ARCHI VELOG\ 2007_07_19\O1_M~_1_2_39Y98JSD_. ARC
archive log thread 1 sequence 3 is already on disk as file D:\ ORACLE\ PRODUCT\ 10.
2. 0\ FLASH_RECOVERY_AREA\ GDB1\ ARCHI VELOG\ 2007_07_19\ O1_M_1_3_39Y9SWAD_. ARC
archive log fil enane=D:\ ORACLE\ PRODUCT\ 10. 2. 0\ FLASH_RECOVERY_AREA\ GDB1\ ARCHI VELO
G 2007_07_19\O1_MF_1_1 39Y98FOH_. ARC t hread=1 sequence=1

medi a recovery conplete, elapsed tine: 00:00:01

Fi ni shed recover at 19-JUL-07
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If your datafiles does not consistent with the database, you should see:

Oracle 9i/10g Example:

RVAN> recover tabl espace TS1;

Starting recover at 19-JUL-07

al | ocated channel: ORA DISK 1

channel ORA DI SK 1: sid=156 devtype=Dl SK
RMAN- 00571:
RVAN- 00569:
RVAN- 00571:
RMAN- 03002: failure of recover command at 07/20/2007 12:24: 49

RVAN- 06163: sone datafiles cannot be recovered, aborting the RECOVER command
RMAN- 06166: datafile 7 cannot be recovered

RVAN- 06166: datafile 6 cannot be recovered

RMVAN- 06166: datafile 5 cannot be recovered

== ERROR MESSAGE STACK FOLLOWS =

In this case, you need to find the consistent datafiles in order to restore the tablespace.

If there are archive log missing, you should see:

Oracle 9i/10g Example:

RVAN> recover tabl espace TS1;

Starting recover at 20-JUL-07
usi ng channel ORA DI SK_1

starting media recovery

archive log thread 1 sequence 12 is already on disk as file D:\ ORACLE\ PRODUCT\ 10
. 2. 0\ FLASH_RECOVERY_AREA\ GDB1\ ARCHI VELOG\ 2007_07_18\Ol_M-_1_12_39VF4JNJ_. ARC
RVAN- 00571:
RVAN- 00569:
RVAN- 00571:
RMVAN- 03002: failure of recover command at 07/20/2007 12:28:52

RMAN- 06053: unabl e to perform nmedia recovery because of missing |og

RVAN- 06025: no backup of log thread 1 seq 13 | owscn 660617 found to restore

== ERROR MESSAGE STACK FOLLOWS =

In this case, you need to find the missing archive log files in order to restore the tablespace.

vii. Open database

RVAN> al ter database open;

Oracle 9i/10g Example:

$ export ORACLE_SI D=GDB1

$ rman target /

Recovery Manager: Release 9.2.0.1.0 - Production

Copyright (c) 1995, 2002, Oracle Corporation. All rights reserved.
connected to target database (not started)

RVAN> startup nount

Oracle instance started
dat abase nount ed

Total System G obal Area 235999352 bytes

Fi xed Size 450680 bytes
Variabl e Size 201326592 bytes
Dat abase Buffers 33554432 bytes
Redo Buffers 667648 bytes

RVAN> report scheng;

using target database control file instead of recovery catal og
Report of database schema

using target database controlfile instead of recovery catal og
Report of database schema

File K-bytes Tabl espace RB segs Datafile Name

1 419840 SYSTEM xkx / oracl e/ Or aHorre1/ or adat a/ GDB1/ syst enD1. dbf
2 204800 UNDOTBS1 i / oracl e/ Or aHonmel/ or adat a/ GDB1/ undot bs01. dbf
3 20480 CWWLI TE xRk / oracl e/ OraHonel/ or adat a/ GDB1/ cwnl i t e01. dbf
4 20480 DRSYS x ok / oracl e/ OraHonel/ or adat a/ GDB1/ dr sys01. dbf

5 141440 EXAMPLE i / oracl e/ Or aHonel/ or adat a/ GDB1/ exanpl e01. dbf
6 25600 | NDX *kx / oracl e/ OraHone1/ or adat a/ GDB1/ i ndx01. dbf

7 20480 ODM xkx / oracl e/ Or aHonel/ or adat a/ GDB1/ odnD1. dbf
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8 10240 TOOLS ki /oracl e/ OraHorre1/ or adat a/ GDB1/ t ool sO1. dbf

9 25600 USERS i / oracl e/ OraHorre1/ or adat a/ GDB1/ user s01. dbf

10 39040 XDB *ok ok / oracl e/ OraHone1/ or adat a/ GDB1/ xdb01. dbf

11 0 Ts1 *ok ok / oracl e/ OraHonel/ or adat a/ GDB1/ TS1_dat af i | el. dbf
12 0 TS1 *ox / oracl e/ OraHonel/ or adat a/ GDB1/ TS1_dat af i | e2. dbf
13 0 TS1 *ok ok / oracl e/ OraHonel/ or adat a/ GDB1/ TS1_dat af i | e3. dbf

Li st of Tenporary Files

File Size(MB) Tabl espace Maxsi ze(MB) Tenpfile Nanme

1 20 TEMP 32767 D: \ ORACLE\ PRODUCT\ 10. 2. 0\ CRADATA\
GDB1\ TEMPO1. DBF

RVAN> recover tabl espace TS1;
Starting recover at 30-AUG 07
al | ocated channel: ORA DISK 1
channel ORA DI SK_1: sid=11 devtype=DI SK

starting nmedia recovery
nmedi a recovery conpl ete

Fi ni shed recover at 30-AUG 07
RVAN> al ter dat abase open;

dat abase opened

9.6 Export and Import a Database (Logical Backup)

While physical backup of database files permit the full reconstruction of database, logical backup is a useful
supplement to physical backup for some purposes. For instance, logical backup using the export and import
utilities are the only method that Oracle supports for moving an existing database from one platform to another.

Please follow the instructions below to backup a database:

i. Export the full database to a dump file

$ exp systemf pwd123 FULL=y FILE='/oracle/data.dnp' LOG='/oracle/export.|og
(assuming your system password is pwd123, the name of dump file is / or acl e/ dat a. dnp and the
name of log file is / or acl e/ export. | og)

Oracle 9i/10g Example:

$ exp system pwd123 FULL=y FILE='/oracle/data.dnp' LOG='/oracle/export.|og

Connected to: Oracle Database 10g Enterprise Edition Release 10.2.0.1.0 - Production
Wth the Partitioning, OLAP and Data M ning options
Export done in WESMSW N1252 character set and AL16UTF16 NCHAR character set

About to export the entire database ...
. exporting tabl espace definitions
exporting profiles
exporting user definitions
exporting roles
exporting resource costs

LEEEEEEEEEE i rnd
... exporting ... //
PEELELEELEr i iringt

exporting di mensions
exporting post-schema procedural objects and actions
exporting user history table
exporting default and system auditing options
. exporting statistics
Export term nated successfully without warnings.

ii. Backup the exported dump file to the Offsite Backup Server

Please refer to the [Section 6.2 Backup files directly to the backup server] for information on how
to upload backup files to Offsite Backup Server.

Please follow the instructions below to restore a database:

iii. Download the backup files from the Offsite Backup Server

Please refer to the [Section 7.1 Restore backup files directly from backup server] for information
on how to download backup files from Offsite Backup Server.
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iv. Import the full database from the downloaded backup of dump file

$ inp system pwd123 FULL=y FILE='/oracle/data.dnp' LOG='/oracle/inport.l|og
(assuming your system password is pwd123, the name of dump file is / or acl e/ dat a. dnp and the
name of log file is / oracl e/ i nport.| og)

Oracle 9i/10g Example:

$ inp system pwd123 FULL=y FILE="/oracle/data.dnp' LOG='/oracle/inport.|og'

Connected to: Oracle Database 10g Enterprise Edition Release 10.2.0.1.0 - Production
Wth the Partitioning, OLAP and Data M ning options

Export file created by EXPORT:V10.02.01 via conventional path
inmport done in WESBMSW N1252 character set and AL16UTF16 NCHAR character set
. inporting SYSTEM s objects into SYSTEM

inporting OLAPSYS's objects into OLAPSYS

inmporting SYSMAN s objects into SYSMAN

inmporting SYSTEM s objects into SYSTEM

inporting OLAPSYS's objects into OLAPSYS

PEELELEErrr i ririringt

/Il ... inmporting ... //

PHELEEEEEEE i rinn
inmporting OLAPSYS' s objects into OLAPSYS
inmporting SYSTEM s objects into SYSTEM
inporting OLAPSYS's objects into OLAPSYS
inporting SYSMAN s objects into SYSVAN

. inmporting SCOTT's objects into SCOTT
I nport terminated successfully without warnings.

Fortikup is a trademark of Micso Srl Page 72 of 135 (April 24, 2008)



micso fortified backup User’'s Guide

Forti Up Fortikup OBS V5.2

10 Backup/Restore Microsoft SQL Server 7.0 /2000

This chapter will describe in details how to use OBM to backup your Microsoft SQL Server 7.0 / 2000 server and
how you can restore your Microsoft SQL Server 7.0 / 2000 server from the backup files.

10.1 Requirements

i. OBM must be installed onto the computer running Microsoft SQL Server.

ii. Data from Microsoft SQL Server will be backed up to a temporary directory before they are sent to
Offsite Backup Server. Please make sure you have sufficient space on your computer to store
these data when you run the backup job.

10.2 Overview

OBM wiill backup your Microsoft SQL Server database(s) by taking the following steps:
iii. Before running any backup activities, OBM will run all Pre-Commands of the backup set.

iv. For each database that is to be backed up, OBM will issue a database / transaction log backup
command to Microsoft SQL Server to backup each database to a Microsoft SQL Server database
backup file (*.bak file) and save it in the temporary directory you specified.

v. After all *.bak files have been spooled to the temporary directories, OBM will run all Post-
Commands of the backup set.

vi. Upload all files copied to the temporary directory to the Offsite Backup Server.

vii. Remove temporary files from the temporary directory if [Setting] -> [Temporary Directory for
storing backup files] is enabled
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10.3 How to backup Microsoft SQL Server database(s)

Please follow the instructions below to backup your Microsoft SQL Server databases using OBM.

i. Open OBM

Right click OBM icon available in the system tray and choose [Open]

Backup L4
Backup and Logoff 4
Backup and Restart 4
Backup and Shutdown P

Help
Btop Eunning Backup  #

Exit

T 146

ii. Create a backup set

a.

b.

From the Menu, Choose [Backup Set] -> [New] -> [MS SQL Server Backup Set]

@ Backup View

~loix|

File Backup Set

Remove » Latus Backup Set gt- MS50LBackupSet-1

Save MS Exchange Backup Set

Exit

SQLBackupSet1
rosoft SGL Server Backup

MySQL Backup Set
MSseL
WEENEE Cracle Database Backup Set

8L Server
LoginlD: =&

BackupSet-7
(=) (g MySQLBackupSet-1
{37 Backup Source Password: ===

i@ Backup Schedule

...... E gn:lnmand Line Taol Properties
...... etting

Log Tahle (MSSQLBackupSet-1)

Type | Log

Time

Backup | Log

|We\cnme to Online Backup Manager!

‘Quma (Rermaining/ Total)y: 49.9G 150G | Last Backup: 2004-07-22 14:32

Enter a name for your backup set

Backup Set
Flease type a name for this Backup Set.

MName: IMSSQLEackupSet-1
Type: Microsoft SOL Server Backup

Microsoft SGL Server

Lagin 1D Isa

Passwaord: I

= Frevious Mext = Cancel
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C. Enter the Microsoft SQL Server administrator username and password

d. Select the database(s) you want to backup

Backup Source
Pleaze select databases to be backed up

F_a Microsoft SQL Server
master

termpdb

model

msdb

pubs

Morthind

ahc

wincent
new_model

o |

Temporary disk space used for storing spool files

IC \BackupiMSSGLServer Change |
< Previous et = Cancel

e. Enter a temporary location to store the backup files before they are sent to an Offsite Backup
Server

f. Set the backup schedule for full database backup and transaction log backup

Backup Schedule

Flease schedule the backup time

Transaction log BackupSchedule (Type: Log; Yieekly - Monday, Tu

1| | |

Add | Remaove | Propetties |

= Previous Mext = Cancel

(Note: You can have more than one schedule in a backup set, i.e. you can perform intra-day
transaction log backup by adding more than one daily transaction log backup schedule to
your backup set)

g. Set the encryption algorithm, encryption mode and encrypting key for this backup set

Encryption Sefting

Flease setup the encryption sefting of the Backup Set
I~ Do NOT use encryption.

Algorithm:
Mode
+ GBGC (Gipher Block Chainine)

¢ ECB (Electronic CookBook)

Encrypting Key: |

Confirm Encrypting Key: |

< Previous Mext = Cancel

(Hint: For maximum security, please select AES (Advanced Encryption Standard) Algorithm,
CBC (Cipher Block Chaining) mode and use an encrypting key with more than 8 characters.)
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iii.  Run Backup

a. Select the backup set you want to run on the left panel and press the [Start Backup] button
)

b.  Select the backup type (e.g. Complete, Differential, Transaction Log) you would like to
perform

Backup

O [DEieeER - (omeEE
" Database - differential

" Transaction log

0K Cancel

C. Select [Off-site Backup Server] to start backing up your files to an Offsite Backup Server.

¢+ 0ff-site Backup Server

£ Local Hard Disk (Seed Load Utility)

Startthe backup for MSSQL BackupSel] 7

K Cancel

10.4 How to restore Microsoft SQL Server database(s)

Please follow the instructions below to restore your Microsoft SQL Server databases from an Offsite Backup Server.

i. Download the backup files (.bak) from the Offsite Backup Server

Please refer to the [Quick Start - Backup File] section for information on how to download backup
files from Offsite Backup Server.

ii. Open Microsoft SQL Enterprise Manager

You can open Microsoft SQL Enterprise Manager from [Start Menu] -> [Program] -> [Microsoft
SQL Server] -> [Enterprise Manager]

iii. (Optional) Restore “master” database

You need to restore “master” database if you:
a. are rebuilding all your databases from scratch

have changing any server-wide or database configuration options

have added logins or other login security-related operations.

have created or removed logical backup devices.

have configured the server for distributed queries and remote procedure calls, such as adding
linked servers or remote logins.

caeo

You do not need to restore your master database if you just want to restore a user database. For
more information on Microsoft SQL Server “master” database, please visit
http://www.microsoft.com/sqgl/.

To restore “master” database, please do the following:

a.  Start Microsoft SQL Server in “Single User Mode”

1. Right click your Microsoft SQL Server and select [Properties]
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2.

3.

4.

“Jii SOL Server Enterprise Manager - [Console Root\Microsoft SOL Servers\SOL Server Gre

|8 Console

Window  Help

|J acton yew Took || & = @@ X DR[| 2

Ik PO®EB

Tree | Databases 8 Items

|_1 Console Raot
= Microsoft SOL Servers
E4F 50 Server Group abe
=

master

hew SGL Server Registration, .
Edit S Server Registration properties. .
Delete SO Server Registration

Disconnect

bODLD

Stop
Pause
Start

New 3
All Tasks 3

New Window from Here

Delete
Refresh

Help

modz!

msdb

Northwind

pubs

tempds

(Opens property shest for the current selsction,

Press the [Startup Parameters] button

SQL Server Properties - WINZ20000-EN 5[
Comnections | SewerSefings | Datobase Setings |
General | Memary Frocessor | Seouity
@ Name: WIN20000-EN
Product: SOL Server Enterprise
Operating system: “windows NT - 5.0 (2195]
Product versior: 7.00 623
Language: English [United States]
Platform; NT INTEL =86
05 memary. 296(MEB)
Processors: 1
Roat directory: F:AMSSALT
Code page: CP1252

AutoStart palicies when the operating system starts

[~ Autostart SOL Server Agent

[~ Autostart MSDTC
Startup parametsrs
oK I Cancel I Lpply Help

Add a “-m” parameter to the [Startup Parameters]

Parameter

Existing parameters
-dC:%Program Files\Microzoft SOL Server

-eC:5Program FilestMicrozoft SOL Server
-IC:\Pragram Filesihicrozoft SOL Servers

KN

ok |

i

Cancel |

-m
Femove |

Help

Restart Microsoft SQL Server

From [Enterprise Manager], right click your Microsoft SQL Server and select [Stop] and

then [Start].
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b.

2.

3.

"Hi SOL Server Enterprise Manager - [Console Root'Microsoft SQL Servers\SOL o [w] 4
|1 Console  Window  Help | =181 ]

| acion  wiew  Toos “ & =+ |

N

EIE:S AR BO®3

Tree I WIMNZODDO-EN {Windows NT) 5 Items

21 Consols Root Gett|ng Started Taskpad

=B Microsaft SQL Servers
¥ & &

45 5QL Server Group
BN
set up your monitor your import or
database S0L Server export data

i

Mew SOL Server Registration, ..
Edit SQL Server Registration properties. ..
Delete SGL Server Registration

-] Dat.
Discannect
solution

Pause
Stark

Mew »
B Dat g Tasks ,
- Mar
B Sem  View »
-1 5up  Mew Window from Here

Delete
Refresh

Properties

Help

"Hi SOL Server Enterprise Manager - [Console Root'Microsoft SQL

=18 x|
|F console Window  Help |=|i|i|

| acon wew wos || = B X @ E[ R[N B0 LS

Tres | SOL Server Group 1 Item

I_1 Console Root %

=T} Microsaft SQL Servers

=453 501 Server Group! WINZO000-EN
B Mew SQL Server Reqistration, ..

Edit SGL Server Registration properties. .
Delete 501 Server Registration

[{ald

Connect
Stop.
Pause

ew 3
All Tasks 3

Newy Window From Here

Delete
Refresh

q | Properties

Help

Restore “master” database

From [Enterprise Manager] -> [Tools] -> [Restore Database]

"[i SOL Server Enterprise Manager - [Console Root rosoft SOL Server: -0l x|
J'ﬁ] Console  Window  Help |- & ﬁl‘
| aon ven wos | ¢ o (@@ XEE|@]% N B0 LG |
Tree I Data Transformation Services 4 (Windows NT) 5 Ttems
——  JobScheduling...
=] C";”‘E R”?ES Reeplication v ) Started Taskpad
E‘ Ierosal Full-Text Indexing. ..
54 saLse
E-EEEE 5oL Server Query Analyzer
SaL Server Profiler i .
Database Scripting, . [ goctupyour | mosRoryomsgL  Tmportorexpodt
‘Wizards..,
Database Maintenance Planner. ..
Backup Database [ta

SQL Server Configuration Properties. ..
Manage SQL Server Messages. ..

External Tools...
Opkions...
Font...

Terming

Select [master] in the [Restore as database] drop down list

Select the [From device] radio button.
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4.

5.

6.

7.

Press the [Select Devices] button.

General | Dptions |

@ Bestore a5 database: Imaslel j

Restare: " Database " Filegroups or files @ From devics

Parameter

Devices: ’

Backup number: |1 Wiew Cantents..

' Restore backup et
@ Database - complete
" Databage - differential
" Transaction log

 File or filegroup

" Riead backup set information and add to backup history

aK Cancel Help

From the [Choose Restore Devices], press the [Add] button.

Choose Restore Devices x|
When the backup is restored, SEL Server will stterpt to restare from the
devices listed below,

Backup set: [Unknown]
Restare from: &+ Disk " Tape

Device hame ‘

Edit
Bemoye

q I LI Femae All
Media verification option
I™ Dby restare from media with the following narme:

Iedia name: I
Ok Cancel

From the [Choose Restore Destination] panel, press the [...] button to choose your master

backup (*.bak) from your backup files

Choose Restore Destination

Chease the file name or backup device to use for the
E=)  restore cperation. Backup devices can be created o fles
that you use frequently,

 Fie name! [FHSSaLTBATKUP -
&

" Backup device: I

Cancel

Press the [OK] button, to start restoring the “master” database.

C. Restart Microsoft SQL Server in “Normal Mode”

1.

2.

iv. (Optional) Restore “model”, “msdb” and “distribution” database

Remove “-m” parameter from the [Startup Parameters] as in previous step

Restart your Microsoft SQL Server as in previous step

You need to restore “model” database if you have changed the database template of your SQL

Server.

You need to restore “msdb” database if you have changed the scheduling information or you want

to restore the backup and restore history of your databases.
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You need to restore “distribution” database if you are running the replication components of SQL
Server.

You do not need to restore these databases if you just want to restore a user database. For more
information on Microsoft SQL Server “model”, “msdb” and “distribution” database, please visit
http://www.microsoft.com/sql/.

You need to restore each of these databases one by one. To restore any of these databases,
please do the following:

a. From [Enterprise Manager] -> [Tools] -> [Restore Database]

b.  Select the database to be restored in the [Restore as database] drop down list

C. Select the [From device] radio button.

d. Press the [Select Devices] button

e. Press the [...] button to choose your backup files (*.bak) for the database to be restored
f. Press the [OK] button

V. Restore user database(s)

For each of the database you would like to restore,
a. From [Enterprise Manager] -> [Tools] -> [Restore Database]
b. Select the database to be restored in the [Restore as database] drop down list

C. Select the [Database] radio button.

Restore database x|

Gereral } Optians |

uﬁ Hestore a5 dalabase: [abo =l

Restore: * Database " Filegroups or files " From device

Parameters

St backugs of detzbese. [
First backup to restare: |13.z‘1 142001 18:52:43 - j
-

Restore | Type | Backup set date | Size | Restore from | Backup set name
¥ 131120011, OKb CAMSSAL

oK Cancel | Help ‘

d. From the [Show backups of database] drop down list, select the database to be restored

e. From the [First backup to restore] drop down list, select the snapshot of the database you
would like to restore to.

You can restore your database to the snapshot of your database at any point of the time
between the time you did your full backup and the time you did your last subsequent backup.

f. Change the [Restore From] entry

If you backup files (*.bak) are not in the default directory, you need to update the full path
to your backup files by pressing the [Properties] button.

g. Press the [OK] button
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vi. All database(s) restored successfully
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11 Backup/Restore Lotus Domino / Notes

This chapter will describe in details how to use OBM to backup your Lotus Domino server / Notes client 5/ 6 / 6.5
and how you can restore your Lotus Domino server / Notes client 5 / 6 / 6.5 from the backup files.

11.1 Requirements

i. OBM must be installed onto the computer running Lotus Domino server / Notes client.

Data from Lotus Domino server / Notes client will be backed up to a temporary directory before

they are sent to Offsite Backup Server. Please make sure you have sufficient disk space on your
computer to store these data when you run the backup job.

Lotus Domino server must runs with archive transaction logging enabled

To set up transaction logging in archive style, please do the following:

a.
or in subdirectories.

From the Domino Administrator, click the Configuration tab.

In the "Use Directory on" field, choose the server's Domino Directory.
Click Server Configuration, and then click Current Server Document.
Click the Transactional Logging tab.

Complete these fields, and then save the document.

Ensure that all databases to be logged reside in the Domino data directory, either at the root

Field

Enter

Transactional Logging

Choose Enabled. The default is Disabled.

Log path

Path name location of the transaction log.

The default path name is \LOGDIR in the Domino
data directory, although it is strongly recommended
to store the log on a separate, mirrored device, such
as a RAID (Redundant Array of Independent Disks)
level O or 1 device with a dedicated controller.

The separate device should have at least 1GB of disk
space for the transaction log. If you are using the
device solely for storing the transaction log, set the
"Use all available space on log device" field to Yes.

Logging style

Choose Archive. The default is Circular.

Maximum log space

The maximum size, in MB, for the transaction log.
Default is 192MB. Maximum is 4096MB (4GB).
Domino formats at least 3 and up to 64 log files,
depending on the maximum log space you allocate.

Use all available space
on log device

Choose one:

. Yes to use all available space on the device for
the transaction log. This is recommended if you
use a separate device dedicated to storing the
log. If you choose Yes, you don’t need to enter a
value in the "Maximum log space" field.

. No to use the default or specified value in the
"Maximum log space" field.

Automatic fixup of
corrupt databases

Choose one:

. Enabled (default). If a database is corrupt and
Domino cannot use the transaction log to
recover it, Domino runs the Fixup task, assigns
a new DBIID, and notifies the administrator that
a new database backup is required.

. Disabled. Domino does not run the Fixup task
automatically and notifies the administrator to
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run the Fixup task with the -J parameter on
corrupt logged databases.

Runtime / Restart This field controls how often Domino records a
performance recovery checkpoint in the transaction log, which
affects server performance.

To record a recovery checkpoint, Domino evaluates

each active logged database to determine how many

transactions would be necessary to recover each
database after a system failure. When Domino
completes this evaluation, it:

. Creates a recovery checkpoint record in the
transaction log, listing each open database and
the starting point transaction needed for
recovery

. Forces database changes to be saved to disk if
they have not been saved already

Choose one:

. Standard (default and recommended).
Checkpoints occur regularly.

. Favor runtime. Domino records fewer
checkpoints, which requires fewer system
resources and improves server run time
performance.

o Favor restart recovery time. Domino records
more checkpoints, which improves restart
recovery time because fewer transactions are
required for recovery.

Notes:

You can only run transaction log backup if you have transaction logging enabled and you are
using archive mode. This command does not apply if you have transaction logging enabled not
in archive mode or if transaction logging is not enabled at all. If you try to issue it, you will
receive an error message.

11.2 Overview

OBM wiill backup your Lotus Domino server / Notes client by taking the following steps:
i. Run all Pre-Commands of this backup set
ii. If the backup type to run is [Database Backup type],

a. all file(s) / database(s) selected are copied to the temporary directory specified by this
backup set

b.  the notes.ini file, if selected, will be copied to the temporary directory

C. only filled log extents will be copied to the temporary directory, and the Domino server is
notified of their availability for reuse (for Domino server only)

iii.  (for Domino server only) If the backup type to run is [Transaction Log Backup type],

a. only filled log extents will be copied to the temporary directory, and the Domino server is
notified of their availability for reuse

iv.  Run all Post-Commands of this backup set
V. Upload all files copied to the temporary directory to the Offsite Backup Server

vi. Remove temporary files from the temporary directory if [Setting] -> [Temporary Directory for
storing backup files] is enabled
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11.3 How to backup Lotus Domino / Notes database(s) / file(s) on
Windows

Please follow the instructions below to backup your Lotus Domino server / Notes client databases / files using OBM.

i. Open OBM

Right click OBM icon available in the system tray and choose [Open]

Backup 4
Backup and Logoff 4
Backup and Restart 4
Backup and Shutdown P

Help
Stop Bunning Backop ¥

Exit

[ 1446
ii. Create a backup set

a. From the Menu, Choose [Backup Set] -> [New] -> [Lotus Backup Set]

-0l x|
il Backup View
File Backup Set
Remove b £t - MSSQLBackupSet1
Save MS Exchange Backup Set
i M3 QL Server Backup Set
| i P SCOLBackupSet-1
[ COTTE T
[RMESET eI R ] rosoft SOL Server Backup
EERLt Oracle Database Backup Set
[FIMESExct P AL Serve
[0 Backupget? [y
5[5 MySOLBackupSet-1 EMISE &
i &8 Backup Source Password: ™=
-y Backup Schedule
“[F Command Line Tool Properiias
L Setting
B Encryption
Log Table (MSSQLBackupSet-1) &
Tine | Log Time
Backup | Log
|We\come to Online Backup Manager! ‘Quota (Remaining f Totaly: 43.9G 506G |Last Backup: 2004-07-22 14:32

b.  Enter a name for your backup set

Add new Lotus Backup Set ] |

Backup Set

Please type a name for this Backup Set.

Narme: [LotusBackupSet 1
Type: Latus Domina Semer Backup

[ Lotu:

notes. ini: lD'\Lntus\Dnminn\nmes ini

Cancel = Freyous et =
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C. Select the Backup Set Type (Lotus Domino Server Backup / Lotus Notes Client Backup)

d. Select the database(s) / file(s) you want to backup

Add new Lotus Backup Set i =

~Backup Source

Please selectfiles orfand directories to be hacked up.

=} @Lulus Doming ﬁl
- CIEgs
M Cdfe
M C1domine
Clgtrhome
Clhelp
C1IBM_TECHMICAL_SUPPORT

q | ;ﬁ‘
-Temparaty directary for storing backup files

|C'\Backup\Lntus Change

¥ Remove temporary files after backup

Cancel = Previous Mext =

e. Enter a temporary location to store the backup files before they are sent to an Offsite Backup
Server

f. Set the backup schedule for Database Backup

[ Backup Schedule

Pleaze schedule the backup time:

Transaction Log Backup Schedule (Type: Transaction log, VWeekly

Kl | |

Add | Remove | Froperties |

= Previous | Mext = Cancel

g. Set the backup schedule for Transaction Log Backup (for Domino server only)
(Note: You can have more than one schedule in a backup set, i.e. you can perform intra-day
transaction log backup by adding more than one daily transaction log backup schedule to
your backup set)

h.  Set the encryption algorithm, encryption mode and encrypting key for this backup set

[ Encryption Setting
Flease setup the encryption setting of the Backup Set

[~ Do MOT use encryption.

Algarithrm: |Twofish +

Mode:
 CBC (Cipher Block Chaining)

" ECE (Electronic CookBoaok)

Encrypting Key: |

Canfirm Encrypling Key: |

= Pravious | Mext = Cancel

(Hint: For maximum security, please select AES (Advanced Encryption Standard) Algorithm,
CBC (Cipher Block Chaining) mode and use an encrypting key with more than 8 characters.)
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iii.  Run Backup

a. Select the backup set you want to run on the left panel and press the [Start Backup] button
)

b.  Select the backup type (e.g. Database, Transaction Log) you would like to perform (for
Domino server only)

Backup

= Database (notes.ini, Databases, Files, Transaction Logs}

= Transaction Logs

Ok | Cancel

C. Select [Off-site Backup Server] to start backing up your files to an Offsite Backup Server.

(ol ;Of'r-sne Backup Server

¢ Local Hard Disk (Seed Load Utility)

Start the hackup for [LotusBackupSet-1] 7

0K Cancel
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11.4 How to restore Lotus Domino / Notes database(s) / file(s) on
Windows

Please follow the instructions below to restore Lotus Domino server / Notes client database(s) / file(s) from an
Offsite Backup Server.

i. Install Lotus Domino server / Notes client back to its original folder (if required)
ii.. Install OBM
Please refer to the [Installation] section for information on how to install OBM onto your computer.
iii.  Shutdown Lotus Domino Server
iv. If you want to perform a full domino restore (restore all databases and files):

a. Download the backup files to be restored from the Offsite Backup Server and save them back
to its original location. It includes notes.ini, all backup files from the lotus domino data
directory and all archived transaction logs

b.  Modify the “DominoRecover.bat” located under the bin directory of the OBM installation to
reflect your setup. You need to specify the lotus executable directory.

For example change the PROGRAM_DIR to:
PROGRAM_DIR=C:\Lotus\Domino

C. Run “DominoRecover.bat” and press ‘Y’ to continue.
For example: C:\program files\obm\bin\DominoRecover.bat

This will run media recovery for all databases (*.nsf and mail.box) found under the Lotus
data directory (e.g. C:\Lotus\Domino\Data). You should see something similar to the screen
below.

Media Recovery Example:

C:\program fil es\ obm bi n>Doni noRecover . bat
Medi a Recovery Utility for Lotus Domino 5.0 or above

Pl ease make sure that you have done the fol | ow ng:

1. Reinstall Lotus Domino on this conputer in the sane directory

2. Restore Notes.ini to the Lotus Donmino installation directory
(e.g. C\Lotus\Don no)

3. Restore Donmino Data directory back to the directory defined
in Notes.ini (e.g. C:\Lotus\Don no\Data)

4. Restore all archived transaction logs to the directory defined
in Notes.ini (e.g. C\Lotus\Dom no\Data\logdir)

Continue ? (Y) or (N y

Runni ng nedi a recovery ...

Pl ease wait, creating new transaction logs in directory: C\logdir\

02/ 12/ 2003 14:39:19 Recovery Manager: Restart Recovery conplete. (0/0
dat abases needed full/partial recovery)

Medi a Recovery Replay (122 MB): 10% 20% 30% 40% 50% 60% 70% 80% 90% 100%
02/ 12/ 2003 14:39:22 Recovery Manager: Media Recovery conplete for

C: \ Lot us\ Doni no\ Dat a\ adni n4. nsf, |ast update applied .

Backup file C:\Lotus\Doni no\Data\adm n4. nsf recovered.

Medi a Recovery Replay (122 MB): 10% 20% 30% 40% 50% 60% 70% 80% 90% 100%
02/ 12/ 2003 14:40:57 Recovery Manager: Media Recovery conplete for
C: \ Lot us\ Domi no\ Dat a\ statrep. nsf, |ast update applied .

Backup file C:\Lotus\Don no\Data\statrep.nsf recovered.

C:\ program fil es\ obm bi n>

d.  All content of all database(s) are now rolled forward to the last committed transaction found
in the last archived transaction log.

e. Restart Lotus Domino server
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V. If you just want to restore a single database:

a.

e.

f.

Download the database file to be restored from the Offsite Backup Server and save them

back to its original location.

(optional) If you need to perform media recovery on this database, please download all
archived transaction logs and save them back to its original location

Modify the “DominoRecover.bat” located under the bin directory of the OBM installation to

reflect your setup.

For example we will recover the “admin4.nsf” and have restored the file to

C:\restore\notesdata, change the tags to:
PROGRAM_DIR=C:\Lotus\Domino
INPUTFILE=C:\restore\notesdata\admin4.nsf
RESTOREDB=C:\Lotus\Domino\Data\admin4.nsf
RECDATE=18/01/2007
RECTIME=00:02

Run “DominoRecover.bat”.

You should see something similar to the screen below.

Media Recovery Example:

C:\program fil es\ obn>Doni noRecover . bat
Medi a Recovery Utility for Lotus Domino 5.0 or above

Runni ng nedi a recovery ...

Restart Analysis (0 MB): 100%

18/ 01/ 2007 14:42:15 Recovery Manager: Restart Recovery conplete. (0/0
dat abases needed full/partial recovery)

Medi a Recovery Replay (122 MB): 10% 20% 30% 40% 50% 60% 70% 80% 90% 100%
18/ 01/ 2007 14:42:17 Recovery Manager: Media Recovery conplete for

C:\ Lot us\ Domi no\ dat a\ adnmi n4. nsf, |ast update applied .

Backup file C:\Lotus\Dom no\data\adnm n4.nsf recovered.

C:\ Lot us\ Doni no>

All content of the database are now rolled forward to the last committed transaction found in

the last archived transaction log.

Restart Lotus Domino Server
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11.5 How to backup Lotus Domino / Notes database(s) / file(s) on

Linux

Please make sure that the user running OBM have sufficient privileges to read and write to the “notesenv” file
located in the “bin” subdirectory of where OBM is installed. This file is used by OBM to store the location of the
domino/notes application executables. e.g. use chmod to set read, write & execute permissions

# cd $OBM_HOME/bin
# chmod 777 notesenv

Please follow the instructions below to backup your Lotus Domino server / Notes client databases / files using OBM.

i. Open OBM by typing the following in a terminal

# cd $OBM_HOME
# ./bin/BackupManager.sh

Create a backup set

a. From the Menu, Choose [Backup Set] -> [New] -> [Lotus Backup Set]

Online Backup Manager

Set-1

Propenties |

[¥| Run scheduled backup on this computer

]

Log

Time |

~|
._Baékup;SEl Backup Restore Tools View Help
| New ¥ |3 File Backup Set
ARemove ¥ 10
}.—:-{ Save Setting
6 Exit
I if
| MyS0L Backup Set
|@ Oracle Database Backup Set
Log Table (FileBackupSet-1)
Type |
1 Backup 1latog |
‘Welcome to Online Backup Manager!

Quota (Remaining / Total): 99.29G f 100G Last Backup: 2007-01-29 17:43

b.  Enter a name for your backup set

[+] Add new_Lotus Backup Set (]
[-Backup Set
Please type a name for this Backup Set
Name: |LowsBackupsSet-1 |
Type: Lotus Domina Server Backup
Lotus
notes.ini: |/local/notesdata/notes. ini Change
Cancel Mext >
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Select the location of the “note.ini” file. The default path for this will be in the

/local/notesdata folder.

Select the database(s) / file(s) you want to backup

-Backup Source
Please select files orfand directories to be backed up.

© [7] (1 1BM_TECHNICAL_SUPFORT
e[ arc
@ [4 Jdomino

(Clatrhome

Temporary directory for storing backup files -

Jvarfbackup/Lotus | Change

[vi Remove temporary files after backup

Cancel < Previous ’V

B =~ Addnew LowsBackupser |

Enter a temporary location to store the backup files before they are sent to an Offsite Backup
Server. Please make sure that the user running OBM have sufficient privileges to read and

write to this location and sufficient space is available.

Set the backup schedule for Database Backup

[~] Add new Lotus Backup Set &
Backup Schedule
Please schedule the backup time.

Database BackupSchedule (Type: Database; Weekly - Friday)
Transaction log BackupSchedule (Type: Transaction Logs; We

l Add || Remove H Properties

Cancel < Previous Next >

] Database BackupSchedule Properties x|

Name: [Database BackupSchedule |
Backup

® Database (notes.ini, Databases, Files, Transaction Logs)
() Transaction Logs

Type

) Daily @ Weekly () Monthly ) Custom
Day-

Backup on the following day(s) every week:

[C]'Sunday [ Monday [ Tuesday [ Wednesday
[C] Thursday (¥ Friday [T Saturday

Start

Start Time (hh:mm): |21 w || 00 w

Stop
Stap on completion (Full Backup)

ok || cancel

Set the backup schedule for Transaction Log Backup (for Domino server only)
(Note: You can have more than one schedule in a backup set, i.e. you can perform intra-day
transaction log backup by adding more than one daily transaction log backup schedule to

your backup set)
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h.  Set the encryption algorithm, encryption mode and encrypting key for this backup set

Add new Lotus Backup Set

Encryption Setting -
Please setup the encryption setting of the Backup Set.

) Default (Use Login Password as Encrypting Key)
® Custom

] Do NOT use encryption.

Algorithm: | AES >
Mode:
® CBC (Cipher Block Chaining)

() ECB {Electronic CookBook)
Encrypting Key:
Confirm Encrypting Key: |

| cancel < Previous Next >

(Hint: For maximum security, please select AES (Advanced Encryption Standard) Algorithm,
CBC (Cipher Block Chaining) mode and use an encrypting key with more than 8 characters.)
iii.  Run Backup

Select the backup set you want to run on the left panel and press the [Start Backup] button
)

a.

b.  Select the backup type (e.g. Database, Transaction Log) you would like to perform (for
Domino server only)

Select Backup Type (LotusBackupSet-1)

-Backup
(® Database (notes.ini, Databases, Files, Transaction Logs)

() Transaction Logs

Select [Off-site Backup Server] to start backing up your files to an Offsite Backup Server.

C.

Confirm Backup Start

Backup to
® Offsite Backup Server
(0 Local Harel Disk (Seed Load Utility)

Start the backup for [LotusBackupSet-1] 7

I OK || Cancel |[ Options > > I

d.  You should get something similar to the screen shot below.
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b2 Z Online Backup Manager Z
Backup Set Backup Restore Tools View Help

|5 save Setting | P> M stop Backup |

;": Backup Controller ,N {4 Backup Set - LotusBackupSet-1
=2 User Profile y ~Backup Set- o :
b M-i‘?%u;f ?::s'f;‘:e Name: LotusBackupSet-1
e Type: Lotus Domino Server Backup |E‘
[~ Backup Schedule
il Backup Filter {#] Log Table (LotusBackupSet-1) =
[E]Command Line Tool [Type] Log [
\.] Setting @ Stant [ Linux 2.6.9-42 ELsmp (localhost), OBM 5.2.1.0 ] [2007701/30 01:58:21]
&l Encryption @ Stant running pre-commands [2007/01/20 01:58:22]
{4 Retention Palicy @ Finished running pre-cormmands [2007/01/20 01:58:22]
%E’“”a Backup @ Stan backing up Motes.ini to "jvarfbackup/Lotus/ 1170093 109...  [2007/01/30 01:58:22]
(G In-Flle Oeta @  End backing up Notes.ini [2007/01/20 01:58:22]
\’_7} Start backing up updated files/databases 1o "fvarfbackup/Lotu...  [2007/01/30 01:58:22]
@ Backing up "/localfnetesdatajdomino/html [DAO/setup. exe” [2007/01/30 01:58:27]
\’B *flocal fnotesdarafdomino/htmlfDAD/setup. exe” backup succes. [2007/01/30 01:58:39]
G) Backing up “flocalfnotesdata/domino/html ffavicon.ico” ... [2007/01/30 01:58:39]
\’_7} *flocalfnotesdata/domino/htmlffavicon.ico” backup successfully. [2007/01/30 01:58:41]
@ Backing up */localfnetesdatajdomino/html fdwa?. cab® [2007/01/30 01:58:41]
@ “jlocalfnotesdatajdoming fhmifdwa7. cab backup successfully. [2007/01/30 01:58:42]
G) Backing up "flocalfnotesdata/domino/himl fdwa7 W.cab” [2007/01/30 01:58:42]
\’_7} “flocalfnotesdatafdomino/htmlfdwa7Ww. cab” backup successfully.  [2007/01/30 01:58:43]
T Backing up "flocalfnotesdata/domino/html fdwaZres_en.dll* ... [2007/01/30 01:58:44]
@ “jflocalfnotesdatajdoming fhtmifdwa7res_en. dii* backup succes...  [2007/01/30 01:58:45]
G) Backing up "flocal{notesdata/domino/html fiNotesé. cab® [2007/01/30 01:58:45]

| & Backup [TV Restore | Lo

Backing up "flocalfnotesdata/domino fhimlfiNotesé.c...

Quota (Remaining / Totaly 99.29G / 100G Last Backup: 2007-01-29 17:43

11.6 How to restore Lotus Domino / Notes database(s) / file(s) on
Linux

Please follow the instructions below to restore Lotus Domino server / Notes client database(s) / file(s) from an
Offsite Backup Server.

Install Lotus Domino server / Notes client back to its original folder (if required)

Install OBM

Please refer to the [Installation] section for information on how to install OBM onto your computer.

Shutdown Lotus Domino Server

If you want to perform a full domino restore (restore all databases and files):

a.

Download the backup files to be restored from the Offsite Backup Server and save them back
to its original location. It includes notes.ini, all backup files from the lotus domino data
directory and all archived transaction logs. If you encounter any access problems, please try
restoring using the “root” user.

Make sure that the owner and group permissions of the restored files are the notes user
For example: # chown —R notes:notes /local/notesdata

This will assign the owner and group to all files and directories within /local/notesdata.

Modify the “DominoRecover.sh” located under the bin directory of the OBM installation to
reflect your setup. You need to specify the data directory and the lotus executable directory.

For example change the DATA_DIR and LOTUS tags to:

DATA_DIR=/local/notesdata
LOTUS=/opt/ibm/lotus

Make sure the current user is the notes user before running the “DominoRecover.sh”.
Run “DominoRecover.sh” and press ‘Y’ to continue.
For example: #./usr/local/obm/bin/DominoRecover.sh

This will run media recovery for all databases (*.nsf and mail.box) found under the Lotus
data directory (e.g. /local/notesdata). You should see something similar to the screen below.
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f.

g.

Media Recovery Example:

bash-3.00$ cd /usr/local /obni bin
bash-3.00$ ./ Domi noRecover. sh
Medi a Recovery Utility for Lotus Domino 5.0 or above

Pl ease make sure that you have done the fol | ow ng:

1. Reinstall Lotus Domino on this conputer in the sane directory

2. Restore Notes.ini to the Lotus Donmino installation directory
(e.g. /local/notesdata)

3. Restore Domino Data directory back to the directory defined
in Notes.ini (e.g. /local/notesdata)

4. Restore all archived transaction logs to the directory defined
in Notes.ini (e.g. /local/notesdatal/logdir)

Continue ? (Y) or (N vy

Runni ng nedi a recovery ...

directory /local/notesdata// already exists

Pl ease wait, creating new transaction logs in directory: /local/notesdata/logdir/
02/01/2007 11:38:43 AM Recovery Manager: Restart Recovery conplete. (0/0 databases
needed full/partial recovery)

02/ 01/ 2007 11:38:45 AM Recovery Manager: Assigning new DBIID for

/'l ocal / not esdat a/ nanes. nsf (need new backup for nedia recovery).

Medi a Recovery Replay (0 MB): 100%

02/01/2007 11:38:45 AM Recovery Manager: Media Recovery conplete for

/'l ocal / not esdat a/ df c/ df c100. nsf, |ast update applied .

Backup file /local/notesdata/dfc/df c100. nsf recovered.

Medi a Recovery Replay (0 MB): 100%

02/ 01/2007 11:38:46 AM Recovery Manager: Media Recovery conplete for
/'l ocal / not esdat a/ hel p/ decsdoc. nsf, |ast update applied .

Backup file /local/notesdatal/i Notes/hel p70_i wa_en. nsf recovered.
Medi a Recovery Replay (0 MB): 100%
02/01/2007 11:38:50 AM Recovery Manager: Media Recovery conplete for
/'l ocal / not esdat a/ mai | / notes. nsf, |ast update applied .

Backup file /local/notesdata/ mail/notes.nsf recovered.
bash- 3. 00$

All content of all database(s) are now rolled forward to the last committed transaction found

in the last archived transaction log.

Restart Lotus Domino server

If you just want to restore a single database:

a.

d.

e.

Download the database file to be restored from the Offsite Backup Server and save them

back to its original location.

(optional) If you need to perform media recovery on this database, please download all

archived transaction logs and save them back to its original location

Modify the “DominoRecover.sh” located under the bin directory of the OBM installation to

reflect your setup.

For example we will recover the “admin4.nsf” and have restored the file to

/restore/local/notesdata, change the tags to:
DATA_DIR=/local/notesdata
LOTUS=/opt/ibm/lotus
INPUTFILE=/restore/local/notesdata/admin4.nsf
RESTOREDB-=/local/notesdata/admin4.nsf
RECDATE=18/01/2007
RECTIME=22:41

Make sure the current user is the notes user before running the “DominoRecover.sh”.

Run “DominoRecover.sh”.

You should see something similar to the screen below.

Media Recovery Example:

bash-3.00% cd /usr/local /obni bin
bash-3.00$ ./ Domi noRecover. sh
Medi a Recovery Utility for Lotus Domino 5.0 or above
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directory /local/notesdata// already exists
Recovering backup file ...

Restart Analysis (0 MB): 100%

18/ 01/ 2007 03:35:56 PM Recovery Manager: Restart Recovery conplete. (0/0 databa ses
needed full/partial recovery)

Medi a Recovery Replay (1 MB): 30% 50% 80% 100%

18/ 01/ 2007 03:35:57 PM Recovery Manager: Media Recovery conplete for /local/res
tore/l ocal / not esdat a/ admi n4. nsf, |ast update applied .

Backup file /local/restore/local/notesdatal/adm n4. nsf recovered.

Taki ng dat abase /| ocal / not esdat a/ admi n4. nsf offline ...

Restoring database /| ocal / not esdat a/ adni n4. nsf

fromrecovered backup file /local/restore/local/notesdatal/adm n4.nsf ...
Dat abase file /1| ocal/notesdata/adm n4.nsf restored from/local/restore/local/not
esdat a/ admi n4. nsf

Bringi ng dat abase /| ocal / notesdata/ adm n4.nsf online ...

Program conpl et ed successful ly.
bash- 3. 00$

f. All content of the database are now rolled forward to the last committed transaction found in
the last archived transaction log.

g. Restart Lotus Domino Server
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12 Backup/Restore Microsoft Exchange Server

This chapter will describe in details how to use OBM to backup your Microsoft Exchange Server 2000 / 2003 and
how you can restore your Microsoft Exchange Server 2000 / 2003 from the backup files.

12.1 Requirements

i. Microsoft Exchange Server 2000 with Services Pack 3 and post-SP3 update rollup installed. Please
refer to http://www.microsoft.com/exchange/ for more information.
or
Microsoft Exchange Server 2003.

ii. OBM must be installed onto the computer running Microsoft Exchange Server 2000 / 2003.

iii. Data from Microsoft Exchange Server will be backed up to a temporary directory before they are
sent to Offsite Backup Server. Please make sure you have sufficient space on your computer to
store these data when you run the backup job.

12.2 Overview

A Microsoft Exchange Server 2000/2003 stores its data in Windows Active Directory as well as in its databases. To
fully backup a Microsoft Exchange Server 2000/2003, you need to backup the following components:

i. Windows System State

The Windows System State contains the information about your Windows system, including
Windows Active Directory. A Microsoft Exchange Server 2000 / 2003 stores some of its
configuration, e.g. email accounts and mailbox properties, inside Windows Active Directory. It is
important that Windows Active Directory is backup properly when backing up a Microsoft Exchange
Server.

Active Directory is stored inside a Windows Server running as Windows domain controller. If your
Exchange Server is a domain controller, you can simply backup the Windows System State of your
Exchange Server. If your Exchange Server is running as a member server, you will need to install
another copy of OBM onto the domain controller to backup the Windows System State of inside the
domain controller.

For more information on Active Directory, please refer to
http://www.microsoft.com/windows2000/technologies/directory/ad/default.asp

ii. Microsoft Information Store
Exchange Server stores all emails and documents inside its databases, which are grouped together
as storage groups inside Microsoft Information Store. It is important that Microsoft Information
Store is fully backup when backing your Exchange Server.

iii. Microsoft Site Replication Service
Microsoft Site Replication Service is installed automatically when exchange server site replication
feature is enabled. Microsoft Site Replication stores its runtime and configuration information
inside its own database. If you are running your Exchange Server with Site Replication Service
enabled, please make sure that you backup the site replication database as well.

iv. Microsoft Key Management Service (Exchange 2000 only)
Similarly, if you have setup your Exchange Server with Key Management Services enabled, please
make sure that you backup the key management database as well.

OBM will backup your Microsoft Exchange Server by taking the following steps:
V. Run all Pre-Commands of this backup set
vi. If the backup type to run is [Database Backup type],
a. Windows System State will be backed up to a temporary directory specified in its backup set

b.  All exchange database(s) selected are backed up to a temporary directory specified in its
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backup set
vii.  If the backup type to run is [Transaction Log Backup type],

a. New transaction log extents generated since last backup will be copied to the temporary
directory

viii. Remove transaction log extents backed up from the Exchange Server
iX. Run all Post-Commands of this backup set
X. Upload all backup files from the temporary directory to an Offsite Backup Server

Xi. Remove temporary files from the temporary directory if [Setting] -> [Temporary Directory for
storing backup files] is enabled
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12.3 How to backup Microsoft Exchange Server
Please follow the instructions below to backup your Microsoft Exchange Server 2000 / 2003 using OBM:

i. Open OBM

Right click OBM icon available in the system tray and choose [Open]

Backup L4
Backup and Logoff 4
Backup and Restart 4
Backup and Shutdown P

Help
Btop Eunning Backup  #

Exit

T 146

ii. Create a backup set

a. From the Menu, Choose [Backup Set] -> [New] -> [MS Exchange Backup Set]

-10] x|
il Hackup View
File Backup Set
I
Pl O | Lo B G et M33aLBackupset]
Save M ie Backup Set
Exit MS SQL Server Backup Set
T SQLBackupSet
i ackup Se rosoft SEL Server Backup
Qracle Database Backup Set
QL Server
(@9 BackupSet7 X
5[ MySQLBackupSet1 (LG 2 &2
@ Backup Source Passward: ¥
+[igh Backup Schedule
-] Command Line Tool Properties
-~ L setting
L8 Encryption
Log Tahle (MESQLBackupSet-1) &
Type | Log Time
Backup | Log
|We\nnmem Cnline Backup Manager! ‘Guma (Remaining / Total): 49.9G / 50G |Last Backup: 2004-07-22 14:32

b.  Enter a name for your backup set

rBackup Set
Please type a name for this Backup Set.

Mame: [MSExchangeBackupSet-1
Type: Microsoft Exchange Server Backup

= Frevigus MNext = Cancel

C. Select the database(s) to be backup
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rBackup Source
Please select Database to be hacked up.
=k my Gomputer =
L[ o system Gtate
=1 (§ Micrasoft Exchange Server
(Bl =3 WIN20005VR
- [T & Micrasoft Informatian Store
[=-[7 ¥ First Storage Group
~[T 3 Mailbox Stare QWIN20008VR)
[ @ Public Folder Store gAN20005VR)
= o el
[ 3 abo
[ O acct
7 3 mallz =l

rTermporary directory for staring backup files

IC:'LEackupIMSExchange Change |
= Previous Mext = | Cancel

If this Exchange Server is also a domain controller of this Active Directory, select the [System
State] checkbox as well. Otherwise, please install OBM to the domain controller of this Active
Directory and select the [System State] checkbox on that computer

Enter a temporary directory for storing the backup files before they are sent to an Offsite
Backup Server

Set the backup schedule for Database Backup

rBackup Schedul
Flease schedule the hackup time.

Transaction Log Backup Schedule {Type: Transaction log; Weekly

4 | |

Add | Remaove | Froperties |

= Previous | Mext = Cancel

Set the backup schedule for Transaction Log Backup

(Note: You can have more than one schedule in a backup set, i.e. you can perform intra-day
transaction log backup by adding more than one daily transaction log backup schedule to
your backup set)

Set the encryption algorithm, encryption mode and encrypting key for this backup set

[ Encryption Setting
Pleaze setup the encryption setting of the Backup Set

[~ Do MOT use encryption.

Algarithrm: |Twaofish +

Mode:
i+ CBC (Cipher Block Chaining)

~ ECE (Electranic CookBook)

Encrypting Key: |

Confirm Encrypting Key: |

= Previous | Mext = Cancel

(Hint: For maximum security, please select AES (Advanced Encryption Standard) Algorithm,
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CBC (Cipher Block Chaining) mode and use an encrypting key with more than 8 characters.)

iii.  Run Backup

a. Select the backup set you want to run on the left panel and press the [Start Backup] button

)

b.  Select the backup type (e.g. Database, Log Files) you would like to perform

Backup

s

" Log Files

ks | Cancel |

C.

Select [Off-site Backup Server] to start backing up your files to an Offsite Backup Server and
press the [OK] button

~ Local Hard Disk (Seed Load Utility)

Startthe backup for [MSExchangeBackupSet-1] ?

Ok | Cancel |

d.  You should get something similar to the screen shot below.

B &hsay Online Backup Manager

: =l01x]
Backup Set  Backup  View
Fn
@ Backup Contraller Q,( (#] Backup Set- MSExchangeBackupSet-1
EEjues‘arPrnﬂle Backup Set
Backup Source Mame: MSExchangeBackupSet-1
i Backup Schedule Twpe:  Microsoft Exchange Semer Backup
[ command Line Tool [T
L setting
L. & Encryption
Log Table (MSExchangeBackupSet-1)
Typel Log Time
@ Start [2004/01/31 13:53:47] -
@ Start running pre-commands [2004i01/31 13:53:47)
& Finished running pre-commands [2004/01/31 13:53:47]
@ Using Tempaorary Cirectary - FABackup\MSExchangel1071124 [2004/01/31 13:53:47]
@ Start Microsoft Exchange backup ... [2004/01/31 13:53:47]
@ [Star] Exchange Server - "WIN20008VR" [2004/01/31 13:53:47]
@ [Starl] Service - "Microsoft Infarmation Store” [2004/01/31 13:53:47]
@ [Star] Storage Group - "First Storage Group” [2004/01/31 13:53:47]
@ [Star] Database - "Mailbox Store (IN2000SVR)" [2004/01/31 13:53:47]
@ Backing up ‘EdProgram Files\Exchsrimdbdatayarivi.edh' .. [2004i01/31 13:53:47)
@ Backing up ‘EXProgram FilesiExchsrmmdbdatatprivl stm’ [2004/01/31 13:53:49]
@ [End] Database [2004/01/31 13:53:51]
@ [Star] Database - "Public Folder Store (MM 2000SVR)" [2004/01/31 13:53:51]
@ Backing up ‘EProgram FilesiExchsrmmdbdataipubi edb’ [2004/01/31 13:53:51]
@ Backing up ‘EXProgram FilesiExchsrmmdbdataipubt . stm’ [2004/01/31 13:54:19]
3 [End] Database [2004/01/31 13:54:22]
@ [Start] Backing up logfiles .. [2004i01/31 13:54:22)
@ Backing up ‘EXProgram FilesiExchsrmmdbdatatE000008, [2004/01/31 13:54:23] LI
Batkup |ﬂ|
| Backing up ‘EXProgram FilesiExchsnSG2acct.stm' ... ‘Quuta iRemaining [ Total) 48.06G [ 506G ‘Last Backup: 2004-01-31 10042

12.4 How to restore Microsoft Exchange Server

Please follow the instructions below to restore Microsoft Exchange Server 2000 / 2003 from an Offsite Backup
Server.

i. Prepare the system for your Exchange Server (if required)

Install the original version of Windows and Exchange Server (with the same level of service pack
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installed as in the original system) back to your computer

ii. Restore Windows Active Directory (if required)

If you have re-installed Windows, please download the Windows System State backup file, named
[SystemState.bkf], from Offsite Backup Server and then use [NTBackup.exe] to restore your
Windows System State to its backup time from the backup file by following the instructions below:

a. Run [NTBackup.exe] from [Start] -> [Run]
b. Press the [Restore Wizard] button and then press the [Next] button

C. Press the [Import] button and use the [Browse] button to select the backup file
[SystemState.bkf] downloaded

d. Select the checkbox next to the description that matches your backup file
e. Press the [Next] button and then the [Finish] button

iii.  Install OBM (if required)

Please refer to the [Installation] section for information on how to install OBM onto your computer.
iv. Startup the [Microsoft Information Store] services from Windows Services
v. Restore exchange database(s) from backup:

a. Download the database backup files to be restored from the Offsite Backup Server (or find
the cached copy available in the temporary directory defined in your backup set) and save
them to your hard disk (please make sure the directory structure is the same as it appears
on the browser), namely:

->[C:]

-->[backup]

---->[ABC]

------ >[Microsoft Information Store]
________ >[First Storage Group]
__________ >[Mailbox Store(ABC)]
_______________ >Privl.edb
_______________ >Privl.stm

__________ >[Public Folder Store(ABC)]
_______________ >Publ.edb
_______________ >Publ.stm

__________ >E0000001.log

b. If the database to be restored exists on your computer already, please dismount it from the
services using [Start] -> [Program] -> [Microsoft Exchange] -> [System Manager]

c. Use [ExchangeRestore.exe] from the [bin] directory under the installation directory of OBM
(e.g. C:\Program Files\OBM\bin\ExchangeRestore.exe) to restore the exchange database(s).

Simply run [ExchangeRestore.exe] to print the usage

ExchangeRestore.exe Usage:
C:\ Program Fi | es\ OBM bi n> ExchangeRest or e. exe

M crosoft Exchange Server 2000/ 2003 Backup Recovery Uility

Usage:
ExchangeRest ore DI R=path SERVER=server TEMP=tenpDir [ SERVI CE=servi ce [ STORAGE=st
orage [ DATABASE=dat abase]]]

DR Directory containing all backup files

SERVER Name of Exchange Server to be restored

TEMP Tenporary directory to be used during restore
Pl ease specific a path with plenty of free space

SERVI CE  Nane of Exchange Service to be restored. It nust be either
"Mcrosoft Information Store", "Mcrosoft Key Managenment Service"
or "Mcrosoft Site Replication Service"

STORAGE Nane of storage group to be restored

DATABASE Nare of database to be restored
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Exanpl es:
1. To restore an exchange server:
ExchangeRestore DI R="C:\ Backup" SERVER="ExchangeServer" TEMP="C:\ Tenp"

2. To restore the information store:
ExchangeRestore DI R="C:\ Backup" SERVER="ExchangeServer" TEMP="C:\ Tenp"
SERVI CE="M crosoft Information Store"

3. To restore an exchange storage group:
ExchangeRestore DI R="C:\ Backup" SERVER="ExchangeServer" TEMP="C:\ Tenp"
SERVI CE="M crosoft Information Store" STORAGE="StorageG oupl"

4. To restore an exchange database:
ExchangeRestore DI R="C:\ Backup" SERVER="ExchangeServer" TEMP="C:\ Tenp"
SERVI CE="M crosoft Information Store" STORAGE="StorageG oupl"
DATABASE=" Dat abasel"

wher e
" C:\ Backup” is the directory containing all backup files
"ExchangeSer ver" is the server nane of an exchange server
"C:\ Temp" is the tenporary directory to be used
" St or ageG oup1" is the nane of a storage group
" Dat abasel” is the nane of a database

d. (Example 1) To restore all databases from backup available in [F:\Backup] to an exchange
server named [WIN2000OSVR] using the temporary directory [F:\Temp], you can use this
command:

E:\Program Files\OBM\bin> ExchangeRestore DIR="F:\Backup" TEMP="F:\Temp"
SERVER="WIN2000SVR"

Exchange Server Recovery Example:

E:\ Program Fi | es\ OBM bi n> ExchangeRestore DI R="F:\Backup" TEMP="F:\ Tenp"
SERVER="W N2000SVR"

M crosoft Exchange Server 2000/2003 Backup Recovery Utility

[Start] Exchange Server - 'W N2000SVR
[Start] Service - 'Mcrosoft Information Store'
[Start] Storage G oup - 'First Storage G oup'

[Start] Database - ' Mailbox Store (WN2000SVR)'

Restoring file 'E\Program Fil es\ Exchsrvr\ ndbdata\ priv1l. edb'
Restoring file ' E:\Program Fil es\ Exchsrvr\ndbdat a\ priv1. stni

[ End] Database - ' Mailbox Store (W N2000SVR)'

[Start] Database - 'Public Fol der Store (WN2000SVR)'
Restoring file 'E\Program Fil es\ Exchsrvr\ ndbdat a\ publ. edb’
Restoring file ' E:\Program Fil es\ Exchsrvr\ndbdat a\ publ. st ni

[ End] Database - 'Public Folder Store (W N2000SVR)'

[Start] Restoring transaction log - 'First Storage G oup'
Restoring Log File 'F:\Tenp\restore.tnp\First Storage G oup\E00000B3. | og'
Restoring Log File 'F:\Tenp\restore.tnp\First Storage G oup\E00000B4. 1 og'

[End] Restoring transaction log - 'First Storage G oup'

[Start] Applying transaction log ...

[End] Applying transaction |og

[End] Storage Group - 'First Storage G oup'
[Start] Storage G oup - 'SQ&'

[Start] Database - 'acct'

Restoring file ' E:\Program Fil es\ Exchsrvr\ S&\ acct . edb’
Restoring file ' E:\Program Fil es\ Exchsrvr\ S&\ acct. stni

[ End] Database - 'acct'

[Start] Restoring transaction log - 'S&'

Restoring Log File 'F:\Tenp\restore.tnp\ SG\ E0100072. | og'
Restoring Log File 'F:\Tenp\restore.tnp\SG\ E0100073. | og'

[End] Restoring transaction log - 'S&'

[Start] Applying transaction log ...

[End] Applying transaction |og

[End] Storage G oup - 'S&'

[ End] Exchange Server - 'WN2000SVR

E: \ Progr am Fi | es\ OBM bi n>

e. (Example 2) To restore the database named [mail] in storage group [SG5] from backup
available in [F:\Backup] to an exchange server named [WIN2000SVR] using the temporary
directory [F:\Temp], you can use this command:

E:\Program Files\OBM\bin> ExchangeRestore DIR="F:\Backup" TEMP="F:\Temp"
SERVER="WIN2000SVR" SERVICE="Microsoft Information Store" STORAGE="SG5"
DATABASE="maill"

Exchange Server Recovery Example:

E:\ Program Fi | es\ OBM bi n> ExchangeRestore DI R="F:\Backup" TEMP="F:\ Tenp"
SERVER="W N2000SVR"' SERVI CE="M crosoft Information Store" STORAGE="SG5"
DATABASE=" i | "

M crosoft Exchange Server 2000/2003 Backup Recovery Utility

[Start] Storage Goup - 'SG5'
[Start] Database - 'mail’
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Restoring file 'E:\Program Fil es\ Exchsrvr\SG\ mai | . edb" ...
Restoring file ' E:\Program Fil es\ Exchsrvr\SG\mail.stnm ...

[ End] Database - 'nail’

[Start] Restoring transaction |log - 'SG5'

Restoring Log File 'F:\Tenp\restore.tnp\ SG5\ E0300012. | 0g" ...
Restoring Log File 'F:\Tenp\restore.tnp\SG\ E0300013. | og'
[End] Restoring transaction |log - 'SG5'

[Start] Applying transaction log ...

[ End] Applying transaction |og

[End] Storage G oup - 'SG5'

E:\ Program Fi | es\ OBM bi n>
f. Repeat the same procedure for each database to be restored to the Exchange Server.

g. You can use [Start] -> [Program] -> [Administrative Tools] -> [Event Viewer] to check if
there are any errors generated from the exchange databases restoring activities.

vi. However, if ExchangeRestore.exe still cannot mount the restored files and returns with strange
errors, e.g. bad signature, or null errors. Then Exchange server might have incorrectly spooled the
backup files in the first place. Please try to mount the restored database and log files manually by
the following instructions:

a. In MS Exchange System Manager, dismount both the Mailbox Store and Public Folder Store
from the server.

b.  Copy all the restored database files to the MDBDATA folder (By default, the MDBDATA folder
is located under C:\Program Files\Excgsrvr\)

Mailbox Store:
- privl.edb
- privl.stm
Public Folder Store:
- publ.edb
- publ.stm

C. Run "eseutil /r" to apply the transaction log files to bring the database to a consistent state,
e.g.:

C:\ Program Fi | es\ Exchsrvr\ NDBDATA> ..\bin\eseutil /r e00

The above command will try to bring all the databases handled by the transaction log files
starting with “e00” located in “C:\Program Files\Exchsrvr\MDBDATA” into clean shutdown
state.

d. Run "eseutil /p" to repair the database files, e.g.:

Program Fi | es\ Exchsrvr\ MDBDATA> . .\bin\eseutil /p privl.edb

C\
C:\ Program Fi | es\ Exchsrvr\ NDBDATA> ..\bin\eseutil /p publ.edb

e. Mount both Mailbox Store and Public Folder Store to the Server through the MS Exchange
System Manager.

vii. Completed
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13 Backup/Restore Windows System State

This chapter will describe in details how to use OBM to backup Windows System State and how you can restore
your Windows System State from backup.

13.1 Requirements
i. Microsoft Windows XP Professional / 2003
ii. OBM must be installed onto the computer containing the system state you want to backup

iii.  Windows system state will be backed up to a temporary file before it is sent to OBS. Please make
sure you have sufficient space on your computer to store the temporary file when you run the
backup job.

13.2 Overview

OBM wiill backup your Microsoft Exchange Server by taking the following steps:
i. Run all Pre-Commands of this backup set
ii. Windows System State will be backed up to a temporary directory specified in its backup set
iii.  Run all Post-Commands of this backup set

iv. Upload the Windows System State backup files from the temporary directory to an Offsite Backup
Server

V. Remove the Windows System State temporary backup files from the temporary directory if
[Setting] -> [Temporary Directory for storing backup files] is enabled
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13.3 How to backup Windows System State

Please follow the instructions below to backup Windows System State using OBM:
i. Open OBM

Right click OBM icon available in the system tray and choose [Open]

Backup L4
Backup and Logoff 4
Backup and Restart 4
Backup and Shutdown P

Help
Btop Eunning Backup  #

Exit

[ 14:46
ii. Create a backup set

a. From the Menu, Choose [Backup Set] -> [New] -> [System State Backup Set]

-lox
Backup Set Backup Restore Tools Wiew Help

r_x Rermve 4 E} Yy State Back ;
15 save Setting |4 Lotus Backup Set
(€] Exit |# M3 Exchange Backup Set

f‘ S Exchange Mail Level Backup Set
|7 MS SGL Server Backup Set

|42 WivS QL Backup Set

[&) Oracle Datahase Backup Set

tication for Windows

User Mame:
Password:

Fropeties |

¥ Run scheduled backup on this computer

E| Log Tahle {FileBackupSet-1) =
Type I Log Time
& Backup | &) Restore| (@) Log
|We|come to Online Backup Manager! |Quota (Remaining [ Total): 9.86G f 10G |Last Backup: 2007-01-1612:22

b.  Enter a name for your backup set
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Add new System State Backup Set
~Backup Set

Please type a name for this Backup Set.

Marne: |SystemstateBackupSet-1|

10 1169005343437
Type: Systern State Backup

Cancel |

= Erevious | Mext =

Use the [Change] button to configure the [Temporary directory for storing backup files]
setting and check the [Remove temporary files after backup] if you want temporary files to

be removed automatically after backup

Add new System State Backup Set
~Backup Source

X

E- 5§ My Computer
. System State

~Tempoarary directary for storing backup files

|C:1Elackup15ystemstate Change |

¥ Remaove termparary files after hackup

Cancel |

= Previous | Mext =

Enter a temporary directory for storing the backup files before they are sent to an Offsite

Backup Server

Set the backup schedule for this backup set
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Add new System State Backup Set |
~Backup Schedule
Please schedule the hackup time.

Add Remaove | Properies |
Cancel | = Previous | Mext =

f. Set the encryption algorithm, encryption mode and encrypting key for this backup set

Add new System State Backup Set ﬂ

~Encryption Setting
Please setup the encryption setting ofthe Backup Set.

" Default {Use Login Password as Encrypting Key)
& Elistorm

[~ Do MOT use encryption.

Algarithm: IAES 'I

Mode:
+ CEC (Cipher Block Chaining)

" ECEB (Electranic CookBook)

Encrypting Key: |

Confitm Encrypting Key: |

Cancel | = Previous Mext =

(Hint: For maximum security, please select AES (Advanced Encryption Standard) Algorithm,
CBC (Cipher Block Chaining) mode and use an encrypting key with more than 8 characters.)

ili.  Run Backup

a. Select the backup set you want to run on the left panel and press the [Start Backup] button
)

b.  Select [Off-site Backup Server] to start backing up your files to an Offsite Backup Server and
press the [OK] button
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Backup to

& DfFsite Backup Serv

¢~ Local Hard Disk (Seed Load Utility)

Startthe backup for [MSExchangeBackupSet-1] 7

oK | Cancel |

C. You should get something similar to the screen shot below.

] ne Backup Manage —[o] x|
Backup Set Backup Wiew
i)
@ Backup Contraller Qﬁ (#] Backup Set- MSExchangeBackupSet-1
Eu@iarllmﬂle Backup Set
i Backup Source MName: MSExchangeBackupSet1
fi Backup Schadule Twpe:  Microsoft Exchange Semer Backup
[P command Line Taal F—
L setting
5 Encryption
Log Table (MSExchangeBackupSet-1)
Typel Log Time
@ Start [2004/01/31 13:53:47] -
@ Start running pre-commands [2004i01/31 13:53:47)
@ Finished running pre-commands [2004/01/31 13:53:47]
@ Using Tempaorary Cirectary - FABackup\MSExchangel1071124 [2004/01/31 13:53:47]
@ Start Microsoft Exchange backup .. [2004i01/31 13:53:47)
@ [Star] Exchange Server - "WIN20008VR" [2004/01/31 13:53:47]
@ [Star] Service - "Microsoft Infarmation Store” [2004/01/31 13:53:47]
@ [Star] Storage Group - "First Storage Group” [2004/01/31 13:53:47]
@ [Star] Database - "Mailbox Store (IN2000SVR)" [2004/01/31 13:53:47]
@ Backing up ‘EnProgram FilesiExchsrimdbdataprivl edb’ [2004/01/31 13:53:47]
@ Backing up ‘EXProgram FilesiExchsrmmdbdatatprivl stm’ [2004/01/31 13:53:49]
@ [End] Database [2004/01/31 13:53:51]
@ [Star] Database - "Public Folder Store (MM 2000SVR)" [2004/01/31 13:53:51]
@ Backing up ‘EProgram FilesiExchsrmmdbdataipub edb’ [2004/01/31 13:53:51]
@ Backing up ‘EXProgram FilesiExchsrmmdbdataipubt . stm’ [2004/01/31 13:54:19]
@ [End] Database [2004/01/31 13:54:22]
@ [Starl] Backing up log files . [2004/01/31 13:54:22]
@ Backing up ‘EXProgram FilesiExchsrmmdbdatatE000008, [2004/01/31 13:54:23] LI
Batkup |ﬂ|
| Backing up ‘EXProgram FilesiExchsnSG2acct.stm' ... ‘Quuta iRemaining [ Total) 48.06G [ 506G ‘Last Backup: 2004-01-31 10042

13.4 How to restore Windows System State

Please follow the instructions below to restore Windows System State from an Offsite Backup Server.
i. Install OBM (if required)
Please refer to the [Installation] section for information on how to install OBM onto your computer.
ii. Restore the Windows System State Backup File (i.e. SystemState.bkf) from the backup server
iii.

Use [NTBackup.exe] to restore your Windows System State to its backup time from the backup file
by following the instructions below:

a. Run [NTBackup.exe] from [Start] -> [Run]
b. Press the [Restore Wizard] button and then press the [Next] button

c. Press the [Import] button and use the [Browse] button to select the backup file
[SystemState.bkf] downloaded

d. Select the checkbox next to the description that matches your backup file
e. Press the [Next] button and then the [Finish] button

iv. Completed
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14 Backup/Restore Individual Brick Level Backup for Microsoft

Exchange Server

14.1 Requirements

i. Microsoft Exchange Server 2000 with Services Pack 3 and post-SP3 update rollup installed. Please
refer to http://www.microsoft.com/exchange/ for more information.
or
Microsoft Exchange Server 2003.

ii. OBM must be installed onto the computer running Microsoft Exchange Server 2000 / 2003.

14.2 Overview

Brick Level Backup for Microsoft Exchange Server is not designed to fully protect an Exchange server, but to
facilitate easy backup and fast restore of individual emails, contacts, calendars, tasks etc. The brick level restore
cannot fully recover the Information Store after a disaster. If used, a brick level backup must be utilized in
conjunction with full Information Store Backup, in order to fully protect the exchange server.

14.3 Granting Privileges

Brick Level Backup requires “Full Mailbox Access” permission for the user running OBM. Normally, OBM can acquire
the permission on it's own but if you encounter ‘Access Denied’ errors you need to manually grant access
privileges to the user running OBM using one of the following instructions below:

For one specific mailbox

Use the following procedure to grant access to an Exchange 2000 or an Exchange 2003 mailbox:
1 Start Active Directory Users and Computers.
2  On the View menu, ensure that the Advanced Features check box is selected.
3 Right-click the user whose mailbox you want to give permissions to and choose Properties.
4 On the Exchange Advanced tab, click Mailbox Rights.

5 Notice that the Domain Admins and Enterprise Admins have both been given Deny access to Full Mailbox
access.

6 Click Add, click the user or group who you want to have access to this mailbox, and then click OK.
7  Be sure that the user or group is selected in the Name box.

8 In the Permissions list, click Allow next to Full Mailbox Access, and then click OK.

9 Click Ok all the way out.

10 Restart the Microsoft Exchange Information Store.

For mailboxes located within a specific mailbox store

Use the following procedure to grant access to an Exchange 2000 or an Exchange 2003 mailbox found on a
specific mailbox store:

1 Start Exchange System Manager.

2  Drill down to your server object within the appropriate Administrative Group. Expand the server object

Fortikup is a trademark of Micso Srl Page 108 of 135 (April 24, 2008)


http://www.microsoft.com/exchange/

Forti Up Fortikup OBS V5.2

micso fortified backup User’'s Guide

and find the required mailbox store within the appropriate Storage Group. Right-click it and choose
Properties.

3 In the Properties window go to the Security tab.

4 Click Add, click the user or group who you want to have access to the mailboxes, and then click OK.
5 Be sure that the user or group is selected in the Name box.

6 In the Permissions list, click Allow next to Full Control, and then click OK.

7  Click 'Apply' and 'OK'

8 Restart the Microsoft Exchange Information Store.

For mailboxes located within a specific server

1 Start Exchange System Manager.

2  Drill down to your server object within the appropriate Administrative Group. Right-click it and choose
Properties.

3 In the Properties window go to the Security tab.

4  Click Add, click the user or group who you want to have access to the mailboxes, and then click OK.
5 Be sure that the user or group is selected in the Name box.

6 In the Permissions list, click Allow next to Full Control, and then click OK.

7  Click Ok all the way out.

8 Restart the Microsoft Exchange Information Store.
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14.4 How to backup Individual Brick Level Backup

Please follow the instructions below to backup all individual items within your Microsoft Exchange Server 2000 /
2003 using OBM:

i. Open OBM

Right click OBM icon available in the system tray and choose [Open]

Backup 4
Backup and Logoff 4
Backup and Restart 4
Backup and Shutdown P

Help
Stop Bunning Backop ¥

Exit

[ 1446
ii. Create a backup set

a. From the Menu, Choose [Backup Set] -> [New] -> [MS Exchange Mail Level Backup Set]

ETE
Backup Set Backup Restore Tools View Help
| File Backup Get

SRemoe v () System State Backup Set

eBackupsetl

|5 5ave Setting | Lotus Backup Set
T8 Bt | MS Exchange Backup Set
n l;upSeM
= 894083
|0 M5 SQL Server Backup Set kup

|42) MySQL Backup Set
|&@! Oracle Datahase Backup Set

rees Authentication for Windows——

User Name:
Password:

Properties

I Run scheduled backup on this computer

Log Tahle (FileBackupSet-1)

Tyme | Lag Time
& Backup | & Restore| (@ Log
|We\cume to Online Backup Manager! \Quula (Remaining / Total): 9.86G /106G |Last Backup: 2007-01-19 16:59

b.  Enter a name for your backup set
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Add new Ms Exchange Backup Set
rBackup Set

Flease type a name far this Backup Set.

Mame |MSExMai\Leve\EackupSet—1
|] 1169197729785
Type: MS Exchange Mail Level Backup

Cancel |

= Fresiols | Mext =

C. Select the email account(s) to backup

Add new MS Exchange Backup Set

rBackup Saurce

Flease select Database to be backed up.

MName |
- 5 S0LAAINZ000
[ Mailbox Store
[0 59 Public Folder Store

From i To |

Cancel

= Previous | Mext = |

Add new M5 Exchange Backup Set il
Backup Source

Please select Database to be backed up.

Marmea |
= [E S0LAYINZO00

-2 Mailbox Store
D%ADM\NISTRATOR
251 JANE.DOE
125 JOHN.SMITH
D@ SYSTEMMAILBOME
[ 59 Public Folder Store

FromiTo |

Cancel

= Previous Mext =
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Add new MS Exchange Backup Set 1[

rBackup Source

Please select Database to he hacked up.

Mame | From{ Ta I
E- 5 S0LwIN2000
-2 Mailoox Stare
15t ADMINISTRATOR
- 84 JANE.DOE
A calendar
[ 184 Contacts
[ & Deleted ltams
[ 4 Dratts

|»

125 JOHN SMITH =l

Cancel = Previous | Mext = |

You can drill down to select individual items.

d. Set the backup schedule

Add new M5 Exchange Backup Set il
rBackup Schedule
Please schedule the backup time

Add Remave | Froperties |
Cancel = Previous | Mext = |
BackupSchedule-1 Properties x|
Mame: IEackupSchedule-1

~Backup

MS Exchange Mailbox

rType

= Daily  weekly O Manthly O Custom

~Day

Backup everyday

- Start
Start Tirme (hh:mm): |21 vI:IDD 'l
~Stop

= Stop on completion (Full Backups

' Stop aﬂerIB Hours)

Ok | Cancel |

e. Set the encryption algorithm, encryption mode and encrypting key for this backup set
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Add new MS Exchange Backup Set

~Encryption Setting
Please setup the encryption setting ofthe Backup Set

" Default (Use Login Passward as Encrypting Key)

& Custom

[~ Do NOT use encryption

Algarithm: IAES -

Mode:
& CEC (Cipher Block Chaining)

" ECB (Electronic CookBook

Encrypting Key: I

Confirm Encrypting Key: |

Cancel = Previous Mext =

(Hint: For maximum security, please select AES (Advanced Encryption Standard) Algorithm,
CBC (Cipher Block Chaining) mode and use an encrypting key with more than 8 characters.)

iii.  Run Backup

a.

Select the backup set you want to run on the left panel and press the [Start Backup] button

)

Select [Offsite Backup Server] to start backing up your files to an Offsite Backup Server and

press the [OK] button

Confirm Backup Stark 5'

Backupio

= Offsite Backup Senver
& Local Hard Disk (Local Copy)

© Local Hard Disk (Seed Load Ulility)

Start the backup for MSExMailLevelBackupSet-1] 7

0K Cancel

You should get something similar to the screen shot below.
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Backup Manager

Backup Set Backup Restore Tools Wiew Help

=181

15| save Setting " Start Backup [l Siop Backup |

;.'} Backup Controller ;? i“ Backup Set- MSExMailLevelBackupSet-1

Backup Set

Mame: MSExMailLevelBackupSet1

D 1168147729785

Type:  MS Exchange Mail Level Backup

E;‘.UsevF‘mﬂ\e
T

19 Backup Source
S Backup Schedule
Command Line Tool

Finished running pre-commands

Reading backup source frarm hard disk.

Downloading server file list..

Downloading server file list.. Completed

Reading backup source from hard disk... Completed

Getting all files which have heen added

Getting all files which have been added... Completed

Getting all files which have heen deleted..

Getting all files which have heen deleted... Completed
Mumber Of E-mail Account Remain="9"

Exist E-mail Account:

JAME.DOE

Total New E-mail Account= 1

JAME.DOE

Total Deleted E-mail Account=0

Total Mew Mail = 6

Total Deleted Mail=0

[1/18] [New Directory] Uploading "SOLAWINZO00"

[219] [New Directory] Uploading "SOL-WINZ00MMailbox Store”
[31 8] [New Directory] Uploading "SOL-WINZ000WMailbox StorelANE DOE"
[4r19] [New Directory] Uploading "SOL-WINZ000Mailbox StorelANE.DOEVCalendar

[719] [New Mail] Uploading 100% of "SOL-WINZ000WMailbox StoreWANE. DOEWCalendaniaaa”
[8/19] [New Directory] Uploading "SOL-WINZ2000WMailbox StorelANE DOEVWC ontacts”
16/ G Ml asar W31 1 Il s i 4 ARG of1 Q1 LR TN STl Sera) TARE DOEICAntoreltost '

i1 setting {#] Log Tahle (MSExMailLevelBackupSet-1)

% Emwm‘unpmic Tyne | Log | Time [

0 Lzmlralgalclku v Start [Windows 2000 (s0lwin2000), OEM 5.2.1.0] [2007/01/18 17:09:55] =

= P Startrunning pre-commands [2007/071/18 17:09:55]
Local Copy

[51 9] [New Mail]l Uploading 100% of "SOL-WIN2000Mailbox StorelANE. DOEWC alendarttest appointment”
[6/18] [Mew Mail] Uploading 100% of "SOL-WIN2000Mailbox StoreldANE DOEICalendarttest appointment.

[2007/01/19 17:09:55]
[2007/01/18 17:09:55]
[2007/01/1917.09:55]
[2007/01/1817:09:55]
[2007/01/18 17:09:56]
[2007/01/19 17 .09:56]
[2007/01/18 17:09:56]
[2007/01/1917.09:57]
[2007/01/1917.09:57]
[2007/01/18 17:09:57]
[2007/01/1917.09:57]
[2007/01/1817.09:57]
[2007/01/18 17:09:57]
[2007/01/1917.09:57]
[2007/01/18 17:08:57]
[2007/01/1917.09:57]
[2007/01/1917.09:57]
[2007/01/18 17:09:58]
[2007/01/1917.09:58]
[2007/01/18 17:09:58]
[2007/01/19 17.09:58]
[2007/01/19 17:09:59]
[2007/01/18 17:09:59]
[2007/01/1917:10:00]
[2007/01/1917:10:00]
PTG MG 47 A0

=

| & Backup | &) Restore ] [ Log

|Eackup Completed Successfully

14.5 How to restore Individual Brick Level Backup

\@unla {Remaining / Total): 9.86G /110G |LastE’aEkup 2007-01-18 16:58

Please follow the instructions below to restore individual emails, contacts, calendars, tasks etc. from an Offsite
Backup Server back into your exchange server. Please note that individual brick level can only be restored using

the OBM client.

Open OBM

Right click OBM icon available in the system tray and choose [Open]

Backup L4
Backup and Logoff 4
Backup and Restart 4
Backup and Shutdown P

Help
Btop Eunning Backup  #

Exit

T 146

Choose the [Restore] tab and select the items you want to restore
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Online Backup Manager |8 x|
Backup Set Backup Restore Tools View Help

H Save Setting " Restore Files ‘

Y Restore Controller 73 Restare Source (MSExMallLevelBackupSet-1)

—1. MSExMailLevelBackupSetT | & showiiles after Job |znnrrn149 (17:08:55 x| ¢ Show allles

?ﬂ Backup Server
== soL-wiN2000
- Mailbox Stare
5[50 J_NE.DOE
E-OEH calendar
Subject test appointment (Received: Tue 8/1/2006 9:00 AM Size: 6k
Subject test appointment2 (Received: Tue 8/1/2008 11:00 AM Size: Bk
Subject aaa (Received: Tue 8/1/2006 12:00 PM Size: Bk)
-84 Contacts
LA test (Date Modified: Fri 1/19/2007 5:09 PM Size: 5k)
% Deleted ltems
(A Drafts
03 Inbox
L= Subject testing email (Received: Tue /12006 240 PM Size: 10k
1 &l Journal
L] notes
= Outhox
£l Sent terns
0=

& Backup ) Restore | (6 Log

\Eackup Completed Successully |Quata (Remaining / Total): 3.86G [ 10G |La5! Backup: 2007-01-19 16:59

iii.  Press the [Restore Files] button

trn Restore Files |

Backup Set: MSExMailLevelBackupSet-1 (Microsoft Exchange Mail (MAPIY)

Time | Log |

Estimated Total Restare Time:
Estimated Restore Time:
Saving File Tao:

Restaring Speed:

Close | Start | Stop |

iv. Press [Start]
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tn Restore Files |

Backup Set: MSExMailLevelBackupSet-1 (Microsoft Exchange Mail (MAP)

Time | Log |

2007-01-18 17:16:50 Start

2007-01-191716:50 Downloading restore file list ..

2007-01-191716:50 Same mail "SOL-WIN2000WMailbox StorelJANE.DOBEWCalendantest appoi..
2007-01-191716:50 Same mail "SOL-WIN2000WMailbox StorelJANE.DOBEWCalendantest appoi..
2007-01-1917:16:50 Same mail "SOL-WIN2000WMailbox StorelJANE.DOEWC alendanaas” exist..
2007-01-1917:16:50 Same mail "SOL-WIN2000WMailbox StorelJANE.DOEWC ontactsitest " exist..
2007-01-191716:50 Same mail "SOL-WIN2000Mailbox StorelJANE. DOEUnboxMtesting email” ..
2007-01-1917:16:50 End

Estimated Total Restore Time: 0 sec {Total -39.31k ytes - 0 bytes restored)

Estimated Restore Time: 0 =ec {Total 0 bytes - 0 bytes restored)
Saving File To:
Restaring Speed: 0 bytesisecond
Close | Start | Stop |
|End

V. Restore complete. Please logon to exchange to get the restored items.
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15 Backup/Restore MySQL Server

This chapter will describe in details how to use OBM to backup your MySQL server and how you can restore your
MySQL server from the database backup files.

15.1 Requirements

i. OBM must be installed onto the computer running MySQL server.

ii. Data from MySQL server will be backed up to a temporary directory before they are sent to Offsite
Backup Server. Please make sure you have sufficient space on your computer to store these data
when you run the backup job.

iii. There must be a MySQL account can be used to connect from localhost.
Add two new MySQL accounts for Backup Manager
mysql> GRANT ALL PRIVILEGES ON *.* TO 'root'@'localhost’
-> IDENTIFIED BY 'some_pass’;
mysql> GRANT ALL PRIVILEGES ON *.* TO ‘root'@'localhost.localdomain’
-> IDENTIFIED BY 'some_pass’;
mysql> FLUSH PRIVILEGES;

They are superuser accounts with full privileges to do anything with a password of some_pass.

15.2 Overview

OBM wiill backup your MySQL server by taking the following steps:
i. Run all Pre-Commands of this backup set

ii. All database(s) (either local or external) selected are backed up to a temporary directory specified
in its backup set

iii.  Run all Post-Commands of this backup set
iv. Upload all backup files from the temporary directory to an Offsite Backup Server

V. Remove temporary files from the temporary directory if [Setting] -> [Temporary Directory for
storing backup files] is enabled
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15.3 How to backup MySQL server on Windows
Please follow the instructions below to backup your MySQL server using OBM:

i. Open OBM

Right click OBM icon available in the system tray and choose [Open]

Backup L4
Backup and Logoff 4
Backup and Restart 4
Backup and Shutdown P

Help
Btop Eunning Backup  #

Exit

T 146

ii. From the Menu, Choose [Backup Set] -> [New] -> [MySQL Backup Set]
Create a backup set

a. From the Menu, Choose [Backup Set] -> [New] -> [MySQL Backup Set]

=10l
@ Backup View
File Backup Set
Remove b Latus Backup Sat bt~ MSSQLBackupSetl
Save MS Exchange Backup Set
Exit MS SGQL Server Backup Set
- SaLBackupget]
......... IL Backup Set
MSSaL rosoft SGAL Server Backup
X Oracle Database Backup Set
(3 MEExct B AL Server
BackupSetT L o
-2 MySGLBackunSet 1 SCIE en
i [y Backup Source Password
figh Backup Schedule
L[] command Line Toal Pragerties
- U Setting
L &) Encryption
Log Tahle (MSSQLBackupSet-1) @
Type | Log Time
Backup | Log
|We|nnmem COnline Backup Manager! |Qunta (Remaining / Total): 48.9G /500G  Last Backup: 2004-07-22 14:32

b.  Enter a name for your backup set

Backup Set
Flease type a name for this Backup Set.

Mame: |MySOLBackupSet-1
Type: MySQL Backup
MySaL

User Name: root

Password

Hostlocalhost

Port [3306

IC.\mysqI\mn Change

"F'ath to mysgldump

= Preyious

Cancel
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C. Enter the root password, the MySQL server TCP/IP port number and the path to MySQL
backup utility (mysgldump)

d. Select the database(s) to be backup

rBackup Source
Flease select databases to be backed up

tmenagerie
mysgl
i test

r Temporary directory for storing hackup files

[ciBackupwysaL Change
= Previous Zancel

e. Enter a temporary directory for storing the backup files before they are sent to an Offsite
Backup Server, e.g. C:\Backup\MySQL

f. Set the backup schedule for Database Backup

~Backup Schedule
Please schedule the hackup time.

Add Remove | Properties |

Cancel

< Previous ’

g. Set the encryption algorithm, encryption mode and encrypting key for this backup set

rEncryption Setting
Flease setup the encryplion setting of the Backup Set.

I~ Do MOT use encryption

Algarithrm: IAES -

Made:
+ CBC (Cipher Block Chaining)

~ ECE (Electronic GookBook)

Encrypting Key: W

Canfirm Encrypting Key: r“““

= Previous Cancel

(Hint: For maximum security, please select AES (Advanced Encryption Standard) Algorithm,
CBC (Cipher Block Chaining) mode and use an encrypting key with more than 8 characters.)
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iii.  Run Backup

a.

Select the backup set you want to run on the left panel and press the [Start Backup] button

(9

Select [Off-site Backup Server] to start backing up your files to an Offsite Backup Server and
press the [OK] button

Backup to

& Off-site Backup Server

" Local Hard Disk (Seed Load Utility)

Start the backup for (MySQLBackupSet1] 7

Cancel |

You should get something similar to the screen

Backup Set  Backup  Wiew

shot below.

il

FO

) Backup Controller I3

(] Backup Set- MySQLBackupSet-1

[43 User Profile

(&] OracleBackupSet-1

(@] Lotus Notes

(@I MEsQLBackupSet1

(3] M3ExchangeBackupSet-1

)

E Backup Source
- igh Backup Schedule
[ Cammand Line Taal
L getting

L D) Encryption

- Backup Set

Name: MySGLBackupSet-1
Type:  MySGL Backup
MySQL

User Narme: root
Password: ==

Host localhost
Part: 3308

Path to my=sgldump
’VC\myaq\\hm

L b

]
Log Tahle (MySQLBackupSet-1) a
Type | Log Time |
@ Start [2004/07/22 16:47:01] -
[¢] Start running pre-commands (200407722 16:47:01]
a Finished running pre-commands (2004/07/22 16:47:01)
( Using Tempaorary Directory - 'C\BackupiMySQL 088760442718" [2004/07/2216:47:01]
@ [Star] Backing up database 'mysql'to 'mysal.sgl’ [2004/07/2216:47:01]
@ [End] [2004/07/22 16:47:01]
@ Start running post-commands 216:47:01] LI

Backup | Log

|Finished running postcommands

‘Quma (Rermaining f Totaly: 48.9G 71 500G |LaleIackup' 2004-07-2214:32

Fortikup is a trademark of Micso Srl

Page 120 of 135

(April 24, 2008)



micso fortified backup User’'s Guide

Forti Up Fortikup OBS V5.2

15.4 How to backup MySQL server on Linux (command line mode)

If you want to setup OBM to backup MySQL server running on Linux using command line mode, please do the
followings:

i. Create a backup account on OBS

ii. Logon to the web interface of OBS using the backup account created in the previous step (doesn’t
matter if it is not from the Linux server running the MySQL server to be backed up)

iii. Create a new backup set by pressing the [Backup Set] -> [Add] button

iv. Select the [Backup Set] -> [Type] -> [MySQL Database Server] radio button and press the
[Update] button (which can be found at the bottom of the page)

V. Setup all [Backup Set] -> [Database Backup Setting]

Settings Descriptions

MySQL Username (e.g A MySQL user account that has backup access to the

root) databases to be backed up (e.g. root). Please refer to
the [Requirements] section for details

MySQL Password Password of the MySQL user account being used

Host IP address / Hostname of the MySQL Server, e.g.
localhost

MySQL Connection TCP/IP port used to access the MySQL Server (default:

TCP/IP Port 3306)

Path to MySQL backup Full path to where mysqldump can be found (e.g.

utility (mysqldump) /usr/bin/mysqgldump)

Temporary Spooling A temporary directory to be used to store all MySQL

Directory database dump files before they are uploaded to the

backup server

Enable Delete Temp. File |Whether to delete the temporary MySQL database
dump files after they are uploaded to the backup server

vi. Setup the [Backup Set] -> [Backup Source] setting

> Add an “MySQL” entry to the [Backup Source] if you want to backup all databases under this
MySQL Server

> Add two entries, “MySQL/databasel” and “MySQL/database2”, to the [Backup Source] if you
want to backup both “databasel” and “database2” under this MySQL Server

(Please use “\” instead of “/” if the MySQL server to be backed up is running on Windows
instead of Linux)

vii. Setup the [Backup Set] -> [Backup Schedule] by pressing the [Add] link next the the “Backup
Schedule” sub-title

viii. Install OBM onto the Linux server running MySQL server (Please refer to the [2.1 Installation of
OBM] section for details. The command line mode installation instructions are available on the web
interface)

ix. Completed

If you have started up the OBM backup scheduler in the previous step, selected databases will be
backed up automatically at scheduled time
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15.5 How to restore MySQL server

Please follow the instructions below to restore MySQL server from an Offsite Backup Server.

i. Download the database backup files to be restored from the Offsite Backup Server

Please refer to the [5.3 Restoring file] section for information on how to download backup files
from Offsite Backup Server.

ii. Restore the database named [db_name] from the database backup file [db_name.sql]:

a. Connect to the MySQL server

(Windows) C:\> mysql
(Linux) [root@server ~]# mysql

b. Create the database to be restored
mysql> CREATE DATABASE IF NOT EXISTS db_name

c.Restore the database backup file back into the MySQL server

mysql> use db_name ;
mysql> source db_name.sql ;

If db_name.sqgl is not located in the current directory, please specify the full path to the
db_name.sql file in the command above.

iii. Repeat the same procedure for each database to be restored to the MySQL Server.

iv. Completed
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16 Email Reporting

Offsite Backup Server makes use of the email system to keep you informed with the status of your backup
activities. Please make sure your contact information within the backup system is correct to receive the reports

described in this chapter.

16.1 New User Report

When a new backup account is added to the backup server, a new user report will be delivered to the contact
email(s) of the new account. The New User Report contains the following information:

Sample Report

Welcome to Online Backup Services

Login Mame
1. Login to our homepage FPassword
Alias
2. Follow the "User's Guide" to start using our hackup Language
EERUE Contact

Backup Guota

Further Information: Backup Server

If further assistance is necessary, please refer to the FAQS

Genaerated at: Sat Jun 21 09:32:36 HKT 2003

Getting started: User Setting

MevAccount

spwd

s Mewy Testing Account Mame
rEnglish
LUSerENOU-COmPANY.Cam

1 50m

rhackup your-company.com

section.
Key Description
Login Name Login nhame
Password Password
Alias Alias
Language Preferred Language for your backup report
Contact Email Address that will be used to contact you
Backup Quota Backup quota
Backup Server |Backup server
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16.2 Forgot Password Report

If you have forgotten your password, you can use the [Forgot Password] feature available on the web interface to
have your password delivered to you through email. (Please refer to “Retrieve Forgotten Password” section in the
next chapter for more information on how to retrieve your forgot password report.) The Forgot Password Report

contains the following information:

Sample Report

Request for forgotten password

forthe lost password of this backup account, all registered  Alias
contacts of this particular account will receive a passwaord Langua
reminder amail. If none ofthe contact person has visited

Generated at: SatJun 21 09:47:14 HKT 2003

FAQS: User Setting

1. Why are you receiving this report? Lagin Name :MewAccount
YWhen a user visits the forgot password page and requests  Password Tpwd

s Mew Testing Account Mame
0e :English

I : i Contact LUSEer@EyOUr-COmpany.cam
the page above and you are receiving this email in errar,
please contact us.
2. What should you do after reading this email ?

Yoaur current passward is shown under the user setting.
You are suggested to change your password to a maore
easily remermhbered passwoard and delete this email to
avaid any third party gaining your passwoard.

Key Description

Login Name [Login name

Password Password

Alias Alias

Language Preferred Language for your backup report

Contact Email Address that will be used to contact you
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16.3 Backup Job Report

For each backup job you have run, a backup job report will be sent to you by email. This report contains a
summary for the backup job that was run and a full listing of all files being backed up by the backup job. The
backup summary report contains the following information:

Sample Backup Summary Report

Online Backup Job Report

Backup Job Summary

Backup Time @ 21-Jun-2003 09:57 - 21-Jun-2003 09:57
Status : Backup finished successfully
Mews Files™ =1 [8k]
Updated Files® 11 [8k]
Deleted Files* =1 [4k]
Moved Files™ 1 [ 3k]
* Unit= Mo, of Files [Total Size]

Afull listing of all backup files is available in the attached file.

FaQs:

1. Wiy are you receiving this report?
You are receiving this report because yvou are registered
as one ofthe contacts ofthis Online Backup account and
this particular account has performed a hackup job
recently.

2. What if you have exceeded your gquota?
Ifyaur recycle bin size is not empty, you can empty your
recycle hin to free up more space. Please contact us for
maore information on how to increase yvour storage quota.

Iffurther assistance is necessary, please referto the FAGS

Generated at: SatJun 21 10:00:05 HKT 2003

Login Mame sMewAccount

Alias s Mew Testing Account Mame
Language sEnglish

Contact TUSErEYOU-COmpAany.com

Backup Setting

Backup Source s Oy Document.

Backup Statistics

Backup Data Size* T [34k]
Retention Area Size* 2 [13k]
Backup Quota HEul
Remaining Guota A9 T
*Lnit= Mo, of Files [Total Size]

section.

Key Description

Backup Time The time when the backup job ran

Backup Status The overall status of the backup job. Normally, you should see “Backup
finished successfully” in this field. If you happen to get something else,
please consult the attached full report for more information.

New Files Total number and size of backup files added to your backup set

Updated Files Total number and size of backup files updated in your backup set

Deleted Files Total number and size of backup files deleted from your backup set

Moved Files Total number and size of backup files relocated in your backup set

Login Name Login nhame

Alias Alias

Language Preferred Language for your backup report

Contact Email Address that will be used to contact you

Backup Source All files/directories that will be backed up

Backup Data Size The total backup data stored in the data area

Retention Area Size |The total backup data stored in the retention area. Old copies of updated
or deleted backup files are retained in the retention area for the number of
days as specified by the retention policy of the backup set before they are
removed from the system.

Backup Quota Backup Quota

Remaining Quota Remaining Quota
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The full backup report, which contains a full listing of all files backed up by the backup job, is attached to the

backup job report email as a zip file. You need to unzip it before you can read the full report.

Sample Report

Full Backup Report

Generated at: Sat Jun 21 10:00:05 HKT 2003

Backup Set BackupSet-0 Mew files* 1 [2k bytes
Backup Job | :| 2003-06-21 {09:58) Updated files* 1 [2k bytes
Backup Statuﬁl :| Backup finished successfully Deleted files* 1 [4k bytes
Backup Time Z003-06-21 09:57 - 2003-06-21 09:57 Moved files® 1 [2k bytes

* Unit = Mumber of files [Total file size

Type
Info
Info
Info
Info

Backup Logs

Backup Logs

Start running pre-commands
Finished running pre-commands
Start running post-commands
Finished running post-cormnmands

Timestamp

2003-06-21 09:57
2003-06-21 09:57
2003-06-21 09:57
2003-06-21 09:57

Files

ChTestylib\Mew DANIEL.DOC

New Files

Last Modified
2003-06-21 09:57

Files

C\TestylibyDANIEL.DOC 9k

Updated Files
Size* Last Modified
2003-06-21 09:57

Files

CihTestylib\DANIEL_A.BAK 4k

Deleted Files
Size* Last Modified
1996-11-29 15:45

Files
1 ChTestyKINGL.BAK -= CATestilibyKINGL.BAK 3k

Moved Files

2003-06-05 12:35

Key Description
Backup Set The name of the backup set
Backup Job The name of the backup job (which is the start time of the backup job)

Backup Status

The overall status of the backup job. Normally, you should see “Backup
finished successfully” in this field. If you happen to get something else,
please consult the attached full report for more information.

Backup Time The time when the backup job ran

Backup Log All messages logged when running this backup job

New Files Total number and size of backup files added to your backup set
Updated Files Total number and size of backup files updated in your backup set
Deleted Files Total number and size of backup files deleted from your backup set
Moved Files Total number and size of backup files relocated in your backup set
New File List Full list of all backup files added to your backup set

Updated File List

Full list of all backup files updated in your backup set

Deleted File List

Full list of all backup files deleted from your backup set

Moved File List

Full list of all backup files relocated in your backup set
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16.4 Setting Change Report

After you have updated your user profile or backup setting, a setting change report will be sent to you. This report
allows you to track record of the changes that have been made to your backup account.

Sample Report

Backup Setting Changes Report

Why are you receiving this report ?

makes this changes, change your passward, carrectyour
setting and see ifthis happens again. Ifthis happens again,

please cantact us for further investigation.

Iffurther assistance is necessary, please referto the FAQS
section.

Source(s) + CAbly Documenti
Schedule(s) sMone

Filter tMone

Retention Policy rkeep deleted files for 7 days
Transfer Size 1 266K hytes
Pre-Command(s) tMane

Post-Command(s) :Mane

Generated at: Sat Jun 21 11:00:00 HEKT 2003

Lagin Mame s Mewwdccount
You are receiving this report since your personal ar backup Alias Thlew Testing Account Marne
setting has heen updated. Please canfirm the information Language :Enaglish
shown onthe rightis correct. Please make sure your setting is Contact LUSerENOU-COmpany.com
notupdated by someone onyour contact list. Ifnone of them Backup Quata 50N

Backup Set - BackupSet-0

Key Description

Login Name Login name

Alias Alias

Language Preferred Language for your backup reports
Contact Email Address that will be used to contact you

Backup Quota

Backup Quota

Backup Source(s)

All backup sources of the backup set

Backup Schedule(s)

All backup schedules of the backup set

Filter(s)

All backup filters of the backup set

Retention Policy

The retention policy of the backup set

Transfer Size

The transfer block size of the backup set

Pre-Command(s)

All Pre-Command(s) of the backup set

Post-Command(s)

All Post-Command(s) of the backup set
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16.5 Inactive User Reminder

You will receive an inactive user reminder in email if your account has been left inactive for the period of 7 days
(or the period specified by the system administrator). This is to remain you that you have not been running
backup for more 7 days. If you are a free trial user, your account will be removed from the system automatically if
the system can track no records of your backup activities in the next 30 days after receiving this report.

Sample Report

Why are you receiving this report ?

Inactive User Reminder

Generated at: Sat Jun 21 11:53:38 HKT 2003

Lagin Mame
You are receiving this report because this backup account has  Alias
heen inactive for 30 days. Ifthis account stays inactive for Language
another 30 days, this account will be removed from our Contact

system automatically without further notice. The following is
the backup activity ofthis account:

Last Login Time : 2003-06-21 10:18 AM
Last Backup Time : 2003-06-21 08:97 Al

Iffurther assistance is necessary, please referto the FAGIS

s MewAccadnt

s Mew Testing Account Mame
:Enalish
USEr@Eyau-campany.com

section.
Key Description
Login Name Login name
Alias Alias
Language Preferred Language for your backup reports
Contact Email Address that will be used to contact you

Backup Quota

Backup Quota

Last Login Time

The last time you logon to the backup system

Last Backup Time

The last time you ran a backup job
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17 Web Features

Other than the features of OBM described in the previous chapter, the web interface of Offsite Backup Server
provides you access to some additional features that are not available in OBM. This chapter describes each of
these features in details.

17.1 Install OBM

Before you can use OBM, you have to download the OBM installer from the web interface of Offsite Backup Server
and install OBM onto your computer. Please refer to the installation section (Chapter 2) for information on how to
install OBM onto your computer.

17.2 Update User Profile

You can update your user profile by using the [Profile] panel available on the web interface. To change your profile,
just make any changes to your profit on the panel shown below and press the [Update] button.

oft Internet Explorer _I_l- | ﬂ
Restare | Install Software EAQs | Help | Select Langquage
Profile | Backup Set | File Explorer | Report | Statistics Logout
a
User Summary
Data Area™ Retention &rea™ Total Restore®
S00M ge1k [ 3] 14M[1] 2.2Mm[ 4] 52M[5]
* Unit : Compressed Size [Total Mo, of Files]
User Profile [ demo ]
Alias ' |Demonstration Account
Language :IEninSh j
Timezone ! | GMT+08:00 (HKD) =l
Contact 1. Mamne [Derno Account [Rernove]
Ernail |demo@your—cnmpanv.com |-
2z, Name | [Add]
Ernail |
Add-on Modules : Microsoft Exchange Server (Enable) , Microsoft SQL Server (Enable)
Oracle Database Server (Enable) , MySQL Database Server (Enahble)
Lotus Domino {Enable’ , Lotus MNotes (Enable) In-File Delta (Enable)
Update Reset
_Ungate |_Reset | -

] [ [ [ e Y

Key Description

Quota Backup Quota

Data Area Total number and size backup files stored in the data area
Retention Area Total number and size of backup files stored in the retention area
Total Upload Total number and size of backup files uploaded to the backup server

Total Restore

Total number and size of backup files restored from the backup server

Login Name

Login name

Display Name Alias of your backup account

Language Preferred Language for your backup report
Time Zone Your Time zone

Contact Email Address that will be used to contact you
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17.3 Request Forgotten Password

If you have forgotten your password, you can retrieve it by simply entering your login name or your registered
email address on the [Password Request] form and press the [Request] button. Your password will be sent to your
registered email address automatically.

=10l x|
Install Software Fags | Help | Select Language
Logon | Forgot Password ?

Password Request

-Easy to use
- Fully Autarmated or
-Daily backup Email: I

-Save you time and
D Request
At a glance: How to retrieve your forgotten password?

-Backup your data

ggzomatlcally Bvery I, Enter either your "Login Mame" or "Email" in the
form above
- Access your dat_a ii. Press the [ Request ] buttan
anyt-\.llhere, an}.rtlmel iii. vou should receive your password immediately
- Retain all backup files, via ernail
even those that have
been deleted
-Backup your data to
our secure data center
-Fire? Earthquake?
Typhoon? Your data is
always safe

Login Mame: Idem0|

i€l [ [ e A

17.4 Restore/Delete/Undelete Backup Files

Using the [File Explorer], you can browse through the backup data (both current and previous versions) on OBS.
You can select any current backup files to Restore or Delete. You can also select any deleted backup files (in gray)
to Undelete.
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3 online Backup Services Management Console - Microsoft Internet Explorer =] =l
Restore | Install Software FAGQs | Help | Select Language
Profile | Backup Set | File Explorer | Report | Statistics Logout

Rows,n’Fage:ISU hd

) Home = FileBackupSet-1 = 2007-01-16 (12:22) = F:\ > images

" Show files after Job IEUU?fU‘F‘IB (12:22) 'I " Show all files  Show Jobs View

Delelel Restore | Undelete |

= File / Directory Size Last Modified Zipped [Ratio]
=
M B A _lego.oes Sk 2006/03/14 12:08 ak [17

Delete | Restore | Undelete |

MNote: 1. This shows all files / directories within a backup job of a backup set.
2. Files shown in light gray color refers to files retained in the retention area.
3. To restore files/directories, check the checkbox next to the files/directories and press the [ Restore ] button.
4. To delete files/directories, check the checkbox next to the files/directories and press the [ Delete ] button.
5. [D] = Differential delta file
6. [I] = Incremental delta file
] T T T Mtoclinganee

17.5 Review Backup Jobs

In addition to reviewing your backup activities from the email report and from OBM, you can also review any of
your backup Jobs by using the [Report] panel available on the web interface. To review a backup job, just select

the required backup job from the [Backup Set] and [Backup Job] drop down list.

xplorer

=100

FaQs | Help | Select Lanquage
Logout

Restore | Install Software
Profile | Backup Set | File Explorer | Report | Statistics

GETE R Al FileBackupSet-1 Backup Job:

hare Information?

Job Statu_s : Backup finished successfully Detai!ed 2 Detaled Report is
Backup Time : 2005/06/28 22:16 - 2005/06/28 22:17 (HKT) Repoit Sailable
New Files* 0[0bytes ] Data Area 561k bytes
Updated Files* 0[ 0bytes ] Retention Area 1.4M bytes
Deleted Files* 1[14M bytes ] Total Upload 2.2M bytes
Mowved Files* 0[0bytes ] Backup Quota 500M bytes

* Unit = Number of files [ Total file size ] Remaining Quota 497.8M bytes

] (= 4
Key Description
Job Status The overall status of the backup job. Normally, you should see “Backup
finished successfully” in this field. If you happen to get something else, please
click the [Detailed Report] images on the page.
Backup Time The time when the backup job ran
New Files Total number and size of backup files added to your backup set
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Updated Files

Total number and size of backup files updated in your backup set

Deleted Files

Total number and size of backup files deleted from your backup set

Moved Files

Total number and size of backup files relocated in your backup set

Backup Data Size

The total backup data stored in the data area

Retention Area

The total backup data stored in the retention area. Old copies of updated or

Size deleted backup files are retained in the retention area for the number of days
as specified by the retention policy of the backup set before they are removed
from the system.

Total Upload Total number and size of backup files uploaded to the backup server

Backup Quota

Backup Quota

Remaining Quota

Remaining Quota
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You can open the [Full Backup Report] to review all information logged by a backup job by clicking the [Detailed
Report] image on the [Report] panel.

Full Backup Report

Full Backup Report

Backup Job Summary

Generated at: Sat Jun 21 10:00:05 HKT 2003

Backup Job Statistics

Backup Set BackupSet-0 Mew files* 1 [9k bytes
Backup Job Z003-06-21 (09:58) Updated filas* 1 [9k bytes
Backup Status|: | Backup finished successfully Deleted files* 1[4k bytes
Backup Time Z003%-06-71 09:57 - 2003-0A-21 09:57 Maoved filas* 1 [3k bytes

Type
Info
Info
Info
Info

Bt R
i
[=]

* Unit = Mumber of files [Total file size]

Backup Logs

Backup Logs

Start running pre-commands
Finished running pre-commands
Start running post-commands
Finished running post-commands

Timestamp

2003-06-21 09:57
2003-06-21 09:57
2003-06-21 09:57
2003-06-21 09:57

MNo. Files

1 CvTestulibvWew DANIEL.DOC 9k

Mew Files

Size* Last Modified

2003-06-21 057

MNo. Files

1 ChTestyibhDANIEL.DOC ale

Updated Files
Size* Last Modified

2003-06-21 09:57

MNo. Files

1 CivTestyibhDANIEL_&.B &K 4k

Deleted Files

Size* Last Modified

1996-11-29 15:45

Mo. Files

Mowved Files

Size* Last Modified

1 CHTestKING1 BAK -= C:Testylib\KINGL.BAK 3k 2003-06-05 12:35
Parameter Description
Backup Set The name of the backup set
Backup Job The name of the backup job (which is the start time of the backup job)
Backup Status The overall status of the backup job.
Backup Time The time when the backup job ran
Backup Log All messages logged when running this backup job
New Files Total number and size of backup files added to your backup set

Updated Files

Total number and size of backup files updated in your backup set

Deleted Files

Total number and size of backup files deleted from your backup set

Moved Files

Total number and size of backup files relocated in your backup set

New File List

Full list of all backup files added to your backup set

Updated File List

Full list of all backup files updated in your backup set

Deleted File List

Full list of all backup files deleted from your backup set

Moved File List

Full list of all backup files relocated in your backup set

17.6 Review Storage Statistics

You can review the amount of data you have stored on the backup server and uploaded to the backup server on
each day by opening the [Statistics] panel available on the web interface. To review your storage statistics for a

different month, just select the month you are after by selecting from the [Month] drop down list.
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=101 %]

Restore | Install Software FAQs | Help | Select Lanquane
Frofile | Backup Set | File Explorer | Report | Statistics Logout
s
Storage Usage Summary Month (vrrr-Mey: | 2005-06 -
Retention &rea® & Total Storage®
2005-06-01 816.5M [ 3076 ] G26.2M [ 3112 ]
2005-06-02 FES.5M [ 3081 ] FTEEM[ 3111 ]
2005-06-03 768.5M [ 3081 ] Fra.2M [ 3111 ]
2005-06-04 11.9M [ 35 ] 768.5M [ 3084 ] z2M[ 8] 780.4M [ 3119 ]
2005-06-05 209.7M [ 1394 ] 1,006.8M [ 4616 ] 436.2M [ 28391 ] 1.19G [ 6010 ]
2005-06-06 209.7M [ 1394 ] 868.3M [ 4518 ] o[o] 1.05G [ 5912 ]
2005-06-07 209,7M [ 1394 ] 868,3M [ 4515 ] o[o] 1.05G [ 5912 ]
2005-06-08 209.7M [ 1394 ] 863.3M [ 4518 ] 0[0] 1.05G [ 5912 ]
2005-06-09 95.6M [ 1536 ] 1,000.2M [ 5289 ] £3.9M [ 914 ] 1.07G [ 6825 ]
2005-06-10 95.6M [ 1536 ] 875.2M [ 5285 ] 0[o] 973,9M [ 6824 ]
2005-06-11 95.6M [ 1536 ] 875.2M [ 5288 ] o[o] 973,9M [ 6524 ] -
2005-06-12 98.6M [ 1536 ] 875.2M [ 52388 ] 0[o] 973.9M [ 6324 ]
2005-06-13 95.6M [ 1536 ] 875.2M [ 5288 ] ofo] 973.9M [ 6824 ]
2005-06-14 S56,4M [ 843 ] 217.7M [ 6041 ] 186k [ 60 ] 974M [ 68584 ]
2005-06-15 S6.4M [ 843 ] 917.7M [ 6041 ] o[o] 974M [ 6834 ]
2005-06-16 S6.4M [ 843 ] 917.7M [ 041 ] o[o] 974M [ 6884 ]
2005-06-17 66,7M [ 1140 ] 2158,2M [ 6066 ] 10,9M [ 322 ] 254,94 [ 7206 ]
2005-06-18 66.7M [ 1140 ] 9138,2M [ 6066 ] 0[0] 954,9M [ 7206 ]
2005-06-19 66.7M [ 1140 ] 915.2M [ 6066 ] o[o] 954,94 [ 7206 ]
2005-06-20 66,7M [ 1140 ] 2158,2M [ 6066 ] o[0] 954,9M [ 7206 ]
2005-06-21 66.5M [ 1075 ] 218.4M [ 6131 ] o[o] 254,9M [ 7206 ]
2005-06-22 £6.5M [ 1075 ] 9153.4M [ 6131 ] 0[o] 954,94 [ 7206 ] =l
i€l [T e 4
Key Description
Date The date the following statistics are collected
Data Area Total number and size of backup files stored in the data area on a particular

date

Retention Area

Total number and size of backup files stored in the retention area on a particular
date

Uploaded Size

Total number and size of backup files uploaded to the backup server on a
particular date

Total Storage

Total number and size of backup files stored under your backup account on a
particular date
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18 Further Information
18.1 FAQs

Please see if your question has already been answered in our FAQs available on our website.

18.2 Contact Us

You can backup your data to an Offsite

Backup Server by following instructions below.

i. Open OBM from the system tray

Choose [View] -> [About] from the top menu

=] 9]
Eackup Set Backup Restore Tools ,W
Save Sefting | » StartBackup ® 5t UssrPmofile
==  Backup
@‘ Backup Caontroller @F E Restore BackupSet-1
User Profila 1 Log
Baciup Source Type: File Backu -
[igy Backup Schedule e P
%] Backup Filter Network Resources Authentication for Windo
[ command Line Taol Dormain:
(5 getting User Marne:
5 Encryption Password:
[, In-File Delta
é Local Copy Fropetties |
(& MSSQLBackupSet-1
OracleBackupSet1 ¥ Run scheduled backup on this computer
(3] MSExchangeBackupSet-1
(@] LotusBackupSet-1
[Hg] MySQLBackupSet-1
Log Table (FileBackupSet-13 &
Type | Log Time |
@ start [2005/06/28 16:59:07] i’
@ Start running pre-commands [2005/0628 16:58:07]
@ Finizhed running pre-commands [2005/06/28 16:59:07]
(i} Downloading serverfile list... [2005/06/28 16:59:071 Ll
& Backup | @ Resmrel Lngl
\Elackup Completed Successiully |Qu0ta (Remaining f Total): 500M § 500M |Last Backup: 2005-06-28 14:51

Online Backup Manager

x|

Online Backup Manager
Version 4.8.1.1d

Backup Service Provider

Company: Backup Provider Company Limited

Backup Server: 192.168.0.22

Company Website: www backup-provider.com
Email: support@backup-provider.com

Telephone: + (o) 2000000

Contact your backup service provider using the information shown in the [About] dialog box
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